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Introduction 

The Intermediate Digital Literacy Program is the second level of the Digital Amhara Initiative’s 

three-tier digital literacy framework, following the Basic level and preceding the Advanced digital 

literacy. This program is designed to strengthen learners’ ability to apply, analyze, and create in 

digital environments, building on foundational skills while preparing them for practical and 

professional use. 

Aligned with Ethiopia’s Digital Education Strategy and Implementation Plan (2023–2028), the 

UNESCO Global Framework of Reference on Digital Literacy Skills (Indicator 4.4.2), and the 

Technical Guidelines for Commissioning Digital Literacy Training Platforms for African 

Governments by Big Win Philanthropy, the program ensures learners acquire globally recognized 

and nationally relevant digital competencies. 

The program develops learners’ capacity to: configure and manage digital devices and productivity 

software; organize, convert, compress, back up, and securely manage data; communicate and 

collaborate responsibly online while managing their digital identity; design, create, edit, and 

integrate digital content in multiple formats while applying copyright principles; implement safe 

digital practices; analyze and troubleshoot common software, network, and application problems; 

and apply basic programming knowledge and explore digital career pathways. 

By completing this program, learners will gain intermediate-level digital literacy competencies 

that enable them to participate effectively in education, employment, and entrepreneurial activities, 

solve real-world digital challenges, and contribute to Ethiopia’s digital transformation and 

technology-driven development goals. 

Modules Covered in the Program 

The program is structured into seven core modules, each addressing a critical area of digital 

competence: 

1. Devices and Software Operations 

2. Information and Data Literacy 

3. Communication and Collaboration 

4. Digital Content Creation 

5. Safety 
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6. Problem-Solving 

7. Career-Related Competencies 

Learning Objectives 

By the end of this program, learners will be able to: 

 Configure and manage digital devices and apply advanced features of productivity 

software to perform complex tasks. 

 Organize, convert, compress, back up, and secure files using local and cloud-based 

systems. 

 Demonstrate effective communication, collaboration, and responsible participation in 

digital spaces while managing personal online identity. 

 Design, create, edit, and integrate digital content across multiple formats while applying 

copyright and licensing principles. 

 Implement secure practices to protect accounts, data, and digital identity in online 

environments. 

 Analyze, diagnose, and troubleshoot common software, network, and application issues 

independently. 

 Explain and apply basic programming concepts, software development tools, and identify 

digital career opportunities. 

Instruction  

The program adopts a competency-based, learner-centered approach, integrating theory with 

practical activities to ensure that learners develop the skills and knowledge outlined in the program 

objectives. Each module is designed to progressively build digital competencies, from device and 

software management to career-related skills, allowing learners to apply, analyze, and create in 

real-world digital contexts. 

Each module includes: 

 Interactive lessons introducing key concepts, digital tools, and advanced features of 

productivity software. 
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 Hands-on exercises and demonstrations to practice applied skills such as file 

management, content creation, communication, collaboration, and problem-solving. 

 Review questions, case studies, and scenario-based activities to assess understanding, 

encourage critical thinking, and connect learning to practical situations. 

 Individual and collaborative tasks that promote digital citizenship, responsible online 

behavior, and teamwork in virtual environments. 

Facilitators and learners are encouraged to contextualize examples to local and professional 

settings, ensuring that learning is relevant, inclusive, and directly applicable to education, 

employment, and entrepreneurial opportunities. Learners are expected to actively engage, 

practice consistently, and apply their skills in authentic scenarios, demonstrating mastery of 

intermediate digital competences such as digital content creation, safe technology use, 

troubleshooting, and career-related digital skills. 

Certification 

Upon successful completion of the program and the final evaluation, learners will be awarded a 

Certificate of Intermediate Digital Literacy Competence. This certification validates their 

ability to apply intermediate-level digital skills across education, work, and everyday life, and 

positions them for advanced training or entry into digital career pathways. 

Note: Learners must complete the final evaluation to be awarded the Intermediate Digital Literacy 

Certificate, which verifies their mastery of the program’s core digital skills and competencies. 
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Module 1: Device Management and Software Operations 

Introduction 

This module equips learners with essential skills to configure digital devices and manage their 

applications effectively. Learners will explore practical techniques, configuration, and 

optimization of devices to ensure a smooth and efficient digital work environment. Under session 

1, working with nearby devices and their connectivity is discussed. The remaining sessions address 

productivity software usage. Session 2 covers advanced document formatting topics and editing in 

MS Word. The last lesson covers more complex spreadsheet management features, including 

creating graphs, using formulas, filtering and sorting data, and more data analysis topics. 

Session 1: Working with nearby devices  

Introduction 

Dear learners, welcome to this session. In this session, you will explore working with nearby 

devices 

The most common activity in the digital world is resource sharing. To carry out our regular tasks, 

devices such as printers, PCs, and smartphones must be locally connected. These sessions cover 

the most common local connectivity technologies, connectivity techniques, and device settings. 

Thus, learning the fundamentals of nearby sharing technologies and how to set them up enables 

students to connect nearby devices and share resources, such as files, images, and printers, with 

ease.  

You may have connected devices nearby to share resources. But how familiar are you 

with local connectivity technologies and their configuration?  

Learning objectives 

By the end of this session, learners will be able to: 

 Identify the concept of local connectivity technologies 
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 Identify common local connectivity technologies and connect to them  

 Configure common digital devices 

Contents outline  

1.1 Working with nearby devices  

1.2 Common local connectivity technologies   

1.3 Digital device configurations 

1.1 Working with nearby devices  

This session includes the identification of common wired and wireless local Connectivity 

technologies configuration for local communication.  

Working with Nearby Devices refers to connecting and interacting with physically closer devices, 

using local communication technologies without needing an internet connection. This feature is 

designed to make file transfer, communication, and device interaction fast, secure, and user-

friendly in short-range environments. 

Key Features 

 Local Sharing: Files are transferred directly between devices, no internet required. 

 Cross-Device Compatibility: Windows to Windows, Android to Android, and some 

cases Windows to Android. 

 Security: Transfers are encrypted, and users must accept incoming files. 

 Ease of Use: Simple interface in system settings or right-click share menu. 

 Multiple File Types: Supports documents, images, videos, PDFs, and more. 

Advantages 

 No Internet Required: Works in offline environments. 

 Secure and Private: Users control who can send or receive files. 

 Efficiency: Quick access to shared resources. 

 Cost-saving: Fewer devices needed (e.g., one printer for many users). 

 Collaboration: Easier teamwork and data exchange. 
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 Limitations 

 Distance Restriction: Typically within 10 meters. 

 Device Compatibility: Some older devices or OS versions may not support it. 

 File Size: Extremely large files may take longer to transfer. 

 Battery Usage: Can drain battery if used continuously. 

1.2 Common Local Connectivity Technologies 

Local connectivity can be categorized as wireless or wired connections. 

1. Common Wireless Local Connectivity  

Common wireless local connectivity is primarily achieved within a limited area, such as, homes 

or offices, providing network access without wires. Key components include access points, which 

broadcast the network, and devices with wireless network adapters that connect to it. 

 

WIFI - The standard for wireless local area networking. Provides high-speed 

internet and local area network access to devices like laptops, smartphones, 

TVs, and game consoles. 

 

Bluetooth – Wireless connection for sharing files, audio, and peripherals 

(headphones, mouse, keyboards, etc.). 

 

Wi-Fi Direct- for connecting devices directly, without needing internet or a 

router/access point for file transfer or streaming 

 

NFC (Near Field Communication) – Quick pairing, payments, or data 

exchange by tapping devices. Mostly works by using radio frequency 

identification (RFID)  

 

AirDrop / Nearby Share-Platform-specific sharing features for Apple and 

Android devices. 

Table 1 Comparison of wireless local communication technologies 

 

Technology Range Used for  

WIFI 50 – 100M Laptops, smartphones, TVs, and game consoles 
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Bluetooth 10–100 m Audio devices, file sharing, keyboards, mice 

Wi-Fi Direct Up to 100 m File transfer, printing, and screen mirroring 

NFC < 10 cm Mobile payments, quick pairing, contact sharing 

Airdrop/Nearby 

Share 

Varies Fast file sharing between phones and laptops 

Table 2 Wireless Technologies and tier use 

Connection Procedures for Common Technologies 

I. Connecting via WIFI 

 Turn Wi-Fi on:  Go to your phone or computer’s 

Settings → Wi-Fi (sometimes “Network & Internet”). 

 Choose a network: A list will appear—pick the one 

that matches your router or hotspot name (SSID). 

 Enter the password: Type the Wi-Fi key (usually 

written on the router or given by the network owner). 

 Connect: Hit “Connect” or “Join.” Once it works, 

you’ll see the Wi-Fi symbol on your status bar. 

II. Connect via Bluetooth 

Step 1: Turn on Bluetooth 

 On phones or Windows computers, go to Settings → Bluetooth and turn on. 

 On other devices (e.g., headphones), press and hold the power or Bluetooth button to 

enter pairing mode.  

 Mac: Go to Apple Menu → System Preferences → Bluetooth → turn on. 

Step 2: Make Device Discoverable 

 Select the device name to initiate pairing in the list of available Bluetooth devices.  

Step 3: Confirm Pairing 

Figure 1: Connect to WIFI 
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 You may be asked to confirm a code or accept the connection. 

 

III. Wi-Fi Direct 

Steps to Connect: 

1. Enable Wi-Fi Direct in device settings (often under “Connections” or “Network”). 

2. On one device, create a Wi-Fi Direct connection or search for nearby devices. 

3. On the second device, accept the connection. 

4. Use apps like File Manager or Gallery to send files. 

IV. NFC (Near Field Communication) 

Used for: Quick pairing, mobile payments, contact sharing, and hotel room by tapping it 

against a reader.  

Steps to Connect: 

1. Enable NFC on both devices (usually under “Connections”). 

2. Tap the devices together (within 4 cm). 

Figure 2 Bluetooth Connectivity 
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3. Confirm the action (e.g., file transfer or payment). 

4. For NFC tags, use apps like NFC Tools to program actions. 

V. Airdrop / Nearby Share 

Airdrop (Apple Devices) 

1. Turn on Wi-Fi and Bluetooth. 

2. Open Control Center → enable Airdrop. 

3. Choose visibility: Contacts Only or Everyone. 

4. Open the file → tap Share → choose AirDrop recipient. 

5. Recipient accepts the transfer. 

Nearby Share (Android Devices) works with either WIFI or Bluetooth connection  

1. Open the file → tap Share → select Nearby Share (such as Bluetooth, WhatsApp, 

Telegram, etc). 

2. Choose the nearby device and confirm. 

Scenario: 

Selam wants to send her project file to Dawit, but the internet is down. How she shares the file to 

Dawit? 

She uses Nearby Device Sharing to send it wirelessly. 

Steps: 

1. Enable Sharing – Selam turns on Nearby Sharing on her laptop. 

2. Activate Receiver – Dawit enables Nearby Share on his Android phone. 

3. Send the File – Selam selects the file → chooses Share → Nearby Sharing → selects 

Dawit’s phone. 

4. Accept the Transfer – Dawit taps Accept when prompted. 

5. Transfer Complete – The file is received quickly using Wi-Fi Direct. 

Learning Points: 
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 Works without internet. 

 Devices must have Bluetooth/Wi-Fi enabled and be close (within 10 meters). 

 Safer and faster than using USB or email for local transfers. 

2. Local Wired Device Connectivity  

The second form of local connectivity, or nearby sharing technologies, is the one that uses cables. 

Different types of cables are used for different devices. The most common ones are:  

  Personal Computer ↔ Monitor: VGA, HDMI, Display Port, or USB-C for extended 

displays. 

  Phone ↔ Speaker: 3.5mm audio jack for direct sound output. 

  Computer ↔ Printer: USB and Ethernet cable for fast and reliable printing,   

  Router ↔ Switch↔ PC: Ethernet for a stable internet connection. 

  Phone ↔ Laptop: USB, Type C for charging and file transfer.   

 PC to PC: Ethernet for a stable internet connection. 

1. 3 Digital Device Configuration  
 

Device configuration is the process of setting up and adjusting a device’s settings and features to 

make it work correctly. This can include devices like computers, smartphones, and network 

equipment. Proper device configuration ensures that devices run smoothly and meet the user’s 

needs 

Digital devices need to be configured to interact within a network and communicate effectively, 

regardless of their connection method. This includes: 

I. Computer configuration 

 IP Addressing: Static (manually set) or dynamic (assigned by a router via DHCP).  

 Default Gateway: The router’s address that allows devices to communicate outside  

 DNS -This is the IP address of the server your computer queries to resolve names. 

 Enable or disable Wi-Fi or Ethernet connections based on network type. 
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 Resource Sharing: Set up file sharing, network drives, and printer sharing. 

Steps to configure IP for computers 

1. Right-click on the Network icon on the desktop & select properties  

2. Click on Change Adapter Settings 

3. Right-click on the Ethernet icon & select properties 

4. Select Internet protocol version 4(TCP/IP 4) & Click on properties 

5. Select “obtain an IP address automatically” to assign an IP using DHCP or “Use the 

following IP address assigning steps” to assign an IP manually (static).   

II. Printer sharing configuration 

Step-by-step printer sharing on a Windows-based PC  

1. Connect your printer to the computer: Connect your printer to the PC (via USB or network 

cable). And add the printer to your computer if not already installed.  

2. Open settings: Press Windows key + I to open Settings & Go to Devices → Printers & scanners. 

 Select the printer to share: Click the printer you want to share and click Manage. 

2 

3 
4 5 

Figure 3: IP setting manually 
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 Open sharing options: Click Printer properties →Sharing tab → Check Share this printer. 

& Click OK 

 Access the shared printer from another PC: On the other PC, open Settings → Devices → 

Printers & scanners → Add a printer or scanner. 

 Select the shared printer from the list & click Next and install drivers if prompted. 

 On the “Run” Windows, write the IP address of the other pc preceded with two 

backslashes (such as: \\192.168.1.10) and double-click the printer to set up installation.  

How to Connect to a Network-Shared Printer Using an IP Address 

You need to know the name of the printer and the IP address of the computer that the printer is 

connected to. Or the printer IP Address. 

 

Option 1: Connect to Printer using IP 

Address 

Step 1: Press shortcut keys: Win + R to 

open the Run box, enter the printer's IP 

address. 

Step 2: Click on the shared printers from the result list. Connect to that printer. 

Step 3: When it prompts a dialog "Do you trust 

this printer?", click on install drivers. 

Step 4: Complete the additional steps in the 

wizard, and then click Finish. 

Option 2: Add a Printer using IP Address 

or Hostname 

Figure 4 Run Windows with sample IP 

Figure 5 Shared Printer Icon 
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Step 1: Open Control Panel, click Hardware and 

Devices, and then click Devices and Printers. 

Step 2: Click on Add a printer in the toolbar of 

Devices and Printers. 

Step 3: If you see the printer you're looking for, click 

the printer you want to install. Windows will handle 

the installation, download drivers if needed. 

Tips: If you don't see the printer you want to install, and you're sure you're properly connected to 

the network, click the printer that I want isn't listed link. Go on to Step 4. 

Step 4: Select Add a printer using a TCP/IP 

address or hostname and then click Next. 

Step 5: Keep Device type to Autodetect and fill 

in the Hostname or IP address. Ensure 

that Query the printer and automatically select 

the driver to use is ticked, click Next. 

Step 6: Wait for the detection TCP/IP port. 

When it jumped to install the printer driver process, select the manufacturer of the printer in the 

left pane, select the shared printer in the 

right pane, and then click Next. 

Step 7: Type a new name for the printer if 

the default name doesn't suit you, and then 

click Next. 

Step 8: Finally, choose whether to set the 

new printer as the default and then click the 

Finish button. 

Figure 6 Start Printer share from control Panel 

Figure 7 Printer Selection Option 

Figure 8 Adding Other computer IP address 
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III. Wireless Access Point (WAP) Configuration: 

A WAP stands for Wireless Access Point, which is a device that allows Wi-Fi devices (like phones, 

laptops, and tablets) to connect to a wired network. WAP can be configured to create and manage 

connections and security issues. Some of the settings to be configured include:  

 SSID (Service Set Identifier) Setup: Network name for wireless devices to connect to. 

 Security Protocols: Wi-Fi Protected Access (WPA/WPA2) settings to secure the wireless 

network. 

 Broadcast ID - helps you to hide your WIFI name from the users. If the broadcast is hidden, 

you have to add your network to the device you are using.  

 MAC – Address Filtering – this configuration helps you either block or allow devices with 

their MAC addresses.  

 Concurrent Connection Management: Limit 

bandwidth to prevent network congestion. 

Steps to configure an Access Point: 

1. Connect the WAP to your computer with  

 Ethernet cable or via wireless 

2. Open your web browser, and type WAP's IP address (eg, 192.168.0.1) in the address bar. 

  If you're using a new WAP, it might have a default IP address. Check documentation 

for your specific model (e.g., 192.168.1.254 for some Cisco WAPs). Or the back side of 

the device  

Figure 9: Access point 
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 You 

might log in 

with default 

credentials 

(e.g., username 

"admin" and 

password 

"admin"). Or 

check the 

backside of the 

device for more 

details.  

3. Configure Wireless Settings: 

a. Go to the wireless settings and configure the SSID 

(network name).  

b. Choose a security protocol (e.g., WPA2) and set a 

strong password 

c. Create a name that is easy to remember 

d. Create the most secure password (>=8, Mixed 

characters and numbers as well as WPA/WPA2-

PSK encryption.  

4. Configure IP Address (if not using 

DHCP): 

If you're using a static IP, enter the desired 

IP address, subnet mask, and the default 

gateway.  

Figure 12: IP configure 

Figure 11 : Security protocol choosing 

Figure 10: Wifi login 
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If you're using DHCP WAP is configured to obtain an IP address automatically.  

Summary 

Effective configuration of digital devices within a network ensures optimal device communication, 

resource management, resource sharing, and security. By properly setting up each device and 

managing its interactions, networks can function efficiently and securely, enhancing productivity 

and reducing costs. In this session, you learned about the basic configuration of nearby devices, 

how to connect them, and how to configure them in your local working environments.  

Review Questions 

Reflective question: Match the correct technology to the question: 

1. Works within less than 10 cm and is used for mobile 

payments.  

2. Has a range of up to 10–100 m and is common for audio 

devices.  

3. Allows fast file sharing between phones and laptops.  

4. Used for printing and screen mirroring with a range of 

up to 100 m.  

5. Connects the laptop to the Monitor.  

6. Connects the computer to the printer. 

A. Bluetooth 

B. Wi-Fi Direct 

C. NFC 

D. Air Drop / Nearby Share 

E. Laptop ↔ Monitor: HDMI 

F. Computer ↔ Printer: USB  

 

Multiple Choice (5 Questions) 

1. Which port is most commonly used today to connect a PC to a modern monitor? 

A. VGA 

B. HDMI 

C. PS/2 

D. Serial 

2. What information is usually required to connect a device to a Wi-Fi network? 

A. IP address and MAC address 
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B. Network name (SSID) and password 

C. Device serial number 

D. Operating system version 

3. Which connector is an older analog standard for connecting monitors? 

A. HDMI 

B. DisplayPort 

C. VGA 

D. USB-C 

4. What is the purpose of the initial setup wizard on a new device? 

A. To install games 

B. To configure basic settings like language, accounts, and Wi-Fi 

C. To test device speed 

D. To check for viruses 

5. What does configuring power management settings on a device mainly help with? 

A. Improving battery life and energy efficiency 

B. Increasing internet speed 

C. Reducing storage space 

D. Enhancing screen resolution 

True / False (5 Questions) 

6. DisplayPort and HDMI can both carry video and audio signals. (True / False) 

7. Troubleshooting usually starts by checking simple things like cables, power, and 

connections. (True / False) 

8. USB-C is only used for charging and cannot transmit video or data. (True / False) 

9. Device drivers are small programs that allow the operating system to communicate with 

hardware. (True / False) 

10. Troubleshooting often begins by checking simple issues like power, cables, and connections. 

(True / False) 
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Session 2 Advanced Document Formatting (Word Processing) 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Advanced Document 

Formatting (Word Processing) 

Microsoft Word has many features to support users in editing, formatting, and managing their 

documents.  In the previous Competency, the basic features of MS-Word were discussed in detail. 

In this session, advanced features of MS Word, such as formatting styles and themes, formatting 

page numbers, inserting references, tables, and figures, as well as mail merging and reviewing 

documents, will be discussed.  

Learning Objective: 

By the end of this session, learners will be able to: 

 Apply Formatting styles and themes 

 Practice formatting page numbers, tables, and inserting Objects  

 Practice how to insert different references  

 Use mail merge and review documents. 

Lesson Outline: 

2.1 Use Styles & Themes 

2.2 Formatting Page Numbers, Tables, and Objects 

2.3 Insert References 

2.4 Mail Merge and Reviewing Documents  

2.5 MS Word Security and Protections 

2.1 Use Styles & Themes 

The intermediate session of word processing is a continuation of the basic level. At this moment, 

it is believed that you can work on basic word formatting. The home and insert tabs were discussed 
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under the basic skill of digital literacy. Styles ensure consistency in headings, body text, captions, 

etc. Themes apply a uniform color, font, and effects design to the entire document. 

I. Modify your styles in Microsoft Word 

To change the style, go to the Home tab in Microsoft Word, locate the Styles group, and then 

right-click on the style you want to change in the Styles gallery. From the menu, select Modify, 

make your desired formatting changes in the dialog box, and then click OK. 

 

Figure 13: Modify MS Word Styles 

II. Modify your theme in Microsoft Word 

MS Word has many built-in themes. You can go to the design tab and select the one you choose, 

or customize it if you want another one. Instead of the default theme, you can customize your 

theme according to your interests. To do this, go to the Design tab and select from the built-in 

Themes to apply a new color scheme, fonts, and effects.  
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Figure 14: Modify MS Word Themes 

Note: Hover the mouse over the selections in the Themes Gallery to preview how each theme will 

look when applied to your document. 

2.2 Formatting Page Numbers, Tables, and Objects  

I. Formatting Page Number  

Formatting page numbers is used to enhance reader navigation, 

improve document organization, and ensure a professional 

presentation of the document. To format page numbers in MS 

Word: 

Insert them via the Insert tab   then select Page Number   

Format Page Numbers to choose a different number format (like 

Roman numerals, Arabic numbers, or alphabets) or start at, to set 

a starting number for a section.  

Figure 15 Formatting Page Numbers 
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To skip the first page, use the Different First Page option in the Header & Footer tools. 

To apply different page number formats to 

different document parts, such as preliminary 

pages of research roman numbers (I, ii,...) and 

your main text section using Arabic numbers 

(1,2,3,.. ), use Section Breaks and apply 

formatting independently to each section. In 

the design tab, click breaks  click on Next-

Page to make a section break.  

II. Tables Formatting 

To format a table in Word, insert a table from the Insert tab, then select the table and go to the 

Table Design tab on the Ribbon to apply preset Table Styles. You can further customize the look 

by adjusting Table Style Options to change row and column formatting, or manually change 

shading, borders, and alignment using options on the Design and Layout tabs. Or right-click and 

see the table properties.  

 

Figure 17 Table Layout View 

III.  Inserting objects and Mathematical Questions 

Figure 16 Section Breaks 
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to embed or link data and graphics from 

other applications (like Excel or 

PowerPoint), add non-text elements 

such as shapes, WordArt, or clip art, or 

organize complex drawings into a single 

unit for easier manipulation. This helps 

to organize and present information 

more clearly and effectively, creating a 

visually appealing layout. In the insert 

tab, click Insert Objects and choose the 

object from the pop-up window.   

Besides inserting objects, the inserted equation helps to add mathematical questions that cannot be 

found from a traditional keyboard, such as: 
−𝑏±√𝑏2−4𝑎𝑐

2𝑎
 

 

IV. Inserting page backgrounds  

To add a background in Microsoft Word, go to the Design 

tab, then select Page Color. You can choose a solid color, 

a gradient, a texture, a pattern, or a picture from the Fill 

Effects options. For a background image, select Fill 

Effects > Picture > Select Picture to browse and insert your 

desired image file. 

V. Adding Columns  

Columns can enhance 

readability, particularly 

in specific types of 

documents, such as 

newspaper articles, 

newsletters, and flyers. 

Word also allows you to 

adjust your columns by 

adding column breaks. 

To add a column in MS 

Word: 

Figure 18Insert Objects Window 

Figure 19 inserting Page Backgrounds 
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Select the text to be columnized (Like the above text divided into three columns), go to the 

Layout tab on the ribbon, select Columns, and choose the desired number from the dropdown 

menu. Alternatively, for more control, select More Columns to open a dialog box for adjusting 

width, spacing, and adding lines between columns. 

2.3 Insert References  

Table of Contents: This group includes commands to create and manage a Table of Contents for 

your document, automatically pulling in 

headings and corresponding page 

numbers. To insert the table of contents, 

first arrange your titles based on the 

level of headings.   

1.  Citations & Bibliography: This 

is where you add, manage, and 

format sources for your in-text 

citations and the final 

bibliography. To insert a reference in Microsoft Word, place your cursor where you want 

the citation, navigate to the References tab:  

2. Click Insert Citation, and then select Add New Source to enter the details of the source type 

(like book or website) or choose from your existing list. 

3. On the pop-up window, fill all necessary information such as Author, Title, Publisher, Date, 

and pages, etc.   

4. After adding the citation, click the style you want the reference to be generated. The default 

format selected is APA.  

5. After adding the citation, click the Bibliography button on the References tab to insert an 

automatically generated bibliography at your cursor's location.  

A. Footnotes and Endnotes: Use this section to insert and manage footnotes and endnotes, 

which provide supplementary information or definitions without cluttering the main text.  

B. Captions: Use these commands to insert captions for figures, tables, and other media 

within your document, and to create a Table of Figures or Table of Tables.  

Figure 20 Insert Citations 
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Figure 21: Inserting References 

C. Index: This group allows you to create an index, which is a list of key terms or topics found 

in your document and the pages where they appear.  

2.3  Mail Merge and Reviewing Documents  

I. Mail Merge  

Mail merge is used to personalize mass communications by automatically combining a main 

document with a data source to create multiple unique documents for each recipient, thereby 

saving time and reducing manual errors in tasks such as sending personalized letters, labels, and 

emails.  

How it works: 

 Main Document: You create a template 

document (like a letter or email) with 

fixed, boilerplate text and "merge fields" 

(placeholders for personalized 

information).  

 Data Source: You provide a separate 

data source, such as a spreadsheet, a 

database, or a list, containing individual 

recipient details like names, addresses, and other relevant information. The data source is in 

the format (e.g., "FirstName," "LastName," "Email").  

Figure 22 Mail Merge 
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 Preview Your Results: Click the Preview Results button on the Mailings tab. Scroll through 

the records to ensure the personalized information appears correctly.  

 Finish and Merge: Click the Finish & Merge button.  Choose to Edit Individual Documents 

(to create a new document with all the merged records), Print Documents, or Send Email 

Messages, depending on your task.  

II. Review Document  

The Review tab in Microsoft Word provides a collection of tools for proofing documents, 

collaborating with others, and managing changes and feedback. Some of the key features are 

presented below:  

A. Proofing and Language Tools 

 Spelling & Grammar: Checks your document for 

errors in spelling and grammar.  

 Thesaurus: Helps find synonyms and related words.  

 Word Count: Displays the number of words, 

characters, and other statistics for your document.  

 Language: Allows you to translate selected text or 

the entire document, or set the proofing language.  

 Accessibility Checker: Identifies potential issues 

for people with disabilities to make your document 

more accessible.  

 Comments: Let's you add notes and feedback directly into the document without altering 

the main text.  

 Track Changes: Records every modification made to a document, showing who made the 

change and when.  

 Accept and Reject Changes: Allows you to review suggested changes and choose to 

incorporate or discard them. 

Figure 23Language Translation 

Figure 24 Review Document tab 
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 Compare: Shows the differences between two versions of a document side-by-side. 

 Combine Revisions: Merges changes from multiple authors into a single document. 

B.  Protect: Restricts editing or formatting to specific parts of the document or sets password 

protection. Adding Dictionary  

We add a word to the Microsoft Word dictionary to prevent it from being flagged as a spelling 

error and to add it to the program's known vocabulary; for example, “Bahirdar” is not known by 

the dictionary. Therefore, add this word to the dictionary. To add a custom dictionary in Microsoft 

Word: 

 Go to File > Options > Proofing and click the Custom 

Dictionaries... button to add, edit, or create new 

dictionaries.  

You can also add words by right-clicking a word flagged as 

misspelled and selecting Add to Dictionary from the context 

menu. If you're on a Mac, navigate to Word > Preferences and 

then to Spelling & Grammar under Authoring and Proofing Tools.  

2.5 MS Word Security and Protections 

Microsoft Word offers several ways to protect your documents, 

each designed for a different purpose, from preventing others from opening a file to only allowing 

specific types of changes. 

Protection Type Primary Purpose Key Limitations & Considerations 

Encrypt with 

Password 

Prevent opening of the 

document 

• Password is case-sensitive, max 15 

characters 

• Microsoft cannot recover a lost password 

Figure 25 Adding to Dictionary 
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Protection Type Primary Purpose Key Limitations & Considerations 

Restrict Editing 
Control how the 

document is modified 

• Can limit to comments, tracked changes, or 

filling forms 

• Can specify editable sections for specific 

users 

Always Open 

Read-Only 

Recommend read-only 

access 

• Users can choose to enable editing when 

prompted 

Mark as Final 
Declare the document 

as a completed version 

• Not a security feature; easily reversed 

• Disables typing and editing commands 

Add a Digital 

Signature 

Verify authenticity and 

integrity 

• Requires a digital certificate or signing 

provider 

Which protection is appropriate for you? Your choice should depend on what you are trying to 

achieve: 

 For maximum confidentiality: Use Encrypt with Password to prevent anyone without 

the password from even opening the file. 

 For collaborative control: Use Restrict Editing if you need others to add comments only, 

fill in forms, or edit specific sections. 

 For final version distribution: Use Mark as Final to gently discourage editing and let 

readers know they are viewing a final version. Remember, this is not a security lock. 

Important Security Considerations 

It's crucial to understand the limitations of Word's native protection: 

 "Restrict Editing" is not foolproof: The read-only protection can often be bypassed by 

saving the document in a different format (like PDF) or by using a different text editor. 
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 Passwords cannot be recovered: If you forget a password you set for encryption or editing 

restrictions, Microsoft offers no way to retrieve it. It is critical to keep a copy of your 

passwords in a secure place. 

The above session helps you choose the right protection for your document. 

Practical Exercise  

Open Microsoft Word and perform the following activities on the document you created:  

Styles and Table of Contents 

1. Write a short document with a title and three headings. 

2. Apply the Heading 1 style to your main headings. 

3. Insert an automatic Table of Contents at the beginning of the document. 

4. Change one of the headings and update the Table of Contents to reflect the change. 

Tables and References 

1. Insert a Table with 4 columns and 5 rows. 

2. Merge the cells in the first row to create a single header. 

3. Apply a Table Style (e.g., Grid Table 4 - Accent 1). 

4. Sort the data in one of the columns alphabetically. 

5. Add a Footnote somewhere in the text to explain a term. 

Mail Merge 

1.Create a simple data source in Excel with three columns: Name, Address, and Product. 

2.In Word, write a short letter with placeholders for the name, address, and product. 

3.Use the Mail Merge wizard to link your Excel data source to the letter. 

4.Complete the merge and preview the results for each recipient. 

Collaborative Review (Track Changes and Comments) 

1. Turn on Track Changes. 
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2. Delete a sentence and add a new one. Observe how the changes are marked. 

3. Insert a Comment on a specific paragraph with the text: "Please verify this information." 

4. Accept the deletion you made and reject the addition you made. 

5. Turn off Track Changes. 

Advanced Layout and Formatting 

1. Divide the document into three Sections. 

2. Set the first section to have Two Columns. 

3. Add a Watermark that says "DRAFT" in the background. 

4. Apply a different Page Border to each section. 

5. Use the Format Painter to copy the formatting from one heading to another. 

Mastering Styles and Automation 

1. Create a new Custom Style called "Important Quote" with specific formatting (e.g., Italic, 

Indent, background color). 

2. Apply this new style to a paragraph. 

3. Insert a Cross-reference that refers to a heading in your document. 

4. Create a Quick Part from your company's name and address and insert it into the document. 

Restrict and protect 

1. For the document you have created, add a restriction that it cannot be edited  

2. In addition, add a password for your document so that others cannot open it easily  

Summary: 

Advanced formatting ensures that documents are not just functional but visually professional. It 

makes information easy to navigate, especially in long documents. At this point, the advanced 

features of MS Word, such as changing the styles and themes, formatting the page numbers, adding 

references, and generating a list of references, as well as the skills of how to review your 

documents and send documents via mail merge, were discussed in the sessions. Besides these, 
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working with security and document protection was discussed under this topic. Therefore, you 

have better skills in working with MS Word.  

Review Question: 

Multiple questions  

1.  What feature in MS Word helps you automatically correct common spelling mistakes? 

A. AutoCorrect 

B. Thesaurus 

C. Word Count 

D. Grammar Check 

2.  What is MS Word Mail Merge? 

A. A feature used to create mailing labels, envelopes, and form letters 

B. A feature to combine multiple Word documents into one 

C. A feature that merges different file formats into one 

D. A feature used to send personalized emails to a group 

3. A document theme consists of three main components—theme colors, theme fonts, and theme 

effects. 

A. True 

B. False 

4. How do you use the Compare Documents feature in Word? 

A. Compare changes between two versions of a document 

B. Remove all formatting 

C. Edit text automatically 

D. View multiple documents side-by-side 

5. What is the “Thesaurus” feature in Word used for? 

A. Highlight text automatically 

B. Change document themes 

C. Provide synonyms and antonyms for words 

D. Insert text boxes 
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Session 3. Spreadsheet Proficiency (Microsoft Excel) 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Spreadsheet Proficiency 

(Microsoft Excel) 

Spreadsheet proficiency involves using Excel to manage, analyze, and visualize data using 

formulas, formatting, and charts. 

Learning objective  

To enable learners to perform efficient data management, analysis, and presentation in Excel 

 Know charts and Graphs  

 Insert formula and functions  

 Apply data analysis tools 

Content Outline: 

3.1 Charts and graphs 

3.2 Using Formulas & Functions 

3.3 Advanced Data Sorting & Filtering 

3.4 Data Analysis  

3.1 Charts & Graphs 

Excel charts are used to present large, complex 

datasets in a graphical format, making them easier 

to understand, visualize relationships, and quickly 

identify trends and comparisons. Charts help to 

convert raw numbers into visual elements like 

bars, lines, or slices. Excel offers a variety of chart 

types to suit different data visualization needs, helping you to convey information effectively. 

Figure 26 Excel Simple Table 
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 Some Key Reasons to Use Excel Charts: 

 Simplify Large Datasets: Charts transform large amounts of data into simple.  

 Identify Trends and Patterns: Visualizing data helps in quickly spotting patterns.  

 Show Relationships: Charts help to reveal correlations or comparisons.  

 Enhance Communication: charts are easier for presentations or reports.  

 Aid Understanding: Charts help to get the meaning behind the numbers for your audience.  

Variety of Chart Types: Excel supports numerous chart types, such as column charts, line charts, 

pie charts, and combination charts, allowing you to choose the best format for your data.  

Excel makes it simple to create charts by selecting your data and inserting the desired chart type 

from the menu.  You can easily modify and customize charts after they are created, adjusting chart 

types, colors, and elements to ensure your message is conveyed effectively.  

Steps to Create a Chart 

1. Select Your Data: Highlight the range of cells containing the data you want to visualize.  

2. Go to the Insert Tab: On the Excel 

ribbon, click the Insert tab. Choose 

a Chart Type: 

Recommended Charts: Click 

Recommended Charts to let Excel 

suggest suitable chart types based 

title, chart inserting on your data.  

3. Specific Chart Type: Select a 

specific chart type (like Line, Pie, or 

Column) from the Charts section of 

the ribbon.  

4. Insert the Chart: Select the desired chart from the options, and Excel will insert it directly 

onto your spreadsheet.  

Modifying and Customizing Your Chart 

Figure 27 Excel Charts 
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Figure 28 auto SUM (B2:B10) 

1. Select the Chart: Click on the chart to activate the chart tools. Or double-click the chart 

2. Access Chart Tools: When the chart is selected, the Chart Design and Chart Format tabs 

will appear on the ribbon.  

3. Add or Edit Elements: Add Chart Element: On the Chart Design tab, click Add Chart 

Element to add or modify elements like titles, axis labels, and data labels.  

Quick Layout: Use the Quick Layout command to apply predefined sets of chart elements.  

4. Change Chart Appearance: Chart Style: Use the Chart Styles group on the Chart Design tab 

to change the overall look of your chart.  

Change Chart Type: Click Change Chart Type on the Chart Design tab to switch to a 

different chart format.  

5. Adjust Data View: Click the Switch Row/Column or Select Data buttons to change how 

your data is displayed in the chart.  

3.2 Using Formulas & Functions:  

Formula Bar: A place where you can enter or view formulas or text 

Creating Formulas: A formula starts with an equal sign (=). It is possible to create formulas in 

Excel using the actual values, such as “4000*.4”, but it is more beneficial to refer to the cell address 

in the formula, for example, “D1*.4”. 

*The most common formulas in Excel are SUM, AVERAGE, and COUNT functions 

 

 

 

 

 

Nested If 
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Figure 30 sort ascending and Descending  

A nested IF in Excel involves placing one IF function inside another's argument to test multiple 

conditions and return different results. For example, if we wanted to insert students' status based 

on their average marks from Excellent to Fair, we would write the nested if statement on H2 and 

drag it below as follows.  

=IF(F2>90,"Excelent”, IF(F2>85,"V. Good", IF(F2>80,"Good","Fair"))) 

 

Figure 29 Excel - Nested if Table 

3.3 Data Sorting, Filtering, and Formatting  

A. Sort:  

Sorting rearranges rows and columns of data based on specific criteria, such as alphabetical, 

numerical, or chronological order, or even by custom lists, colors, or font styles. To sort data in 

Excel, select a cell within your data, go to the Data tab, and click the Sort button. 

If you select cells, Excel will think you only want to sort or filter by that selection, but if your 

dataset has no blank rows and no blank columns Excel will see the whole range as one dataset. 

 

  Ascending sorts   

1) Text: Sort alphabetically from A to Z 

2) Numbers: Sort from the smallest to the largest number 

3) Dates: Sorts from the newest date to the oldest date 

Descending Sorts 
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1.  Text: Sort alphabetically from Z to A      

2. Numbers: Sort from largest number to smallest number 

3. Dates: Sort from the oldest date to the newest date 

B. Filters:  

Show or hide specific data within a sheet based on defined criteria, making it easier to work with 

subsets of data. To apply a filter in Excel, first, ensure your data has a header row, then select any 

cell within the data range and navigate to Data > Filter to add dropdown arrows to your headers. 

Next, click the desired header's dropdown arrow to open the filter menu, where you can uncheck 

"Select All" and check only the specific values you want to view 

 

Figure 32 Excel Filter Table 

C. Conditional Formatting: 

Apply unique formatting (like color, icons, or data bars) 

to cells that meet specific, user-defined criteria.  Such as 

students who scored above 85. Select the cells and in the 

Home Tab  conditional formatting  highlight  

greater than “85”. 

  

3.4 Further Data Analysis  

A. Pivot Tables: 

Figure 33 Excel Conditional Formatting 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [34]                                 October, 2025 

A pivot table is an interactive tool for summarizing and analyzing large datasets, allowing you to 

group, count, average, and otherwise aggregate your data to reveal patterns and trends.  Pivot 

tables are a powerful data analysis tool available in spreadsheet programs like Microsoft Excel and 

Google Sheets. 

How It Works 

1. Select Your Data: Start with your raw data, which should be organized in a tabular format 

with a single header row.  

2. Insert a Pivot Table: In Excel, go to the "Insert" tab and select "PivotTable".  

3. Arrange Fields: A field list will appear. You can drag your data fields into the four areas of 

the pivot table:  

 Rows: Fields placed here define the rows in your summary.  

 Columns: Fields here define the columns.  

 Values: Fields placed here are typically the numerical data that will be aggregated (e.g., 

summed or counted).  

 Filters: Fields here allow you to narrow down the data shown in the pivot table.  

4.Analyze and Report: Your pivot table will update dynamically, allowing you to analyze 

relationships, spot trends, and present concise reports.  

Common Uses: Summarizing sales data by region and product, Identifying outliers in large 

datasets, Comparing metrics across different categories, and Creating interactive dashboards for 

reporting. 

B. Power Query: 

Connect to external data sources, clean, transform, and load data directly into Excel, streamlining 

data preparation.  

How Power Query Works: Power Query follows a simple, automated process known as ETL 

(Extract, Transform, Load):  
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1. Extract: Connect to a data source, such as a web page, a database, a folder of files, or 

another Excel workbook.  

2. Transform: Clean and reshape the data within the Power Query Editor. This involves steps 

like removing columns, filtering rows, changing data types, replacing values, and splitting 

columns.  

3. Load: Load the transformed data into an Excel table for further analysis, charting, or 

reporting.  

Example: 

Method 1: Link to a Specific Cell (Static Link) This method creates a static link to a particular 

cell. The following example shows how to do a Roster from three subjects. 

1. Open both workbooks/sheets: – the source workbook (with the data) and the destination 

workbook (where you want the data).  

2. Select the destination cell in your new workbook where the linked data should appear.  

3. Type an equal sign: (=) to start a new formula.  

4. Switch to the source workbook.  

5. Click the cell you want to link to.  

6. Press Enter. Excel will automatically populate the formula in the source workbook's name, 

worksheet, and cell.  

7. Use the summation formula for total marks, the average formula, and the rank formula from 

the formula function to summarize the roster.  
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Practical Exercise  

Assume you are requested to work on the Inventory Management and Reordering System 

You are managing inventory for a warehouse. You need a system that flags items that need to be 

reordered and calculates the required order quantity. 

Your Raw Data (Columns in a sheet named Inventory): 

 ProductID 

 ProductName 

 CurrentStock 

 MinimumStockLevel (reorder point) 

 Supplier 

 LeadTime (in days) 

Your Tasks is  

1. Automatic Reorder Flags: 

Figure 34 Link Different Sheets Value to one 
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o Use an IF statement to create a "Reorder Status" column. If CurrentStock is less than or equal 

to MinimumStockLevel, it should display "ORDER NOW", otherwise "OK". 

o Use Conditional Formatting to highlight entire rows where the status is "ORDER NOW" in 

red. 

2. Calculate Order Quantity: 

o Add a column "Order Quantity". The logic should be: (MinimumStockLevel * 2) - 

CurrentStock. This ensures you order enough to bring stock back to a safe level. 

o Use an IF statement so that this calculation only appears for items that need reordering; 

otherwise, the cell should be blank. 

3. Supplier Summary Report: 

o On a new sheet, use the FILTER function (or PivotTable) to create a list that shows only the 

items that need reordering, grouped by Supplier. This is the list you would send to each 

supplier. 

4. Advanced: Projected Stock-Out (Optional): 

o Assume you have a separate sheet with SalesForecast (units predicted to sell per day). 

o Use a VLOOKUP/XLOOKUP to bring the forecast into your inventory table. 

o Create a "Days Until Stock-Out" column: =CurrentStock / SalesForecast. Format this to show 

warnings for values less than the LeadTime. 

Summary  

Excel provides various tools for managing statistical and numerical data. This session covers the 

advanced features of Excel, such as using charts, using formulas and functions, data analysis tools 

that enable users to sort, filter, and use pivot tables to organize and visualize data, identify patterns, 

and extract insights.  

Review question  

Multiple choice  

1. What is the correct formula to calculate the average of cells B2 through B10? 

A. =SUM(B2:B10) 

B. =AVERAGE(B2:B10) 
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C. =COUNT(B2:B10) 

D. =MAX(B2:B10) 

2. What is the difference between relative and absolute references in Excel? 

A. Relative references always point to A1, absolute references do not 

B. Relative references adjust when copied, absolute references remain fixed 

C. Relative references are for charts only 

D. Absolute references change automatically 

3. Which tool allows you to highlight cells that meet certain conditions (e.g., values greater than 

5000)? 

A. Data Validation 

B. Conditional Formatting 

C. PivotTable 

D. Goal Seek 

4. Which Excel feature is best for visually representing sales growth over time? 

A. Sort 

B. Filter 

C. Chart 

D. Freeze Panes 
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Module 2: Information and Data Literacy 

Introduction 

In today’s digital world, the ability to handle files effectively is a core digital literacy skill. Whether 

it’s converting files into different formats, compressing them for easier storage and sharing, or 

managing them securely across networks, these skills are essential for both personal and 

professional use. 

Three main topics will be covered in this module: Learn how to convert files across formats in 

Session 1 to guarantee compatibility, enhance usability, and modify files for various software or 

devices. The second session contains Compression and Decompression of Files. Learn how to 

recover compressed files to their original format and how to minimize file sizes for quicker sharing 

and easy storage. Third Session: Backup and Network File Management To ensure data security 

and accessibility, learn how to arrange, exchange, and safeguard your files across networks and 

cloud platforms. 

Session 1: File conversion 

Introduction  

Dear learners, welcome to this session. In this session, you will explore File conversion 

In this session, we will learn how to convert files from one format to another, an essential digital 

skill that allows you to share, edit, or open files across different devices and software. File 

conversion is the process of changing a digital file’s format so it can be opened, modified, or used 

by various programs or platforms. This is especially useful when a file doesn’t open on your 

device, needs to be shared in a compatible format, or must be compressed for easier transfer. 

Understanding how to convert files effectively ensures greater flexibility, accessibility, and 

efficiency in managing digital content. 

Learning Objectives 

By the end of this session, learners will be able to:  
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 Identify common methods of file conversion. 

 Demonstrate the use of built-in software to convert files. 

 Explore online file conversion tools for quick, cross-platform file format changes. 

Content Outline: 

1.1 File Conversion and Its Importance 

1.2 Methods of file Conversion 

1.1 File Conversion and Its Importance 

File conversion is the process of changing a file from one format to another. It can be done using 

dedicated software, online tools, or built-in features in many applications.  

For example, convert a Word document (.docx) into a PDF (.pdf), xlsx to .csv, Bmp to jpg MP4 

to MP3, etc  

Importance of File Conversion in Digital Literacy 

 Collaboration across different platforms. 

 Data preservation and archival. 

 File optimization for web or mobile use, such as a smaller size for web or high quality for 

printing. 

 Support different devices and applications in different file formats. 

Reflective questions: 

1. List the importance of File conversion. 

2. How does file conversion affect accessibility and compatibility? 

1.2 Methods of File Conversion 

Have you ever tried to open a file that your device couldn’t read? What did you do? 
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File conversion changes a file from one format to another to ensure compatibility, reduce size, or 

meet specific usage needs. Some of them are Built-in software, online file conversion tools, and 

Mobile apps for conversion. 

Some of the common File Conversion methods are: 

1. Using Offline Software 

Many applications can support or export files into different formats without needing extra tools. 

Such as MS-Word, MS-Paint, Nitro PDF, VLC player, etc. Examples: MS Word → PDF, BMP 

→ JPEG, and MP4 to MP3, etc. 

2. Online File Conversion Tools 

Web-based platforms that allow you to upload a file and download it in a new format. Example: 

Cloud Convert (DOCX → PDF), OneDrive (Excel → CSV), etc.  

Step for File Conversion 

A. Convert Word to PDF 

Example: Word → PDF - MS Word 2013 or later can easily convert Word files to PDF.  

 Step 1: Open a Word 2013 document, 

click “File” on the top Menu Bar, as shown in 

the following screenshot. 

 Step 2: In the next interface, choose “Save 

As” on the left and tap the Browse folder on the 

right.  

 Step 3: As the Save As window turns up, click 

the Word Document bar beside Save as type, 

select “PDF” in the pop-up list, and tap the 

Save option. 

Figure 35 Save as PDF Option 
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B. Convert the PDF back to Word  

Nitro converter is one of the tools that helps you convert PDF to Word. If you don’t have download 

from https://nitro-pdf-

reader.en.softonic.com/download  

I. Open your PDF document on 

Nitro PDF reader 

II. Select the convert group and click 

on To Word 

C. Convert Video to MP3 

Find VLC Media player on your 

computer if not installed, install it  

from https://images.videolan.org/vlc/ 

1. Open the VLC player 

2. Click on Media 

3. Click on “Convert/save “ 

4. Add your video file  

5. Click the convert/save drop-

down 

6. Select MP3 and convert your 

file to Audio  

Exercise: Do the following exercise based on the information is given below. 

1. Using File Explorer, locate a Word document (e.g., exerse2.docx) and open it in its default 

application. 

2. Convert the Word document exerse2.docx into a PDF file. 

3. Open the newly converted PDF file to ensure it displays correctly. 

    a. Did the PDF open without errors? 

    b. Was the formatting (text, images, layout) preserved from the original Word document? 

Using Online Tools: 

Figure 36 Nitro PDF to Word 

Figure 37 VLC Media Player convert Video to MP3 

https://nitro-pdf-reader.en.softonic.com/download
https://nitro-pdf-reader.en.softonic.com/download
https://images.videolan.org/vlc/


Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [43]                                 October, 2025 

Using Cloud Convert on Computers or mobiles: 

Steps:  

1. Open a Web Browser 

 Open Microsoft Edge, Chrome, or Firefox. 

 Go to the website: https://cloudconvert.com 

2. Select the File to Convert 

 Click “Select File”. 

 Choose a file from your 

computer, Google Drive, 

Dropbox, or via URL. 

3. Choose Conversion Format 

 After uploading, select the 

output format from the dropdown menu (e.g., MP4 → MP3).  

4. Adjust Conversion Settings 

(Optional) 

 Click the wrench icon 

to change settings like 

resolution, quality, or 

file size. 

 This step is optional; 

you can skip if default 

settings are fine. 

5. Start Conversion 

 Click “Convert” to begin. 

Figure 38 Cloud file conversion page 

Figure 39 Choosing file type for conversion 

https://cloudconvert.com/
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Figure 40 File converting 

 Cloud Convert will process the file. 

6. Download the Converted File 

 After conversion, click “Download” to save the file to your computer. 

 

Figure 41: Converted file downloading 

7. Access Converted File 

 Open the folder where you saved the file and check it. 

 You can now use or share it as needed. 

Reflection Questions 

1. Why is online file conversion is useful compared to using desktop software? 

2. What types of files might you need to convert in your school or work projects? 

Exercise: Do the following task based on the information given below. 

a. Open your web browser and go to https://cloudconvert.com. 

b. Upload a file from your computer. 

c. Choosing a Target Format 

https://cloudconvert.com/
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d. Convert the file and then download the converted file. 

Summary 

File conversion involves transforming files from one format to another to ensure compatibility, 

usability, or optimization. Common types of file conversion include document conversion (e.g., 

Word to PDF), image conversion (e.g., JPEG to PNG). These methods may vary in speed, quality, 

and security depending on the file type and conversion requirements. at this point, you are familiar 

with the basics of converting work to PDF and vice versa, converting Video to MP3.  

Review Questions 

Multiple Choices   

1. Which of the following best describes file conversion? 

A. Copying a file from one folder to another 

B. Changing a file from one format to another to suit a specific purpose 

C. Compressing a file to reduce its size 

D. Downloading a file from the internet 

2. Why is file conversion important in digital work? 

A.  It helps in upgrading the operating system 

B. It allows files to be compatible with specific software or devices 

C. It makes files automatically compress themselves 

D. It removes viruses from files 

3. Which of the following is NOT a common method of file conversion? 

A. Using built-in software 

B. Using online conversion tools 

C. Using mobile conversion apps 

D. Restarting the computer 
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4. In Windows 11, what is the first step in converting a file format using built-in software like 

Paint or Word? 

A. Right-click the file and select “Convert Now” 

B. Open the file in a compatible program 

C. Compress the file into a ZIP folder 

D. Rename the file with a new extension 

5. When using Cloud Convert on Windows 11 to convert files, which step usually comes first 

after visiting the website? 

A. Dragging and dropping or uploading the file you want to convert 

B. Downloading the converted file 

C. Choosing the output format 

D. Signing out of your account 

6. Which of the following is an advantage of using online tools for file conversion like Cloud 

Convert? 

A. They work only without internet 

B. They require no software installation on the computer 

C. They can only convert image files 

D. They delete the original file automatically 
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Session 2: File Compression and Decompression 

Introduction: 

Dear learners, welcome to this session. In this session, you will explore File Compression and 

Decompression  

File compression is a crucial skill in digital literacy that entails minimizing the size of digital files 

(compression) to conserve storage space and enable quicker sharing, followed by restoring those 

files to their initial state (decompression) when required. This procedure is vital for the efficient 

management of digital content, allowing users to systematically organize, store, and communicate 

data effectively across different devices and platforms. 

Learning Objectives: 

By the end of this session, learners will be able to: 

 Define file compression and decompression.  

 Identify common file compression formats  

 Use appropriate software tools to compress and decompress files and folders across 

different devices and operating systems. 

Content Outline: 

2.1 File Compression and Decompression 

2.2 File Compression and decompression Formats and Tools  

2.1 File Compression and Decompression 

File Compression 

Have you ever had trouble sending a file because it was too large?  What did you do? 

Do you think videos, photos, or text documents compress the most?  Why? 
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File compression reduces the size of files or folders to save storage space or make them easier to 

share. And Decompression (or extraction) restores compressed files to their original form. 

Types of File Compression  

1. Lossless Compression: is a type file compression ensures that no data is lost during 

compression. When decompressed, the file returns to its original form (e.g., text files, software 

files).  Example: ZIP, GZIP , 7Z,etc 

2. Lossy Compression: is another type of compression that some data is permanently removed 

to reduce file size. This is commonly used for multimedia files like images, audio, and video 

where perfect quality is not always necessary. Example: MP3 (audio), JPEG (images), MP4 

(video).  

Importance of File Compression 

 Reduces file size, optimizing storage on local drives and cloud platforms. 

 Enables faster uploads and downloads, saving time and bandwidth. 

 Makes backups smaller, easier to store, and quicker to manage. 

 Ensures compatibility across devices and operating systems. 

 Helps organize and manage large collections of documents, images, and media efficiently. 

 Restores files to their original state during decompression, preserving integrity. 

Reflective questions 

1. Why compress files to manage storage and improve file transfer efficiency? 

File Decompression 

File decompression (also called extraction) is the process of restoring a compressed file back 

to its original format and size. After compressing files to save storage space or make sharing 

easier, decompression allows you to access the content just as it was before compression. 

Key Points about File Decompression 

1. Purpose: 
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o To retrieve and use files that were previously compressed. 

o Ensures the original data, quality, and structure are preserved. 

2. Types of Decompression: 

o Lossless Decompression: Returns the file to exactly its original state without any 

data loss. Example: ZIP, GZIP, 7Z. 

o Lossy Decompression: Restores a file to a usable form, but some original data 

removed during compression may not be recovered. Example: MP3 (audio), JPEG 

(images), MP4 (video). 

3. Why It Matters: 

o Access files for editing, viewing, or sharing. 

o Restore files for proper functionality in applications. 

o Maintain data integrity when sharing across devices and platforms. 

4. How It Works: 

o A compressed file is typically in a format like .zip, .rar, .7z, or .tar. 

o Decompression software (e.g., WinRAR, 7-Zip, Windows built-in extractor, or 

macOS Archive Utility) reads the compressed data and rebuilds it into the original 

files or folder structure. 

o Once decompressed, files are ready to use without errors. 

2.2 File Compression and decompression Formats and Tools  

Common compression formats and tools are methods and software used to reduce the size of digital 

files and bundle multiple files into a single archive for easier storage, sharing, and management. 

Examples like ZIP, RAR, 7z, TAR, etc.  
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Some of the common Compression Formats and Tools are: 

Compression Formats  

 ZIP: A widely used lossless compression format supported natively by Windows, macOS, 

and many other systems.    

 RAR: A proprietary compression format offering high compression ratios and error recovery 

features (requires WinRAR or similar).  

 7z: An open-source format using high-compression algorithms, supported by 7-Zip software.  

 Use: Compressing large game files or software packages 

 GZIP: A lossless compression format mainly used in UNIX/Linux environments and for 

compressing web content.  

Tools for Compressing and Decompressing  

 WinRAR: A tool for creating and extracting RAR and ZIP files with advanced compression 

and encryption.  Download from: https://www.win-rar.com/download  

 7-Zip: Free, open-source compression tool supporting multiple formats including 7z, ZIP, and 

TAR. Download from: https://www.7-zip.org/download.html 

 WinZip: A commercial tool for ZIP and other formats, with cloud integration and encryption 

features. Download from  https://www.winzip.com/en/download/  

 GZIP: gzip (GNU zip) is a compression utility designed to be a replacement for 

compress. Download available from: https://ftp.gnu.org/  

Steps for File Compression  

Figure 42 Common file format 

https://www.win-rar.com/download
https://www.7-zip.org/download.html
https://www.winzip.com/en/download/
https://ftp.gnu.org/
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In this lesson, we will focus on how to apply these common steps using popular compression tools. 

This will help learners understand practical usage while choosing the right format for their needs. 

File Compression in Computers 

Using Zip Files in Windows Using File Explorer  

1. Press Win + E to open File 

Explorer. Select files/folders. 

2.  Right-click > "Show more options" 

> "Sent to". 

3. Click "Compressed (zipped) 

folder." 

4. A new zipped folder (.zip) appears 

at the same location 

Steps for File Decompression 

Extract ZIP Files 

Method 1: Unzip Files in Windows Using File 

Explorer by  

1.  Press Win + E to open File Explorer. Select 

files/folders to extract. 

2. Right-click > "Extract All". 

3. Choose the extraction destination. 

4. Click "Extract" to unzip the files. 

Activity 1: Do the following tasks based on the information given below. 

1. Select 3 files of different types (e.g., a document, an image, and a video). 

2. Use the above compression tool to create a compressed file. (ZIP or RAR). 

3. Compare the file size before and after compression. 

Figure 44 File decompression 

Figure 43 File compression 

https://www.geeksforgeeks.org/techtips/open-file-explorer-windows-11/
https://www.geeksforgeeks.org/techtips/open-file-explorer-windows-11/
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4. Extract all files to a new folder. 

5. Open the compressed file created in question number 2. 

6. Check if all files are intact and usable. 

Steps to Compress Files on Mobile using Android - ZArchiver   

Once you download ZArchiver from the Google Play Store, follow these steps to create a ZIP file 

on your phone: 

1. Organize the files and folders you want to compress into a single folder using a file manager. 

2. Launch ZArchiver, locate the organized folder, and long-press it. 

3. Tap Compress to *.zip to start file compression. 

4. Monitor the status bar that pops up until it reaches 100%. 

5. Your ZIP file should be ready, and you can locate it in the same place as the original folder in 

your file manager. 

Exercise: Based on the information given below, do the following tasks. 

1. Install ZArchiver from the Google Play Store. 

2. Use a mobile app (like ZArchiver) to compress a set of at least three image files from your 

mobile phone. 

3. You receive a ZIP file containing multiple documents via email. To view and use these 

files: 

1. Right-click the ZIP file. 

2. Select Extract All (Windows) or Open With → Archive Utility (Mac). 

3. Choose a destination folder. 

4. Access the decompressed files in their original formats, ready for editing or 

sharing. 

Summary 

File compression is the process of reducing the size of files to save storage space, facilitate faster 

file transfers, and simplify backups, either through lossless methods that preserve all data or lossy 

methods commonly used for multimedia files.  Common compression formats include ZIP (widely 

supported), RAR (high compression with extra features), 7Z (very high compression and 

encryption), and TAR/GZ (popular on Linux/Unix).  



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [53]                                 October, 2025 

Tools such as WinRAR, 7-Zip, WinZip, and mobile apps like ZArchiver help to create, extract, 

and manage compressed files, making file organization and digital storage more efficient across 

devices and platforms. 

Review Questions 

Multiple Choices  

1. What is the main purpose of file compression? 

A. To change a file from one format to another 

B. To reduce the file size for easier storage and transfer 

C. To encrypt a file for security 

D. To delete unnecessary files automatically 

2. Which of the following is NOT a benefit of file compression? 

A. Faster file transfer over the internet 

B. Saving storage space on devices and cloud 

C. Improving file compatibility with certain software 

D. Increasing the file’s original size for higher quality 

3. Which of these is a common compressed file format? 

A.  DOCX 

B. .ZIP 

C. .MP3 

D. .TXT 

4. Which tool is widely used to create and extract ZIP files in Windows? 

A. Adobe Photoshop 

B. WinRAR 

C. VLC Media Player 
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D. Microsoft Excel 

5. Why does someone compress files before sending them via email? 

A. To make them look more professional 

B. To bypass email attachment size limits 

C. To convert them to a different format automatically 

D. To prevent them from being opened by others 

6. Which of the following is an example of a lossless compression format? 

A. JPEG 

B. PNG 

C. MP4 

D. MP3 
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Session 3: Network File Management and Backup 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Network Management and 

Backup  

Welcome to today’s session on Network File Management and Backup. We’ll explore how to 

organize, share, and protect files across networks efficiently.  

Network File Management involves organizing, storing, and retrieving digital files across a 

network. 

It includes sharing files, controlling access, and ensuring data security. Users can locate and 

retrieve files from network locations and save documents in shared folders. Setting permissions 

and using version control help maintain data integrity. Overall, it enables secure and efficient 

collaboration in networked environments. 

Learning Objectives 

By the end of this session, learners will be able to: 

 Understand the concept of sharing files using a Local Area Network. 

 Identify popular cloud storage providers and their key features. 

 Demonstrate how to upload, organize, and manage files in the cloud effectively. 

 Practice how to share files and folders in Google Drive using a computer. 

Content Outline: 

       3.1 Network File Management  

       3.2 Cloud Storage and Backup   
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3.1 Network File Management  

Network file management is one of the digital literacy skills that involves organizing, storing, and 

protecting files across connected devices within a network. Effective network file management 

ensures that digital data is accessible, well-organized, and securely shared among users or systems 

in an organization or home environment. 

Sharing a File using Local Area Network (LAN): 

A Local Area Network (LAN) is a network that connects computers and devices within a limited 

area, such as a home, school, or office, allowing them to share resources like files, printers, and 

internet connections. 

To share files over a LAN in Windows 11, you first need to enable Network Discovery and File 

and Printer Sharing in the advanced sharing settings. This allows other computers connected to the 

same local network to find your device and access shared files securely. 

Steps to Share a Folder in Windows 11 

On Windows, you can either use the public folder to share files or share the folder you created to 

users on the LAN.  

To use the C:\Users\Public folder to share files, place files in, to make them accessible to all users 

on the computer and potentially to others on your network. For network sharing, you must also 

ensure the network sharing settings in the Control Panel are configured to allow public folder 

access.  

I. Using the C:\Users\Public Folder 

 Locate the folder: Open File Explorer and navigate to This PC > Local Disk (C:) > Users 

> Public.  

 Add files: Open one of the default subfolders (e.g., Public Pictures) and copy or move 

the files you want to share into it.  

 Access files: Other users on the same computer can now access these files by navigating 

to their own C:\Users\Public folder.  
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Network Sharing Settings 

To make files in the Public folder accessible to others on your network, you must enable public 

folder sharing in the network settings:  

 Open Control Panel: Search for and open the "Control Panel" on your computer. 

 Go to Network and Sharing Center: Click on "Network and Internet" and then select 

"Network and Sharing Center". 

 Change advanced sharing settings: On the left side, click on "Change advanced sharing 

settings". 

 Turn on sharing: Under "Public folder sharing," select the option to "Turn on public folder 

sharing". 

 Save changes: Click "Save Changes" to apply the settings. 

With these steps, files in the Public folder will be visible and accessible to others 

II. Locate the Folder 

 Open File Explorer. 

 

 

 

 

 

 

Figure 45: File placing for local sharing 
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 Navigate to the folder you want to share. 

2. Open Properties 

 Right-click the directory you want to share and 

select Properties. 

 Go to the Sharing tab. 

3. Enable Sharing 

 Click Share… to open the File Sharing window. 

  

 Choose the users you want to share with from the dropdown menu or type their names. 

 Set the permission level (Read or Read/Write) for each user. 

 Click Share, and in the coming dialog box, click on the Done button and then the close 

button. 

How to access the shared folder? 

Steps:  

Figure 47: Choosing the people to share with 

Figure 46: Sharing the file 
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Method 1: Access Shared Files from Another Device:  

o Open File Explorer → in the address bar type: 

o \\ ComputerName  or \\ IPaddress 

o Browse and copy files as needed. 

Method 2: Access from another computer:  

     Press Windows + R, type \\ComputerName\SharedFolder. 

Exercise: Based on the given information, do the following tasks. 

1. Create a new folder on your desktop called ClassDocuments and share it with other users on the 

same network. 

A. Which steps did you follow to create the folder? 

B. How did you share the folder with other users? 

C. What permission level did you assign when sharing? 

2. Access the ‘ClassDocuments’ folder from another computer on the same LAN. 

A. How did you find the shared folder on the other computer? 

B. Did you use the network path or IP address it as a network drive? 

C. Were you able to open files in the shared folder? 

3. Change the permissions of the ‘ClassDocuments’ folder to allow a specific user full control. 

A. Which steps did you follow to modify the permissions? 

B. How can you verify that the user now has full control? 

4. Stop sharing the folder after completing your project. 

A. Which steps did you follow to stop sharing the folder? 

B. How did you confirm that the folder was no longer shared on the network? 

file://///ComputerName
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3.2 Cloud Storage and Backup   

Have you ever shared a file with someone without using email? How did you do it? 

What’s the most important file on your computer that you’d want to back up? 

Cloud storage services like Google Drive, OneDrive, and Dropbox let you save files online, sync 

them across devices, and access them anytime. They function as both storage (keeping files safe 

in the cloud) and backup (protecting against local device loss or damage). 

On computers, install the desktop app, sign in, and drag files into the synced folder to upload 

automatically. 

On mobile, install the app, sign in, and use the upload or backup feature to store photos, documents, 

and videos online. 

Cloud storage is a service that allows users to store, manage, and access files over the internet 

instead of on a local computer or physical storage device. Files are saved on remote servers 

maintained by cloud providers such as Google Drive, OneDrive, Dropbox, or iCloud. 

Functions of Cloud Storage 

 Accessibility: Access files from any device with an internet connection. 

 Collaboration: Multiple users can view, edit, and comment on files in real-time. 

 Data Protection: Cloud storage often includes automatic backups and version history. 

 Scalability: Easy to increase storage space as needed. 

Good Practices 

 Use both local and cloud backups for maximum data protection. 

 Regularly update backups to include recent changes. 

 Organize files and folders consistently for easy retrieval. 

 Ensure cloud accounts are secure with strong passwords and two-factor authentication. 

Cloud Storage Providers 
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Cloud storage providers are service providers that allow users to store, manage, and access files 

online, offering features such as file synchronization, sharing, collaboration, and backup. 

Common Cloud Storage Providers: 

1. Google Drive 

 Free storage: 15 GB (shared with Gmail and Google Photos). 

 Features: Real-time collaboration (Docs, Sheets, Slides), file versioning, link sharing. 

 Platforms: Web, Windows, Mac, Android, iOS. 

2. Microsoft OneDrive 

 Free storage: 5 GB (upgradable with a Microsoft 365 subscription). 

 Features: File synchronization, collaboration with Office apps, version history. 

 Platforms: Web, Windows, Mac, Android, iOS. 

3. Dropbox 

 Free storage: 2 GB (upgradable with paid plans). 

 Features: File sharing, versioning, smart sync, integration with third-party apps. 

 Platforms: Web, Windows, Mac, Linux, Android, iOS. 

4. iCloud 

 Free storage: 5 GB (Apple ecosystem). 

 Features: Syncing across Apple devices, backup for iOS devices, file sharing. 

 Platforms: Mac, iOS, Windows, Web. 

5. SharePoint / OneDrive for Business 

 Features: Enterprise collaboration, document libraries, advanced permissions, integration 

with Microsoft 365. 

 Platforms: Web, Windows, Mac, mobile apps. 
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Reflection Questions 

1. List at least three cloud storage providers. 

2. Discuss the advantages of storing files in the cloud. 

Uploading and Managing Files on the Cloud 

Cloud storage allows users to upload, organize, and manage digital files online. Efficient 

management ensures easy access, sharing, collaboration, and secure backup of files. 

Uploading Files and Folders  

A. From Computer: 

o Using the web interface or cloud desktop apps 

(Google Drive, OneDrive, Dropbox). 

o Drag-and-drop or “Upload” button for 

files/folders. 

 Upload Files and Folders to Google Drive 

(Computer) 

1. Open Google Drive 

2. Go to https://drive.google.com in a web 

browser. 

Figure 48 Selecting google drive 
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3. Locate and Sign in with your Google account in with email address and password. But, if 

you don’t have an account, select Sign up to create an account. 

4. Your Google Drive will appear here, and locate and select the grid's upper corner, choose 

your Google Drive appear here. 

5. Choose Upload Method 

Option A – Using the “New” Button 

1. Click New on the top-left menu. 

2. Select File upload to upload 

individual files or Folder upload 

to upload an entire folder. 

3. Browse your computer and select 

the file(s) or folder(s). 

4. Click Open to start the upload. 

Option B – Drag and Drop 

1. Open the folder on your computer that contains the files/folders. 

2. Drag the file(s) or folder(s) directly into the Google Drive browser window. 

3. Wait for the upload progress bar to finish. 

Exercise: Do the following questions based on the information below. 

1. Create an account in a cloud storage service using Google Drive. 

2. Upload at least two files (documents, images, or videos) to your cloud storage. 

a. Which files did you upload? 

b. Where in your cloud storage did you save them? 

c. How long did the upload take? 

3. Create folders and move your uploaded files into appropriate folders. 

       a. What folders did you create? 

       b. How did organizing files into folders help manage your storage? 

Figure 49 Upload file to google drive 
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Share Files and Folders in Google Drive  

Steps:  

1. Open Google Drive 

 Go to https://drive.google.com in a web browser. 

 Sign in with your Google account. 

2. Drag and drop the file directly into your Drive.  

 Browse My Drive, Shared 

drives, or search for the 

file/folder you want to share. 

3. Open Sharing Options: 

Alternatively, select the item and 

click the Share icon at the top-right of 

the screen. 

4. Choose Sharing Method: Add people or 

groups: Enter email addresses of recipients. 

 Share via link: Click Copy link to create 

a shareable link. 

5. Set Permissions 

 Viewer: Can only see or download the 

file. 

 Commenter: Can view and add comments. 

 Editor: Can view, edit, or delete the file. 

6. Send or Copy Link 

Figure 50 Share drive Document 

Figure 51 Set Permission 
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 Click Send to notify recipients via email. 

 Or click Copy link and share manually through messaging apps or email. 

Sync Files and Folders to Google Drive: 

1. Open Your Browser 

o On your Windows 11 computer, open Google Chrome (recommended), Microsoft Edge, 

or Firefox. 

2. Go to Google Drive 

o Type drive.google.com in the address bar and press Enter. 

3. Sign in to Your Google Account 

o Enter your Gmail address and password, then click Next. 

4. Upload a File 

o Click the + New button (top-left corner). 

o Select File upload. 

o In the Windows file picker, locate the file you want to upload. 

o Click Open to start the upload. 

5. Upload a Folder 

o Click + New again. 

o Select Folder upload. 

o Choose the folder from your computer and click Upload. 

6. Drag-and-Drop (Quick Method) 

o Open File Explorer (Windows key + E). 

o Drag the file or folder from File Explorer and drop it into your Google Drive browser 

window. 

7. Wait for Upload to Finish 

o Check the progress box in the bottom-right of Google Drive. 

o When you see a green checkmark, the upload is complete. 

8. Verify the Sync 

o Refresh the page (F5). 

o Your files/folders should now appear in My Drive and be accessible from any device with 

your account. 
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Exercise 1- Do the following questions based on the information given below.  

1. Create a new folder in Google Drive named ‘Group Project’. 

2. Upload multiple files into the ‘Group Project’ folder i.e. upload at least two files and organize. 

them inside the folder. 

3. Share the ‘Group Project’ folder with a classmate or trainer with set permission for editing. 

6. Remove all shared access for the Group Project folder. 

7. Demonstrate version control using Google Drive. 

Summary 

Network file management and backup are essential skills for organizing, storing, and protecting 

files while ensuring efficient access and security. LAN sharing enables computers on the same 

network to exchange files quickly and securely. On the other hand, Cloud storage and backup store 

files on remote servers, allowing safe access from multiple devices and easy recovery from data 

loss. Cloud Providers like Google Drive, Dropbox, OneDrive, and iCloud offer file 

synchronization, sharing, and storage management features. Applying LAN sharing and cloud 

storage improves collaboration, file accessibility, and overall data security. 

Review Questions 

Multiple Choices  

1. Which of the following best describes file sharing over a Local Area Network (LAN)? 

A. Uploading files to a public website 

B. Transferring files using a USB drive 

C. Allowing devices on the same network to access shared files or folders  

D. Storing files in the cloud for public download 

2. Which of these is NOT an example of a cloud storage provider? 
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A. Google Drive 

B. Dropbox 

C. Microsoft OneDrive 

D. File Explorer  

3. What is the first step in uploading files to most cloud storage services? 

A. Rename the file 

B. Log in to your cloud storage account  

C. Compress the file into ZIP format 

D. Share the link with others 

4. In cloud backup, what is one advantage compared to local backup? 

A. It is not affected by physical damage to your device  

B. It does not require an internet connection 

C. It is faster than any other backup method 

D. It can only store text documents 

5. When managing files in the cloud, which action helps keep storage organized and efficient? 

A. Uploading files without folders 

B. Using clear folder names and regularly deleting unnecessary files  

C. Storing all files in the root directory 

D. Avoiding file version history features. 
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Module 3: Communication and Collaboration 

Introduction 

Imagine working on a school project with classmates who live in different cities you need to 

exchange ideas, edit shared documents, and present your results, all without ever meeting face-to-

face. How would you make it work? This module helps you find the answer by exploring the 

essential skills for effective online communication, collaboration, and responsible digital 

engagement.  

Therefore, the module consists of four sessions. Session 1 focuses on online communication and 

virtual meetings, Session 2 explores collaboration through various digital technologies, Session 3 

addresses how to express oneself as a digital citizen online, and finally, Session 4 examines how 

one can manage their digital identity. By the end of this module, you will be able to communicate 

and collaborate confidently online, share and co-create digital content safely and ethically, 

participate actively in digital communities, and protect your digital identity and reputation in an 

increasingly connected world. 

Session 1: Online Communication & Virtual Meetings 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Online Communication 

and Virtual Meeting  

Online communication and virtual gatherings utilize digital resources such as internet-enabled 

devices and conferencing applications to link individuals in various locations for immediate 

discussions, teamwork, and the sharing of information. You have just received an invitation to a 

virtual meeting with a group of unfamiliar individuals. Some participants are in your age group, 

while others are older. Some reside in Ethiopia, whereas others live in other countries. How will 

you ensure that your message is clear, respectful, and comprehensible for everyone? 
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In this session, we’ll explore how to communicate effectively online and master virtual meetings 

from preparation to follow-up so that you can collaborate confidently in diverse, digital 

environments. 

Learning Objectives 

By the end of this session, you will be able to: 

 Apply principles of effective online communication. 

 Adapt communication styles to accommodate cultural and generational differences. 

 Differentiate between synchronous and asynchronous communication tools 

 Set up, participate, and follow up virtual meetings using professional etiquette. 

Content outline   

1.1  Principles of effective online communication 

1.2  Synchronous Vs. Asynchronous communication 

1.3  Set up and participate in virtual meetings professionally 

1.1 Principles of Effective Online Communication  

Before we explore the principles of effective online communication, it is important to understand 

what communication is. Communication is the process of sharing information, ideas, thoughts, 

or feelings between individuals or groups, enabling understanding and connection. It can take 

several forms: 

 Verbal Communication - Using spoken or written words. 

 Non-Verbal Communication - Using body language, facial expressions, gestures, and 

tone of voice. 

 Visual Communication - Using images, charts, diagrams, or videos to convey meaning. 

 Digital Communication - Using online tools, social media, emails, and messaging 

platforms to share messages. 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [70]                                 October, 2025 

Effective communication occurs when the message sent is accurately received and understood as 

intended. In face-to-face interactions, messages are often supported by gestures, facial expressions, 

and tone of voice. In online settings, particularly in text-based communication, these cues are 

absent, making the words themselves even more significant. 

Therefore, effective online communication is not just about what you say it also involves how you 

say it and how attentively you listen to others. Following key principles of clarity, engagement, 

and understanding helps ensure your message is interpreted correctly and fosters meaningful 

digital interactions. 

Clarity: Your message should be easy to read, understand, and act on. Avoid long, complicated 

sentences or unnecessary details. 

Tips for clarity: 

 Use short sentences. 

 Start with the most important information. 

 Use bullet points for multiple ideas. 

 Avoid jargon unless you’re sure your audience understands it. 

Tone: is the emotional quality of your message or voice. Online, it can be tricky without facial 

expressions or voice inflection; the same words can sound friendly, neutral, or rude. 

Why it matters: A misunderstood tone can cause conflict or make others feel unwelcome. 

Tips for managing tone: 

 Use polite, positive wording. 

 If appropriate, add a friendly greeting or closing. 

 Be cautious with humor—it may not translate well across cultures. 

 Use emojis/icons sparingly to soften tone, if the setting allows. 

Respect: Respect in communication means valuing others’ opinions, ideas, and time. 
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Why it matters: Respectful communication builds trust and encourages collaboration. 

Tips for showing respect: 

 Acknowledge others’ contributions (“Good point, I agree…”). 

 Avoid interrupting during calls. 

 Avoid using all caps (it can feel like shouting). 

 Don’t use offensive or discriminatory language. 

Active Listening: Active listening is more than just hearing words; it’s focusing, understanding, 

and responding thoughtfully. 

Why it matters: When people feel heard, they are more likely to engage and collaborate. 

Tips for active listening in virtual calls: 

 Keep your attention on the speaker (avoid multitasking). 

 Show you’re listening nod, use “mm-hmm,” or give short verbal confirmations. 

 Wait for the person to finish speaking before replying. 

 Summarize or paraphrase what they said to confirm understanding. 

Quick Self-Check: 

Think of your last online message or meeting. Did you apply all four principles: Clarity, Tone, 

Respect, and Active Listening? Which one could you improve next time? 

Cultural & Generational Diversity  

When communicating online, remember: one style does not fit all. What feels natural and polite to 

you might feel too formal, too casual, or even confusing to someone from a different cultural or 

age group. 

Digital communication happens in a global space; you might be talking to someone in your own 

city or on the other side of the world. Understanding cultural and generational differences will help 

you avoid misunderstandings and build stronger relationships. 
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Why This Matters 

 Miscommunication can cause frustration, conflict, or even lost opportunities. 

 Awareness of differences shows respect and professionalism. 

 Adapting your style helps your message be understood and appreciated by all audiences. 

Key Differences to Consider 

I. Formal vs. Casual Language  

 Some cultures or generations prefer a formal approach, using titles, full sentences, and 

polite phrases. 

 Others may be comfortable with casual language, abbreviations, or even slang. 

Example: Formal: “Dear Mr. Alemu, I hope you are doing well. Could we schedule a meeting 

next week?” 

 Casual: “Hey Alemu, can we meet next week?” 

II. Use of Emojis 

 In some professional contexts, emojis are friendly and help convey tone. 

 In others, they may be seen as unprofessional or distracting. 

 Generational differences play a role—younger people may use emojis frequently; older 

professionals may prefer plain text. 

III. Time Sensitivity & Response Expectations 

 Some cultures and individuals value instant replies to show attentiveness. 

 Others are comfortable with delayed responses, especially if they need time to think 

before replying. 

 Generationally, younger people accustomed to instant messaging may expect quick 

interaction, while older generations may not. 

Discussion Activity 
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1. Think of a time when your message was misunderstood because of different communication 

styles. 

o What caused the misunderstanding? 

o How could you have adapted your message? 

2. If you’re unsure about someone’s communication style, what’s the safest way to start? 

(Hint: formal, neutral, and polite) 

Pro Communication Strategy 

When you communicate online with someone from a different culture or generation: 

1. Observe first:  Check how they greet, respond, and structure messages. 

2. Adapt respectfully: Match their level of formality and tone. 

3. Clarify politely: If something is unclear, ask respectfully rather than assume. 

1.2 Synchronous vs. Asynchronous Communication  

When working online, especially with teams spread across different locations, choosing the right 

communication type can make your collaboration more effective and less stressful. 

There are two main categories: Synchronous (real-time) and Asynchronous (delayed). 

Understanding the difference helps you pick the right method for each situation. 

I. Synchronous Communication  

Synchronous communication occurs in real-time, where all participants are present simultaneously 

and can respond immediately. This type of communication allows for instant feedback, active 

engagement, and dynamic interaction, making it effective for discussions, decision-making, and 

collaborative problem-solving. 

Examples of Synchronous Communication 

1. Video Calls & Meetings 

o A virtual meeting where participants can see and hear each other live, often with 

options to share screens, presentations, or documents. 
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o Usage: 

 Conduct team meetings or project updates. 

 Host workshops, webinars, or online classes. 

 Collaborate on tasks by discussing ideas and clarifying questions instantly. 

o Tools: Zoom, Google Meet, Microsoft 

Teams, Cisco Webex, BlueJeans 

2. Instant Messaging / Chat 

o Real-time text-based communication that 

allows participants to send messages and 

receive responses immediately. 

o Usage: 

 Quick updates or urgent questions 

within a team. 

 Coordinating work tasks or schedules. 

 Sharing links, files, or short instructions for immediate action. 

o Tools: Slack (direct messages), Microsoft Teams chat, WhatsApp, Telegram 

3. Live Voice Calls 

o Verbal communication conducted in real-time, either via traditional phone 

networks or internet-based voice applications. 

o Usage: 

 Discussing complex 

topics that are easier 

to explain verbally. 

 Resolving issues 

quickly without 

waiting for email or text responses. 

 Team check-ins or one-on-one mentorship conversations. 

o Tools: Phone calls, WhatsApp voice calls, Discord voice channels 

4. Webinars & Virtual Workshops 

Figure 52  Instant Messaging / Chat 

Figure 53 Live Voice Calls 
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o Live online sessions where a presenter shares information with an audience, often 

with interactive Q&A or 

polls. 

o Usage: 

 Conducting training 

sessions or 

educational 

seminars. 

 Engaging audiences 

through live questions and discussions. 

 Providing real-time demonstrations or tutorials. 

o Tools: Zoom Webinar, GoToWebinar, Microsoft Teams Live Events 

Key Point: Synchronous communication is best for activities requiring immediate interaction, 

active participation, and real-time decision-making. 

Challenges: 

 Requires all participants to be available at the same time 

 Time zone differences can make scheduling difficult 

 Can feel rushed, less time to think about your response 

How to use Zoom Call  

This practice helps you build confidence in using Zoom for online learning. You will practice 

joining a meeting, greeting the group, asking a question, and sharing your screen. 

Step 1: Join the Meeting 

o Click the Zoom link and open Zoom. 

o Enter your name as FirstName – School. 

o Allow microphone and camera. 

o Join with Computer Audio and test sound. 

Figure 54  Webinars & Virtual Workshops 
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o Mute until your turn. 

Step 2: Greet the Group 

o Unmute and smile at the camera. 

o Example: “Good morning, everyone. I’m 

[Introduce yourself]. Can you hear me 

clearly?” 

o Pause for confirmation. 

o Re-mute when finished. 

Step 3: Ask a Clear Question 

Structure your question: 

o Context (1 sentence) 

o The question (1 sentence) 

o Thank you (1 phrase) 

o Example: “For the Internet Basics module, could you confirm the due date? Thank you.” 

Step 4: Share Your Screen 

o Open your file before sharing. 

o Click Share Screen and choose the correct window. 

o Point out what others should notice. 

o Stop sharing when done. 

Troubleshooting Tips 

o No one hears me: check mic mute and select the right microphone. 

o Echo: mute extra devices or use headphones. 

o Cannot share screen: ask the host to enable screen share. 

o Low bandwidth: turn off video and use chat if needed. 

 

Figure 55 How to use a Zoom call 
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II. Asynchronous Communication 

Asynchronous communication takes place when participants are not communicating in real-time. 

There is a delay between when a message is sent and when it is read or responded to. This type of 

communication allows individuals to participate at their own convenience, making it ideal for 

teams working across different time zones or with flexible schedules. 

It supports thoughtful reflection, well-structured responses, and inclusive participation especially 

in online learning environments. 

 

 

 

 

 

 

Examples of Asynchronous Communication 

1. Email 

o A digital messaging system used to send written messages, files, and attachments 

to individuals or groups. 

o Usage: 

 Sharing updates, 

instructions, or formal 

announcements. 

 Sending assignments, 

reports, or documents. 

 Communicating with 

team members who are unavailable at the same time. 

o Tools: Gmail, Outlook, Yahoo Mail 

2. Discussion Boards & Forums 

Figure 57 Email Tools 

Figure 56 Asynchronous communication 
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o Online platforms where participants can post messages, respond to others, and 

engage in threaded discussions over time. 

o Usage: 

 Facilitating class discussions that allow reflection before responding. 

 Sharing opinions, feedback, or resources on specific topics. 

 Encouraging participation from all learners, even those who prefer to think 

before speaking. 

o Tools: Moodle forums, Google Classroom discussions, Edmodo, Reddit, 

Microsoft Teams channels 

3. Recorded Video or Audio Messages 

o Pre-recorded videos or voice messages shared for others to view or listen to later. 

o Usage: 

 Providing feedback or explanations that require tone and expression. 

 Sharing lectures or presentations for learners to access at any time. 

 Allowing learners to respond through their own recorded reflections. 

o Tools: Loom, Flip (formerly Flipgrid), YouTube (unlisted videos), VoiceThread, 

WhatsApp voice notes 

4. Shared Documents with Comments 

o Collaborative documents that allow users to leave comments, suggestions, or edits 

asynchronously. 

o Usage: 

 Reviewing and providing feedback on written work. 

 Co-authoring documents without needing to be online simultaneously. 

 Tracking version history and maintaining a record of all contributions. 

o Tools: Google Docs, Microsoft Word Online, Dropbox Paper 

5. Learning Management System (LMS) Activities 

o Platforms that host assignments, quizzes, announcements, and content that 

learners can access and complete on their own time. 

o Usage: 

 Uploading course materials and assignments for flexible access. 

 Allowing learners to engage in peer review or reflection activities. 
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 Tracking learner progress without the need for live sessions. 

o Tools: Canvas, Moodle, Google Classroom, Schoology 

Key Point: Asynchronous communication is best for situations where participants need flexibility, 

time to reflect, or the ability to contribute across different schedules. It encourages thoughtful 

responses and supports inclusive participation in online environments. 

Challenges: 

 Slower decision-making 

 Urgent messages may be missed if not checked promptly 

 Requires self-discipline to check and respond regularly 

Step-by-Step Guide 

Mailing Lists (e.g., Gmail Group, Outlook Distribution List) 

1. Access your email platform (e.g., Gmail, Outlook). 

2. Create a group contact list: 

o In Gmail: Go to Google Contacts → Create Label → Add contacts. 

o In Outlook: Go to People → New Contact Group → Add members. 

3. Name the mailing list clearly (e.g., Project Team 2025). 

4. Add members by entering their email addresses. 

5. Save and test the mailing list by sending a short message. 

6. Use for announcements or updates when you want all members to receive the same email. 

Choosing the Right Method 

Situation Best Choice Why 

Urgent problem with a client Synchronous Immediate action is needed 

Brainstorming new ideas Synchronous Live discussion encourages 

creativity 
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Gathering detailed feedback on a 

proposal 

Asynchronous Gives people time to review and 

think 

Communicating across time zones Asynchronous Flexible for everyone’s schedule 

Table 3: synchronous vs asynchronous 

 

1.3 Virtual Meeting Tools and Etiquette 

Virtual Meeting Tools 

In today’s connected world, virtual meetings are an 

essential platform for work, study, and collaboration. 

There are many platforms available, each with unique 

features suited to different needs. Here are three of the 

most popular tools: 

1. Zoom 

 Best for: Webinars, online classes, and large meetings. 

 Features: 

o Breakout rooms for small group discussions. 

o Screen sharing for presentations and demonstrations. 

o Recording options to review sessions later. 

 Why it’s popular: 

o Works on multiple devices (computers, tablets, smartphones). 

o Easy to join meetings with a link—no account required for participants. 

2. Microsoft Teams 

 Best for: Team collaboration and ongoing projects. 

 Features: 

o Integrated chat, file sharing, and task 

management. 

o Can schedule and host both small and large 

meetings. 

Figure 58 webinars using zoom meeting 
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o Integration with Microsoft 365 tools (Word, Excel, PowerPoint). 

 Why it’s useful: 

o Centralized workspace for communication, 

documents, and meetings. 

o Ideal for long-term collaboration in organizations and schools. 

3. Google Meet 

 Best for: Quick, simple meetings, especially for those 

with Gmail accounts. 

 Features: 

o Easy link-based joining with no software 

download needed. 

o Live captions for accessibility. 

o Integration with Google Calendar for scheduling. 

 Why people like it: 

o Seamless connection with Google tools like Drive and Docs. 

o Simple interface that’s beginner-friendly. 

Virtual Meeting Etiquette 

Just like face-to-face meetings, virtual meetings require professional behavior. Following proper 

etiquette makes communication smooth and respectful. 

Before the Meeting 

 Test your device settings:  Check the camera, microphone, and internet connection. 

 Prepare: Read the agenda and write down your talking points. 

 Environment: Choose a quiet, well-lit space with minimal distractions. 

During the Meeting 

 Mute when not speaking: This prevents background noise from disrupting the 

conversation. 

Figure 59 Microsoft Teams interface 

Figure 60 Google Meet video call 
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 Use the chat respectfully: Ask questions or share links politely without interrupting the 

speaker. 

 Keep your camera on (if possible): Seeing faces builds trust and connection. 

 Be present: Avoid multitasking: stay focused on the discussion. 

After the Meeting 

 Follow up: Send notes, summaries, or confirmation of your assigned tasks. 

 Thank the participants: A short message of appreciation can strengthen professional 

relationships. 

Exercise  

Objective: Practice hosting and participating in a professional virtual meeting. 

Instructions: 

1. Break into small groups in breakout rooms. 

2. Assign roles: 

o Host – Leads the meeting and keeps it on track. 

o Participant – Contributes ideas and responds to questions. 

o Note-taker – Records key points and action items. 

3. Run a 5-minute virtual meeting on a chosen topic. 

4. After the meeting, discuss: 

o What went well? 

o What could improve for next time? 

Practical Exercise 

1. You are writing an email to your instructor asking for an extension on your project 

deadline. 

 Rewrite the message below to demonstrate clarity, respectful tone, and 

professional structure: 

“Hey! I’m too busy right now. Can I get more time for the project?” 
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 What changes did you make to improve clarity and tone? 

2. You are collaborating with two teammates—one older teacher from another country and 

one younger student from your region. The older teammate prefers formal 

communication; the younger prefers chat messages with emojis. 

 How will you adjust your tone and style to communicate effectively with both? 

 Write a sample greeting or message that balances both styles. 

3. During a virtual meeting, one participant keeps interrupting others and another is silent 

throughout. 

 As the meeting host, how would you handle this situation respectfully? 

 Mention at least two strategies for maintaining engagement and respect in virtual 

spaces. 

Summary  

Effective online communication is essential for working in today’s digital and global environment. 

It requires clarity, a respectful tone, and active listening, especially since many non-verbal cues 

are absent in text-based interactions. Cultural and generational awareness helps prevent 

misunderstandings and builds stronger relationships by adapting language, tone, and response 

expectations. 

Choosing between synchronous (real-time) and asynchronous (delayed) communication ensures 

that messages are delivered and responded to in the most efficient way for the situation. Virtual 

meetings, whether on Zoom, Microsoft Teams, or Google Meet, require preparation, professional 

etiquette, and appropriate follow-up to be productive and respectful. Mastering these skills enables 

you to collaborate confidently across cultures, generations, and time zones. 

Review Questions  

 Multiple choice  

1. You need urgent clarification from your teammate about a client issue. Which communication 

method is BEST? 

A. Email 
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B. Recorded video message 

C. Video call 

D. Shared Google Doc with comments 

2. In a virtual meeting, someone from another culture sends a very short reply that seems blunt 

to you. What should you do first? 

A. Assume they are being rude 

B. Ask politely for clarification 

C. Ignore their message completely 

D. Respond with an equally short message 

3. Which of these is NOT a tip for maintaining clarity in online communication? 

A. Use bullet points for multiple ideas 

B. Avoid jargon unless everyone understands it 

C. Hide your key point in the middle of a long paragraph 

D. Start with the most important information 

4. You are working with a team spread across three time zones. The task requires thoughtful 

review of a proposal. Which tool is MOST suitable? 

A. Instant messaging chat 

B. Email with attached document 

C. Live brainstorming call 

D. Phone call 

5. During a Zoom meeting, what is the BEST way to show active listening? 

A. Keep your camera off and type messages in chat 

B. Nod occasionally and give short verbal confirmations 

C. Multitask while the other person is speaking 

D. Interrupt with your opinion immediately 
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Session 2: Collaborating through Digital Technologies 

Introduction:  

Dear learners, welcome to this session. In this session, you will explore Collaborating through 

Digital Technologies  

Collaborating through digital technologies involves using tools like project management software, 

communication platforms, and shared document editors to enable teams to work together 

regardless of their physical location, fostering increased efficiency, better communication, and 

more organized workflows.  

Let’s start with a quick scenario: You and your classmates have a group project due in two weeks. 

The challenge? Everyone lives in different towns across Ethiopia: Addis Ababa, Bahir Dar, Dire 

Dawa, and Hawassa. Meeting in person is impossible. 

Think about this: 

 How will you share your ideas? 

 How will you split the work? 

 How will you make sure everything comes together on time? 

Digital collaboration answers all this. By the end of this session, you’ll know how to work 

effectively as a team online—whether it’s with a small local group, a large organization, or even 

partners across the globe. 

Learning Objective  

By the end of this session, learners will be able to: 

 Explain the concept, types, and benefits of digital collaboration. 

 Use online communication, file-sharing, and task-management tools to plan and manage 

group work. 
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 Evaluate common challenges in virtual teamwork and create practical solutions through a 

collaborative project. 

Content outline 

2.1 Concepts of Digital Collaboration and its benefits 

2.2 Digital Collaboration Tools 

2.3 Common challenges in virtual teamwork 

2.1  Concepts of Digital Collaboration and Its Benefits 

What is Digital Collaboration?  

Digital collaboration refers to the process of working together with others using online tools 

and digital platforms to achieve a shared goal. It allows people to plan, create, share, and 

communicate without needing to be in the same physical space. In a world where teams are often 

spread across different cities or even countries, digital collaboration helps ensure that work 

continues smoothly, regardless of distance or time zone. 

Types of Digital Collaboration 

There are two main types of digital collaboration based on how and when team members interact: 

1. Real-Time (Synchronous) Collaboration 

o In this form, all participants work together at the same time, often through live 

communication tools. 

o Examples include video meetings on Zoom or Microsoft Teams, instant 

messaging on Slack, or co-editing a Google Document while discussing ideas in 

real-time. 

o This approach allows for immediate feedback, quick decision-making, and 

active discussion, similar to an in-person meeting. 

2. Asynchronous Collaboration 

o Here, team members work and contribute at different times, which provides 

flexibility for people in different time zones or with varying schedules. 
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o Examples include adding comments to a shared Google Doc, posting updates 

on Trello or Asana, or sharing recorded video messages. 

o This method is useful when real-time interaction is not necessary, helping everyone 

participate at their own pace. 

Both forms of collaboration are valuable the best approach often depends on the team’s goals, the 

task at hand, and participants’ availability. 

Benefits of Digital Collaboration 

When done effectively, digital collaboration offers numerous advantages that go beyond simple 

online communication. It helps teams become more efficient, innovative, and inclusive, while 

overcoming traditional barriers of time and space. 

1. Work with People Anywhere, Anytime 

 Digital collaboration allows teams to connect regardless of geographical location. 

 Team members can contribute from different cities, regions, or even countries, as long 

as they have an internet connection and a digital device. 

 Example: Teachers in Addis Ababa can collaborate with educators in Hawassa or Bahir 

Dar to design lesson plans using Google Docs, without having to meet physically. 

 This global connectivity encourages knowledge sharing and diverse perspectives, 

enriching the final outcome. 

2. Save Time and Reduce Costs 

 Traditional collaboration often requires travel for meetings, training, or workshops, 

which can be expensive and time-consuming. 

 Online collaboration eliminates much of this need; meetings can be held virtually, 

documents can be shared instantly, and feedback can be exchanged in minutes. 

 As a result, teams make faster decisions and spend less money on transportation or 

logistics. 
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 Instead of spending hours traveling, members can use that time to focus directly on 

project tasks. 

3. Keep Work and Communication Organized in One Place 

 Digital collaboration tools like Google Workspace, Microsoft Teams, or Trello allow 

users to store files, chat histories, meeting notes, and project updates in one central 

location. 

 This organization prevents confusion caused by searching through multiple emails, phone 

messages, or USB drives. 

 Everyone can view the latest version of a document, track who made changes, and access 

shared materials anytime. 

 Such transparency promotes accountability and smooth teamwork. 

4. Combine Different Skills and Perspectives for Better Results 

 Teams are often made up of individuals with diverse backgrounds and expertise such as 

writing, design, teaching, or technical problem-solving. 

 Digital collaboration enables these varied skills to come together effectively, regardless of 

where each person is located. 

 By blending different viewpoints and experiences, teams can create more innovative, 

creative, and comprehensive outcomes. 

 This inclusivity also builds a stronger sense of community and shared ownership of the 

work. 

2.2 Digital Collaboration Tools  

Digital collaboration is only as effective as the tools you use. The right tools help teams 

communicate clearly, share resources efficiently, and stay on track with deadlines no matter where 

members are located. 

Below is your digital toolkit, organized into three categories: communication, file sharing, and 

task management, plus the steps to use them effectively. 
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 For Communication 

a) WhatsApp / Telegram: Fast Messaging & Group Chats 

 Purpose: Share quick updates, create group discussions, send images, and share files 

instantly. 

 Steps to Use: 

1. Create a dedicated group chat for your project or team. 

2. Set clear rules for communication (e.g., working hours, avoid spamming). 

3. Use voice notes for complex messages when typing is inconvenient. 

4. Pin important messages so everyone can find key information quickly. 

b) Zoom / Microsoft Teams / Google Meet – Video Meetings & Screen Sharing 

 Purpose: Host real-time discussions, share screens for presentations, and record meetings 

for later review. 

 Steps to Use: 

1. Schedule the meeting using a shared Google Calendar invite. 

2. Share the link in your team’s main chat group. 

3. Test your microphone and camera before joining. 

4. Use the screen share option to walk the team through documents or slides. 

5. Record the meeting if some members can’t attend. 

For File Sharing  

a) Google Drive / OneDrive / Dropbox – Store, Share, and Co-edit Documents 

Purpose: Keep all files in one place so everyone can view, edit, and comment in real-time.Step-by-Step 

Guide (Google Drive) 

Step 1: Open Google Drive 

1. Open your internet browser (Chrome, Edge, or Firefox). 

2. In the address bar, type drive.google.com and press Enter. 
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3. Log in with your Google account (Gmail) if asked. 

4. You will see your Google Drive homepage where all your files and folders are stored. 

Step 2: Create a New Project Folder 

1. On the left side, click the New button. 

2. Select Folder from the menu. 

3. Type a clear name for the folder, for example: 

o Magazine Project 

o Class Assignment Folder 

4. Click Create. 

5. The new folder will now appear in your Drive. 

Step 3: Upload Files to the Folder 

1. Double-click to open your new folder. 

2. Inside the folder, click New → File Upload (or Folder Upload to add many files at once). 

3. Select the file(s) from your computer — for example: 

o Images (photos, graphics) 

o Draft documents (Word, Google Docs) 

o PDFs or presentations 

4. Wait for the upload to finish. You’ll see the file appear in the folder. 

Step 4: Share the Folder with Teammates 

1. Right-click the folder name. 

2. Select Share. 

3. A box will open where you can type your teammates’ email addresses. 

4. Next to each email, choose their permission level: 

o Viewer → Can only look at files. 

o Commenter → Can leave comments but cannot change files. 

o Editor → Can add, remove, or edit files. 

5. Click Send → your teammates will get an email with access to the folder. 
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Step 5: Work Together in the Shared Folder 

 Everyone with access can now: 

o Upload new files. 

o Edit documents (if they are shared as Google Docs, Sheets, or Slides). 

o Organize content by making subfolders (e.g., Drafts, Final Versions, Images). 

 Any changes made are saved automatically and visible to all team members. 

Step-by-Step Guide (Google Docs) 

Step 1: Open Google Docs 

1. Open your internet browser (e.g., Chrome, Edge, Firefox). 

2. In the search bar, type docs.google.com and press Enter. 

3. If you are not signed in, log in with your Google (Gmail) account. 

Step 2: Create a New Document 

1. On the Google Docs homepage, you will see a plus sign Blank Document (+). 

2. Click Blank to start a new empty page. 

o If you want to use a ready-made format (like a resume, report, or letter), click on 

one of the Templates. 

Step 3: Start Writing 

1. Place your cursor on the white page. 

2. Start typing your text for example: 

o Write an article (about a topic you like). 

o Write a story. 

o Write a school or work report. 

3. Your work is saved automatically in Google Docs you don’t need to click Save. 

Step 4: Share the Document with Others 
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1. In the top-right corner, click the blue Share button. 

2. A box will appear where you can type the email addresses of the people you want to share 

the document with. 

3. Next to each email, you will see a drop-down menu with roles. 

Step 5: Choose Roles (Permissions) 

 Viewer → Can only look at the document but cannot make changes. 

 Commenter → Can add suggestions and comments but cannot edit the text directly. 

 Editor → Can make full changes to the document. 

(Tip: If you are working in a group project, make your teammates “Editors” so they can write 

with you.) 

Step 6: Use Comments to Give Suggestions 

1. Highlight (select) the text you want to comment on. 

2. Click Insert → Comment (or right-click and choose Comment). 

3. Type your suggestion in the box and press Comment. 

4. Your teammate will see the comment and can reply or fix it. 

Step 7: Collaborate in Real Time 

 When multiple people open the document, you can see their names or initials at the top. 

 Each person’s text appears in real time changes show up instantly. 

 You can chat or reply to comments inside the document for teamwork. 

For Task Management  

a) Google Calendar - Schedule Deadlines & Meetings 

 Purpose: Keep track of project timelines, events, and meetings in one shared calendar. 

Step-by-Step Guide (Google Calendar) 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [93]                                 October, 2025 

Step 1: Open Google Calendar 

1. Open your internet browser (Chrome, Edge, or Firefox). 

2. In the address bar, type calendar.google.com and press Enter. 

3. Log in with your Google account (Gmail) if needed. 

4. You will now see your calendar view (by day, week, or month). 

Step 2: Create a Shared Project Calendar 

1. On the left-hand menu, find Other Calendars. 

2. Click the + (plus sign) next to it. 

3. Select Create new calendar. 

4. Give the calendar a name (e.g., Project Team Calendar). 

5. Add a description (optional, e.g., For tracking deadlines and meetings). 

6. Click Create Calendar. 

7. To share with your team: 

o Go to Settings & Sharing → enter teammates’ email addresses. 

o Choose permissions: View only or Make changes. 

 

Figure 61 Working with Google Calendar 

Step 3: Add Deadlines and Meetings 
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1. Click on a date in the calendar where you want to add an event. 

2. A box will pop up → type the event name (e.g., Submit Draft Report). 

3. Choose Event type: 

o Deadline → Set the due date and time. 

o Meeting → Add meeting link (Google Meet/Zoom). 

4. Invite teammates: Add their emails in the “Guests” section. 

5. Click Save → your event will appear in the calendar. 

Step 4: Set Reminders for Events 

1. When creating or editing an event, look for Notifications. 

2. Add reminders such as: 

o 1 day before (so people prepare in advance). 

o 1 hour before (so no one forgets). 

3. You can add multiple reminders for the same event. 

Step 5: Color-Code Events 

1. Click on an event in the calendar. 

2. Select the event color from the color menu. 

3. Use a simple color system, for example: 

o Red → Deadlines 

o Blue → Meetings 

o Green → Presentations or milestones 

4. This makes the calendar easy to read at a glance. 

b) Microsoft Teams   

Microsoft Teams is a digital collaboration platform that brings together chat, meetings, file 

sharing, and teamwork tools in one place. It helps organize people, conversations, and resources 

around shared goals or projects. 

1. Creating a Team  
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A Team is a digital workspace for a group of people who collaborate on a common task or topic. 

Steps: 

1. Open Microsoft Teams (desktop app or web version). 

2. On the left navigation panel, click on the Teams icon  

3. At the bottom of the Teams list, click “Join or create a team.” 

4. Choose “Create a team.” 

5. Select one of the following options: 

o From scratch – Build a new team from the beginning. 

o From a group or team – Reuse an existing Microsoft 365 group (if available). 

6. Choose the privacy level: 

o Private – Only invited 

members can join. 

o Public – Anyone in your 

organization can join. 

7. Enter a Team name and 

Description (optional). 

8. Click Create to finalize your 

new team. 

Tip: Create teams based on courses, 

departments, or projects (e.g., “ICT 

Teachers Group” or “Digital Skills 

Project Team”). 

2. Adding Members, Guests, and Channels to a Team 

A. Add Members and Guests 

Once your team is created, you can invite people to join. 

Steps: 

Figure 62  Creating a Team 
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1. Open the Teams tab and select your new team. 

2. Click the three dots (⋯) next to the team name. 

3. Choose “Add member.” 

4. Type the name, email address, or contact of the person you want to add. 

5. Select Add to include them. 

o Members – People 

within your 

organization. 

o Guests – External 

users (for example, a 

partner or student 

from another school). 

6. Click Close when finished. 

Tip: Guests will receive an email 

invitation to join the team. They can 

access shared resources but with 

limited permissions. 

B. Add Channels 

Channels help organize discussions and files by topic or function within a team. 

Steps: 

1. Click the three dots (⋯) next to your team name. 

2. Select “Add channel.” 

3. Enter a Channel name (e.g., “Lesson Planning” or “Student Support”). 

4. Add a description (optional). 

5. Choose the Privacy setting: 

o Standard – Everyone on the team can access it. 

Figure 64 Add Members and Guests 

Figure 63 Add Members and Guests 
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o Private – Only 

specific members can 

access it. 

6. Click Add to create the 

channel. 

Tip: Use channels to separate work 

areas — for example, “Assignments,” 

“Meetings,” and “Resources.” 

 

3. Removing Members, Guests, and 

Channels from a Team 

A. Remove Members or Guests 

Sometimes you may need to remove 

someone from the team. 

Steps: 

1. Go to your Team and click 

the three dots (⋯) next to its 

name. 

2. Select “Manage team.” 

3. Under the Members tab, 

you will see a list of all team 

participants. 

4. Click the X (Remove) next 

to the person’s name. 

5. Confirm removal if prompted. 

Note: Only the team owner (creator or assigned leader) can add or remove members. 

Figure 66 Remove Members or Guests 

Figure 65 Add Channels 
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B. Remove a Channel 

If a channel is no longer needed, it can be 

deleted. 

Steps: 

1. Find the channel name under 

your team. 

2. Click the three dots (⋯) beside it. 

3. Choose “Delete this channel.” 

4. Confirm by clicking Delete. 

Tip: Deleting a channel removes all posts 

and files in it, so make sure to back up 

important materials first. 

4. Viewing Team Information and Analytics 

Team analytics help you understand how active your team is who’s participating, how many 

messages are sent, and how files are used. 

Steps: 

1. Click the three dots (⋯) next to your team name. 

2. Select “Manage team.” 

3. Go to the Analytics tab (or Insights if available). 

4. Review details such as: 

o Number of active members 

o Posts, replies, and reactions 

o File sharing activity 

o Channel usage trends 

Figure 67 Remove a Channel 
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Tip: Use this data to monitor engagement and identify areas where participation can be improved. 

C) Trello and Asana - Project 

management tools 

Project management tools like 

Trello and Asana help teams stay 

organized, on track, and clear about 

responsibilities. They work like 

digital “to-do lists” where you can 

assign tasks, set deadlines, and 

track progress all in one place. 

Step-by-Step Guide (Trello 

Example) 

Step 1: Open Trello 

1. Open your internet browser (Chrome, Edge, or Firefox). 

2. In the search bar, type trello.com and press Enter. 

3. Click Log in (if you already have an account) or Sign up (to create a free account). 

4. After logging in, you will see your Trello workspace. 

Step 2: Create a New Board 

1. On the homepage, click Create new board. 

2. A box will appear asking for details: 

o Board Name → Type a name for your project (e.g., Online Magazine Project). 

o Background → Choose a color or image to make it easy to recognize. 

o Visibility → Decide if the board is private (only you), workspace (team only), or 

public. 

Figure 68 Viewing Team Information and Analytics 
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3. Click Create 

Board. 

Step 3: Add Lists to 

Organize Work 

1. On your 

board, you 

will see an 

option to Add 

a list. 

2. Type the first list name, for example: 

o To Do → Tasks not started yet. 

o In Progress → Tasks currently being worked on. 

o Done → Finished tasks. 

3. Press Enter after each list. 

4. Now you have a workflow to track your project. 

Step 4: Create Cards (Tasks) 

1. Under the To Do list, click + Add a card. 

2. Type the name of the task, for example: 

o “Write Article” 

o “Design Cover” 

o “Publish Final Version” 

3. Click Add Card. 

4. Each card represents one task in the project. 

Step 5: Assign Tasks to Teammates 

1. Click on a card (e.g., “Write Article”). 

2. A pop-up window will open. 

3. On the right side, click Members. 

Figure 69 Working with Trello 
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4. Type the teammate’s name or email to assign them. 

5. Their profile will now show on the card, meaning they are responsible for that task. 

Step 6: Track Progress by Moving Cards 

1. As work begins, drag the card from To Do → In Progress. 

2. When the task is completed, drag the card from In Progress → Done. 

3. This visual movement helps the whole team see what’s finished and what still needs work. 

Step 7: Use Extra Features for Better Organization (Optional) 

 Due Dates: Set deadlines for tasks. 

 Labels: Add colors (e.g., red for urgent, green for completed). 

 Checklists: Break down big tasks into smaller steps. 

 Attachments: Upload files, images, or links related to the task. 

Best Practices for Successful Collaboration  

Working together online can be smooth and productive but only if your team follows certain habits 

from the start. 

These best practices help avoid confusion, delays, and misunderstandings, ensuring that your 

project moves forward efficiently. 

Set Clear Goals from the Start 

 Why: If the team doesn’t agree on what they’re working toward, people may waste time 

on tasks that don’t matter. 

 How: 

1. Define the project’s purpose and expected outcome. 

2. Write these goals in a shared document so everyone can refer back to them. 

3. Break big goals into smaller milestones. 

 Example: Instead of “Improve community awareness,” set “Create and share a health 

awareness poster online within 3 weeks.” 
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Assign Roles and Responsibilities 

 Why: Avoids confusion and ensures every task is covered. 

 How: 

1. Assign tasks based on each member’s strengths. 

2. Clearly list who is responsible for what in the shared task list. 

3. Check in regularly to ensure roles are clear and still suitable. 

 Example: In a school project, one person could handle research, another writes content, 

and another designs the slides. 

Use a Shared Calendar or Task List 

 Why: Keeps the whole team on track and aware of deadlines. 

 How: 

1. Use Google Calendar, Trello, or Asana to list all deadlines and meetings. 

2. Set reminders so no one misses important dates. 

3. Update tasks as they are completed. 

Communicate Regularly and Respectfully  

 Why: Frequent, polite communication prevents misunderstandings and builds trust. 

 How: 

1. Agree on a main communication channel (e.g., WhatsApp group). 

2. Send short, clear updates instead of long, confusing messages. 

3. Respect working hours, avoid sending late-night messages unless urgent. 

Keep All Files in One Shared Folder 

 Why: Saves time searching for documents and ensures everyone works on the latest 

version. 

 How: 

1. Use Google Drive, OneDrive, or Dropbox. 

2. Name files clearly and organize them in folders. 
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3. Remove outdated versions to avoid confusion. 

Give Constructive, Polite Feedback  

 Why: Feedback improves quality and helps teammates grow, but harsh words can 

discourage people. 

 How: 

1. Be specific: say what’s good and what can be improved. 

2. Use “I” statements (e.g., “I think this section could be clearer” instead of “You wrote this 

wrong”). 

3. Suggest solutions, not just problems. 

2.3 Common Challenges in Digital Collaboration & How to Solve Them  
 

Digital collaboration offers flexibility, creativity, and teamwork across distance but it also brings 

unique challenges that can affect communication, productivity, and team relationships. In this 

lesson, you will explore the most common challenges teams face when working online and learn 

strategies and digital tools to overcome them. 

No. Challenge Description Examples Solutions / Strategies 

1 Miscommunication 

& Lack of Clarity 

Messages 

misunderstood due to 

missing tone or 

context. 

“We need this 

report soon” 

→ unclear 

deadline. 

- Use clear, specific 

language.- Confirm 

understanding.- Use 

shared docs and video 

messages for clarity. 

2 Unequal 

Participation 

Some dominate while 

others stay silent. 

Few speak in 

meetings; 

others remain 

off-camera. 

- Use structured turns, 

polls, breakout rooms.- 

Rotate roles.- Create 

inclusive space. 

3 Time Zone & 

Scheduling 

Conflicts 

Difficult to find 

common meeting 

times. 

Members in 

different 

countries miss 

meetings. 

- Blend live & async 

communication.- Use 

scheduling tools.- 

Record sessions.- Share 

meeting notes. 

4 Technology Issues Poor connectivity or 

tool failures interrupt 

collaboration. 

Mic/camera 

doesn’t work 

in a meeting. 

- Offer tech 

orientation.- Provide 

backup tools.- Share 

offline resources.- 
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Teach troubleshooting 

basics. 

5 Lack of 

Accountability 

Tasks delayed due to 

unclear follow-up. 

Shared file left 

unupdated 

after meeting. 

- Use task trackers 

(Trello, Asana).- Send 

recap emails.- Set 

check-ins.- Foster 

responsibility culture. 

6 Cultural & 

Language Barriers 

Misunderstandings 

due to diverse 

backgrounds. 

Local slang or 

idioms 

confuse 

others. 

- Use simple, inclusive 

language.- Discuss 

communication norms.- 

Be patient & 

respectful.- Use visuals. 

7 Information 

Overload 

Too many 

messages/tools cause 

confusion. 

Updates 

shared on 

email, Teams, 

and 

WhatsApp. 

- Choose one main 

platform.- Organize 

chats by topic.- Limit 

notifications.- 

Summarize discussions. 

8 Building Trust & 

Team Connection 

Hard to build rapport 

online. 

Team feels 

distant; low 

motivation. 

- Use icebreakers.- 

Celebrate wins.- 

Encourage video 

sessions.- Keep 

commitments. 
Table 4 : Common Challenges in Digital Collaboration & How to Solve Them 

Hands On Exercise: Digital Team Collaboration Project 

Exercise Title: Plan and Manage a Group Project Using Online Collaboration Tools 

Instructions: 

1. Form a small group of 3-5 members. 

2. Choose a simple group project, such as preparing a short presentation or designing an 

awareness poster (e.g., “Promoting Safe Internet Use”). 

3. Set up your digital workspace using the following tools: 

 Communication: Create a group on WhatsApp or Telegram for team discussions and 

updates. 

 File Sharing: Create a shared Google Drive folder to store all project files and allow team 

members to edit documents together. 

 Task Management: Create a Trello board (or Google Calendar) to assign tasks, set 

deadlines, and track progress. 
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4. Collaborate and complete your tasks online. Each member should contribute by: 

 Sharing ideas and updates in the chat group. 

 Uploading or editing project documents in Google Drive. 

 Updating progress on the Trello board or calendar. 

5. Present your outcome (e.g., a shared Google Slides presentation or digital poster) to the class 

or instructor. 

6. Reflect briefly (3 - 5 sentences): What digital tools helped your group the most, and what 

challenges did you face while collaborating online? 

Summary 

In this session, we explored how to make online teamwork effective and productive. Successful 

digital collaboration requires clear goals, well-defined roles, and the use of shared tools like 

calendars, task lists, and file storage platforms. Good communication, regular, respectful, and 

organized, is key to avoiding misunderstandings. Keeping all work in one shared location ensures 

everyone is on the same page, while polite, constructive feedback helps improve the final outcome. 

We also discussed common challenges like poor internet, unclear messages, and uneven 

participation, along with practical solutions such as using lightweight tools, clear communication 

methods, and fair task distribution. By applying these best practices, teams can work together 

smoothly no matter where members are located. 

Review Question  

1. Which of the following is a best practice for successful online collaboration? 

A. Waiting until the last day to share your part of the work 

B. Using a shared document where everyone can edit 

C. Avoiding communication to prevent conflicts 

2. Why is assigning roles and responsibilities important in a team project? 

A. It helps avoid confusion and ensures every task is covered 

B. It allows some members to skip tasks 

C. It reduces the need for communication 

3. Which tool is best for organizing deadlines and meetings? 
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A. WhatsApp 

B. Google Calendar 

C. Dropbox 

4. How can teams handle different internet speeds effectively? 

A. Only work with people who have fast internet 

B. Use lightweight apps and enable offline editing 

C. Delay meetings until everyone gets better internet 

5. Giving constructive feedback means: 

A. Pointing out mistakes without offering solutions 

B. Being specific, polite, and suggesting improvements 

C. Ignoring problems to avoid hurting feelings 
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Session 3: Engaging in Citizenship through Digital Technologies  

Introduction 

Dear learners, welcome to this session. In this session, you will explore Engaging in Citizenship 

through Digital Technologies  

Think for a moment about an issue in your community you wish you could change perhaps your 

school needs new classrooms, your neighborhood struggles with waste management, or your local 

park could use more trees. Now, imagine being able to share your idea with hundreds or even 

thousands of people within minutes, all without leaving your home. That is the power of digital 

tools, giving you a voice to raise awareness, connect with others, and inspire action. 

In this session, you’ll learn how to: 

 Use online platforms to raise awareness for causes you care about. 

 Gather support and work with others even across long distances. 

 Make your voice heard while staying respectful, safe, and effective. 

By the end of this lesson, you’ll be ready to act as a responsible digital citizen, someone who uses 

technology not just to connect, but to create real change. 

Learning Objectives 

By the end of this lesson, you will be able to: 

 Explain what digital citizenship is and why it matters in community engagement. 

 Identify safe, respectful, and effective ways to participate in online civic activities. 

 Apply digital tools to promote awareness and mobilize people for local causes. 

Content outline 

3.1 Basic concepts of digital citizenship 

3.2 Ways to Engage in Digital Citizenship  
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3.3 Responsible and Safe Participation 

3.4 Digital platforms promoting Digital Citizenship 

3.1 Basic Concepts of Digital Citizenship  

Digital citizenship today goes beyond the early focus on online safety, such as protecting 

passwords or avoiding harmful content. In the 21st century, it has evolved into a broader concept 

that emphasizes responsible, respectful, and effective participation in digital society. 

A digital citizen is someone who: 

 Thinks critically about information and online content. 

 Stays informed about local, national, and global issues. 

 Engages responsibly in civic, cultural, and professional spaces. 

 Promotes positive values online while discouraging harmful behavior such as 

cyberbullying or misinformation. 

 Protects themselves and others, contributing to a safe and ethical digital environment. 

 Uses technology for innovation, advocacy, and entrepreneurship, helping solve 

community and societal challenges. 

In short, digital citizenship is about being an active, ethical, and informed participant in today’s 

interconnected digital world. Here are the Key Dimensions of Advanced Digital Citizenship as 

(from Ribble’s 9 Elements) 

1. Digital Access:  Ensuring that everyone has equal opportunity to use technology, the internet, 

and digital tools for learning, communication, and daily life. 

Example: Schools offering computer labs or Wi-Fi for all.  

2. Digital Communication: The exchange of information using digital platforms such as email, 

social media, messaging apps, and video conferencing. 

Example: Using the school email to send homework questions. 
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3. Digital Literacy:  The ability to find, evaluate, use, and create digital content responsibly. It 

involves understanding how technology works and analysing information critically. 

Example: Checking if an online article is from a reliable source. 

4. Digital Security (Self-Protection): Practices that protect personal information, devices, and 

online accounts from unauthorized access or cyber threats. 

Example: Using strong passwords and two-step verification. 

5. Digital Etiquette: Following socially acceptable standards and responsible behavior online. 

This includes being polite, professional, and respectful. 

Example: Avoiding rude comments in online discussions. 

6. Digital Rights & Responsibilities: Recognizing that everyone has rights online—such as 

privacy, access to information, and freedom of expression—while fulfilling responsibilities like 

ethical behavior and reporting misuse. 

Example: Reporting cyberbullying instead of ignoring it. 

7. Digital Law: Legal frameworks governing digital activity, including copyright, intellectual 

property, data protection, and cybercrime regulations. 

Example: Respecting Creative Commons when using images in assignments. 

8. Digital Health & Wellness: Maintaining physical and psychological well-being while using 

digital technology. Includes screen-time management, ergonomics, and mental health awareness. 

Example: Taking screen breaks to avoid eye strain. 

9. Digital Commerce: Buying, selling, or conducting financial transactions safely online. Includes 

understanding risks and practicing ethical behaviour in e-commerce. 

Example: Using secure payment methods when shopping online. 
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3.2 Ways to Engage in Digital Citizenship  

Digital citizenship is not just about knowing your rights and responsibilities online; it’s about 

taking action to make a positive impact in your community, your country, and even globally. 

Here are practical ways to participate in civic engagement using digital tools: 

A. Social Media Advocacy  

Social media platforms like Facebook, Instagram, TikTok, and Twitter (X) are powerful tools for 

raising awareness.  

 You can share posts, images, or videos about causes you support, such as environmental 

conservation, education, or women’s rights. 

 Use hashtags to reach wider audiences (#CleanAddis, #SaveLakeTana, 

#EthiopiaForEducation). 

 Tag community leaders, organizations, or influencers to help spread your message. 

B. Online Petitions 

Platforms like Change.org and Avaaz allow you to gather digital signatures for a cause. 

 Create a petition explaining the problem, why it matters, and the change you’re requesting. 

 Share the petition link through WhatsApp groups, Telegram channels, and social media to 

collect support. 

 Present the results to local authorities, schools, or NGOs. 

C. Community Groups 

Joining Skool, Circle, Might Networks, WhatsApp, Telegram, or Facebook groups is a great way 

to stay informed and coordinate activities. 

 Participate in discussions, share useful information, and volunteer for tasks. 

 Organize clean-up drives, charity events, or awareness campaigns. 

 Respect group rules to maintain constructive dialogue. 
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D. Online Volunteering  

Even without traveling, you can offer your digital skills to help others. 

Examples: 

 Graphic Design: Creating posters for awareness campaigns. 

 Translation: Translating materials into local languages. 

 Content Writing: Writing articles or social media posts for NGOs. 

 Data Entry: Helping digitize records for community projects. 

Digital Participation Trends in Ethiopia 

Around the world, digital tools are transforming how citizens interact with governments, 

communities, and movements. This trend also influences Ethiopia to be governed in it.  

A. E-Governance & Smart Services: EthioGov / Digital Ethiopia 2025 Strategy. Ethiopia’s 

national digital strategy aims to integrate digital platforms into governance, service 

delivery, and economic growth. This includes: Online tax filing, trade licensing, and some 

e-learning platforms., National Digital ID (Fayda Project). 

B. Civic Tech & Open Data- Ethiocoders: A civic-tech initiative inspired by the government 

to improve digital citizen engagement. Include programs such as data analysis, Artificial 

intelligence, and Programming etc. 

C. Digital Financial Inclusion (Telebirr): A mobile money platform by Ethio Telecom that 

enables millions of Ethiopians to make digital payments, transfer money, and pay bills. 

D. Citizen Activism & Social Movements -  #NoMore Campaign: A digital activism campaign 

started by Ethiopian and Eritrean diaspora communities to counter misinformation about 

Ethiopia’s conflict in global media. 

E. COVID-19 Digital Awareness Campaigns: During the pandemic, Ethiopian institutions 

and civil society groups used SMS, Telegram, and Facebook to spread accurate health 

information and combat misinformation. 

3.3 Responsible and Safe Participation 
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Being an active digital citizen is not just about using technology; it’s about safe and responsible 

online participation in the digital world. Every time you post, comment, or share, you are shaping 

your digital footprint and contributing to the larger digital community. 

Public vs. Private Participation 

When engaging as a digital citizen, it’s important to understand the difference between public and 

private participation, as each has its advantages, limitations, and safety considerations. 

Public Participation 

Public participation means sharing your views, ideas, or content openly, where anyone can see and 

interact with it. 

Examples: 

 Posting a Facebook status update that is visible to “Everyone” 

 Commenting on a public Twitter/X thread about environmental policies 

 Writing a blog post or publishing an article on a public website 

 Participating in open online forums like Reddit or public community boards 

Advantages: 

 Can reach a wide audience quickly 

 Encourages open debate and discussion 

 Raises awareness on a large scale 

Risks: 

 Your words and content are visible to strangers, which may invite criticism or negative 

comments 

 Personal safety concerns if sharing sensitive details 

 Information can be copied or shared without your control 

Private Participation  
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Private participation happens in controlled or closed spaces, where communication is limited to 

selected individuals or groups. 

Examples: 

 Sending a direct message to a local council member on Telegram 

 Participating in a closed Facebook or WhatsApp group 

 Emailing an NGO about a community project 

 Sharing documents in a private Google Drive folder 

Advantages: 

 Greater control over who sees your messages 

 Safer for discussing sensitive or personal matters 

 Allows more focused, in-depth discussions 

Risks: 

 Limited reach compared to public posting 

 Still possible for private messages to be leaked or forwarded 

Safety Tip: If you are discussing politically sensitive issues, organizing an event that could attract 

attention, or sharing personal details, use private channels. Always verify the trustworthiness of 

the group or person before sharing sensitive information 

Safe participation  

Being an active digital citizen is powerful, but it also comes with responsibility. The way you act 

online not only affects your own reputation and safety but can also impact your community. 

Responsible and safe participation ensures that you contribute positively while protecting yourself 

and others. 

Stay Respectful Even in Disagreement  
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Online spaces often bring together people with different opinions, cultures, and experiences. 

Disagreements are natural, but they must be handled respectfully. 

 Avoid personal attacks, insults, or hate speech. 

 Focus on the issue, not the individual. 

 Use polite, professional language, even if the other person is being rude. 

Verify Information before Sharing 

Misinformation spreads quickly online and can cause harm to people, communities, or even 

national stability. 

 Check reliable news sources or official government announcements. 

 Avoid sharing posts with no clear source or suspicious headlines. 

 Use fact-checking websites like Africa Check or BBC Reality Check. 

Protect Your Personal Data  

Your personal information can be misused for fraud, harassment, or identity theft. 

 Never share your full home address, phone number, bank details, or ID numbers publicly. 

 Be cautious with location-sharing features on social media. 

 Use strong, unique passwords and two-factor authentication. 

Follow Community Guidelines and Platform Rules 

Every online platform, whether it’s Facebook, Telegram, or Zoom, has rules to maintain safety 

and respect. 

 Read and understand the terms of service. 

 Avoid posting banned content (e.g., hate speech, violent imagery, copyrighted material). 

 Report harmful behavior when you see it. 
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3.4 Digital Citizenship promoting platforms  

Digital tools make it easier than ever to connect with others, share ideas, and take action on issues 

that matter. By learning how to use these tools effectively, you can mobilize communities, gather 

feedback, and organize meaningful change. 

Facebook Groups / Telegram Channels – Mobilizing Communities  

These platforms allow you to bring people together for a common cause. 

 Why use them? They have a wide reach and enable discussions, updates, and event 

organization. 

 How to use effectively: 

1. Create a group or channel with a clear name and purpose (e.g., “Green Addis Tree 

Planting Initiative”). 

2. Set group rules to keep discussions respectful and on-topic. 

3. Post regularly to keep members engaged (updates, images, calls to action). 

4. Use polls and announcements to make decision-making easier. 

Google Forms – Gathering Feedback and Opinions 

Google Forms lets you create surveys or questionnaires to collect community opinions. 

 Why use it? Free, easy to use, and results are automatically collected in Google Sheets for 

analysis. 

 Steps to create a form: 

1. Go to forms.google.com. 

2. Click Blank Form or use a template. 

3. Add questions (multiple choice, short answer, checkboxes). 

4. Share the link via WhatsApp, Telegram, or email. 

5. Review results and make informed decisions based on responses. 

Exercise  
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Choose a community issue you care about (e.g., school, neighborhood, environment) and use 

digital tools to raise awareness and involve others safely. 

Steps: 

1. Write a short description of the issue and why it matters. 

2. Create a digital post (text, image, or video) about the issue. 

3. Share your post in a private group or online community. 

4. Create a simple survey or poll to collect opinions or support. 

5. Take screenshots of: 

o Your post 

o The shared group or survey 

o Survey/poll results 

6. Write a short reflection (3-4 sentences) on what you learned about responsible and safe 

online participation. 

Submission: Combine all screenshots, post, and reflection into a single Word or PDF document 

and submit with your name. 

Summary 

This session introduced digital citizenship as the responsible, respectful, and effective use of 

technology to participate in society. Learners explored ways to engage in online civic activities 

such as social media advocacy, online petitions, community groups, and online volunteering. The 

lesson highlighted the difference between public and private participation, emphasizing when each 

is appropriate. Safety practices like staying respectful, verifying information, protecting personal 

data, and following platform rules were discussed. Learners also discovered practical digital tools 

(Facebook/Telegram, Google Forms, Zoom/Teams) to mobilize communities, gather feedback, 

and host virtual meetings. 

Review Question  

Multiple Choices  
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1. Which of the following best defines digital citizenship? 

A. Knowing how to use a smartphone 

B. Using technology responsibly to participate in society 

C. Creating social media accounts for entertainment 

D. Downloading free software from the internet 

2. Which is an example of online civic engagement?  

A. Playing online games with friends 

B. Sharing a hashtag campaign about tree planting 

C. Watching random YouTube videos 

D. Installing a new mobile app 

3. What is one advantage of public participation online? 

A. It is always completely private 

B. It reaches a wide audience quickly 

C. It cannot be criticized 

D. It keeps information secure 

4. Which safety step should you take before sharing information online? 

A. Share first, check later 

B. Only check with friends 

C. Verify with reliable sources 

D. Post on multiple platforms at once 

5. Which digital tool is most suitable for collecting community opinions? 

A. Facebook Groups 

B. Google Forms 

C. Telegram Channels 

D. Zoom 

6. Which is an example of private participation? 

A. Tweeting about a new school policy 

B. Posting a public Facebook update 

C. Sending a direct message to a community leader 

D. Writing an open blog post 
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Session 4. Managing Digital Identity  

Introduction  

Dear learners, welcome to this session. In this session, you will explore Managing Digital Identity 

Imagine you are applying for a scholarship, a job, or a leadership position, and before making a 

decision, the committee searches your name online. What will they find your inspiring 

achievements, thoughtful posts, or perhaps old content you wish would disappear? In this session, 

you will learn how to create, protect, and maintain a positive digital identity so that your online 

presence supports your goals and opens doors to new opportunities rather than limiting them. 

 Learning Objective  

 Explain what digital identity is and why it matters. 

 Apply strategies to build and protect a positive online presence. 

 Edit and improve their own digital footprint. 

Content outline 

4.1  Digital Identity and its importance  

4.2 Building a Digital Identity  

4.3 Protecting Your Digital Identity and Digital Footprint 

4.1 Digital Identity and its importance  

Basic concepts of Digital Identity 

Digital identity is the electronic representation of a person, organization, or even a device in the 

digital world. It's not just what you choose to share; it's the entire compilation of data about you 

that can be found on the internet. This includes information you've posted yourself, as well as 

things others have posted about you. 
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It includes: 

Your digital identity is made up of a wide range of components, including: 

 Social media profiles: Your accounts on platforms like Facebook, LinkedIn, X (formerly 

Twitter), and Instagram are a major part of your digital identity. 

 Photos, videos, and posts: The content you've shared, from vacation photos to personal 

opinions, all contribute to your online persona 

 Comments, likes, and reviews: Your interactions with other people's content and your feedback 

on products and services also become part of your digital footprint. 

 Public records and media mentions: Articles, news stories, and any public records that are 

available online add to the picture of who you are. 

 Online forum and community participation: Your contributions to discussions in online 

forums, groups, and communities are also a part of your digital identity. 

Importance of Digital Identity 

Your digital identity is the version of you that exists online, and it's more important than ever. 

What you post, share, and engage with online creates a lasting impression that can impact your life 

in tangible ways. Here's why you need to pay attention to your digital footprint: 

i. First impressions are now online. Before a school, a potential employer, or even a new friend 

meets you in person, they will likely search for you online. What they find can shape their 

opinion of you and influence their decision. 

ii. It builds trust and credibility. A clean and professional online presence shows that you are 

responsible and take your reputation seriously. It can signal to others that you are reliable 

and trustworthy in the real world as well. 

iii. It protects your personal information. By actively managing what is visible to the public, you 

can reduce the risk of your personal information being misused. Limiting what you share and 

adjusting your privacy settings can help you avoid scams, identity theft, and other security 

risks. 

iv. It opens up opportunities. A strong digital identity can be a powerful tool. Networking, 

collaborations, and new opportunities often arise from your online presence. Whether it's 
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showcasing your skills on a professional site or connecting with others who share your 

interests, your digital identity can help you stand out and get noticed. 

4.2 Building a Digital Identity  

Best Practices (Simple Rules to Follow): 

I. Choose a good profile picture 

 Use a clear photo of yourself where your face is visible. 

 Avoid silly or unprofessional images, especially on accounts that others (like employers 

or schools) may see. 

II. Post useful and positive content 

 Share things that show your skills, achievements, or interests (for example: educational 

tips, inspiring quotes, or projects you’ve done). 

  Stay away from posting harmful, offensive, or inappropriate material. 

III. Join the right communities 

 Be active in online groups that match your studies, career, or hobbies. 

 This helps you learn, grow, and connect with people who share your goals. 

IV. Separate personal and professional life 

 Use one account for friends and family, and another for school or work. 

 This keeps your professional image clean and focused. 

V. Think before you post 

 Ask yourself: Would I be okay if my teacher, employer, or family saw this? 

 If the answer is no, don’t post it. Remember: once online, it’s hard to erase. 
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4.3 Protecting Your Digital Identity and Digital Footprint  

I. Protecting Your Digital Identity 

Safeguarding your digital identity is crucial for maintaining your privacy and security online. By 

taking a few proactive steps, you can significantly reduce your risk and protect your personal 

information. 

Steps to Stay Safe: 

1. Check Privacy Settings: Regularly review and adjust the privacy settings on all your social 

media accounts and other online platforms. Make sure you understand who can see your posts, 

photos, and personal information. 

2. Use Strong, Unique Passwords: Create complex passwords that are difficult to guess and avoid 

using the same password for multiple accounts. Using a password manager can help you keep 

track of them securely. 

3. Limit Personal Data Sharing: Be mindful of the personal information you share online. Avoid 

posting sensitive details such as your home address, phone number, financial information, or 

identification numbers. This helps prevent identity theft and other forms of misuse. 

4. Enable Two-Factor Authentication (2FA): Whenever possible, enable Two-Factor 

Authentication (2FA) on your accounts. This adds an extra layer of security by requiring a 

second form of verification (like a code sent to your phone) in addition to your password. 

Scenario: 

Abebe, a teacher, uses Facebook to connect with friends, share photos, and participate in 

professional groups. Recently, someone created a fake profile using his pictures and sent friend 

requests to his contacts. Abebe decided to take immediate steps to strengthen his digital identity 

protection. 

Action What Abebe Did Outcome / Benefit 

1. Checked 

Privacy Settings 

He went to Settings → Privacy → “Who can 

see your future posts?” and changed it to 

Strangers could no longer 

see his personal photos, 
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Friends only. He also reviewed his old posts 

and limited their audience. 

reducing impersonation 

risks. 

2. Used Strong, 

Unique Passwords 

He changed his old password (“abebe1985”) 

to a stronger one (“@bebeT3@ch!ng2025”) 

and stopped reusing passwords across other 

sites. 

Prevented password-

guessing or hacking 

attempts. 

3. Limited 

Personal Data 

Sharing 

He removed his phone number, address, and 

workplace from the “About” section, and 

turned off location tagging in posts. 

Reduced personal data 

exposure and stopped 

targeted scams. 

4. Enabled Two-

Factor 

Authentication 

(2FA) 

He activated 2FA under Settings → Security 

and Login, using his phone number for login 

alerts. 

Even if someone learned 

his password, they 

couldn’t access his 

account without his phone 

verification. 

5. Reported and 

Educated 

He reported the fake account to Facebook and 

warned his friends not to accept duplicate 

requests. 

The fake profile was 

removed, and his network 

became more cautious. 
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II. Monitoring Your Digital Footprint  

Your digital footprint is the trail of data you leave behind from all your online activities. It includes 

everything from your social media posts to the websites you visit. Monitoring this footprint is an 

essential part of managing your digital identity. 

How to Check Your Digital Footprint: 

1. Google Yourself and Review the Results: A simple but effective way to see what's publicly 

available about you is to search for your own name and any associated usernames on a search 

engine like Google. Pay close attention to what comes up on the first few pages of results. 

2. Audit Old Content: Go back through your social media profiles, old forum posts, and any other 

platforms you use. Delete or hide any content that is no longer representative of who you are 

today, or that could be seen as unprofessional or inappropriate by a school, employer, or anyone 

else. 

Figure 70 Facebook Security and Privacy settings 
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3. Set Up Google Alerts: To stay on top of new information about you as it appears, set up a 

Google Alert for your name and any other relevant keywords. This will send you an email 

notification whenever your name is mentioned in a new online article, blog post, or other web 

content. 

Exercise 

 Audit personal social media accounts for privacy and professionalism. 

 Create a LinkedIn profile or personal online portfolio. 

Exercise: Managing Your Digital Identity 

Audit your online presence, improve your professional image, and secure your digital identity by 

completing the following steps: 

1. Google your name and review what is publicly visible. Take notes or screenshots of any 

content that may be unprofessional or sensitive. 

2. Adjust privacy settings on your social media accounts to control who can see your posts, 

photos, and personal information. Enable Two-Factor Authentication (2FA) if available. 

3. Create or update a professional online profile (e.g., LinkedIn or personal portfolio) with a 

clear profile picture, bio, and highlights of your skills, achievements, or projects. 

4. Delete or hide any old content that may negatively impact your professional image. 

5. Write a short reflection (3–4 sentences) on what you learned and how you will maintain a 

positive online presence. 

Submission: 

Submit a Word or PDF document including: 

 Screenshots of your audit and privacy settings 

 Link to your professional profile 

 Your written reflection 

File name: DigitalIdentity_[YourName].docx 
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Summary  

In this session, learners explored the concept of digital identity, the information about them that 

exists online through social media, posts, public records, and more. They learned why maintaining 

a positive online presence is essential for building trust, attracting opportunities, and protecting 

personal information. The lesson covered practical ways to create a professional image, safeguard 

accounts with privacy settings and strong passwords, and monitor their digital footprint. By 

applying these strategies, learners can ensure their online reputation works in their favor. 

Review Questions 

Multiple Choice Questions  

1. Which of the following best describes a digital identity? 

a) Your offline ID card information 

b) The collection of data and online profiles that represent you online 

c) Only your social media accounts 

d) Your email password 

2. A digital footprint refers to: 

a) The physical devices you own 

b) The data trail you leave while using the internet 

c) Your identity card number 

d) Your credit card details 

3. Which of the following is a good practice for protecting your digital identity? 

a) Using the same password across all platforms 

b) Sharing your login credentials with friends 

c) Using strong, unique passwords and enabling two-factor authentication 

d) Clicking unknown links in emails 

4. Which action can help minimize your digital footprint? 

a) Regularly clearing browser history and cookies 

b) Posting personal information openly online 

c) Accepting all friend requests without checking 

d) Using unsecured public Wi-Fi for banking 
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5. Which of the following is part of your digital identity? 

A. Your social media posts 

B. Comments you leave on blogs or videos 

C. Mentions of your name in online news articles 

D. All of the above 

5. Which action best builds a positive digital identity? 

A. Posting funny memes without checking appropriateness 

B. Sharing educational content related to your career interests 

C. Liking or commenting on negative posts 
D. Posting personal details like your address 
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Module 4: Digital Content Creation 

Introduction  

This module covers the principles and practices of creating, editing, and integrating digital content 

across various formats while respecting copyright and licensing rules. The module is structured into 

three main sessions. Session 1: Understanding Digital Content: Learn about types, features, and 

purposes of digital content and its role in communication and learning. Session 2: Creating and Editing 

Digital Content: Explore practical techniques to produce and refine text, image, audio, and video 

content with clarity, originality, and audience engagement. Session 3: Integrating and Re-elaborating 

Digital Content: Learn to combine multiple sources into coherent, relevant, and original digital 

products. 

By the end of this module, you will be able to create and edit diverse digital content, integrate and 

adapt information effectively, and apply copyright and licensing principles responsibly when 

sharing or modifying content. 

Session 1: Developing Digital Content  

Introduction  

Dear learners, welcome to this session. In this session, you will explore Developing Digital 

Content 

Digital tools give us countless ways to express ideas, tell stories, and share information. In this 

session, you will learn how to create and edit digital content in a variety of formats, from text and 

images to audio and video, so that your message is clear, engaging, and impactful. 

You’ll explore how to transform your thoughts and creativity into meaningful digital expressions 

that connect with your audience. Whether you’re aiming to inform, persuade, or inspire, this 

session will give you the practical skills and confidence to bring your ideas to life in the digital 

space. 

Learning Objectives 
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By the end of this session, you will be able to: 

 Identify what digital content is  

 Create and edit digital content in various formats. 

 Create and modify content for different audiences and platforms. 

Content Outline: 

1.1.Understanding Digital Content 

1.2.Creating Digital Content 

1.3.Editing and Refining Content 

1.1 Understanding Digital Content 

Digital content is any type of information or media created, shared, and consumed in a digital format. If 

you’ve ever written a social media post, uploaded a video, or listened to a podcast, you’ve already engaged 

with digital content. It can be stored, accessed, and shared through devices like computers, tablets, and 

smartphones. 

Purpose of digital content: 

 To inform: Providing knowledge, facts, or instructions. 

 To educate: Teaching skills or concepts in a structured way. 

 To entertain: Engaging the audience through storytelling, humor, or visuals. 

 To communicate and express ideas: Sharing opinions, messages, or creative works. 

 To promote or persuade: Influencing audiences in marketing, campaigns, or social causes. 

Common Formats of Digital Content 

 Text:  Text-based content includes articles, blogs, social media posts, captions, and 

eBooks. 

  Images: Images such as photographs, illustrations, infographics, and memes are used to 

grab attention, enhance comprehension, and support visual storytelling.  

 Audio: Audio content includes podcasts, music, voice notes, and audiobooks. 
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 Video: Videos include short clips, tutorials, animations, and webinars. By combining 

visual and audio elements 

 Interactive Media: Interactive media includes quizzes, simulations, games, and interactive 

infographics. It encourages active participation, experimentation, and instant feedback, 

enhancing learning and engagement. 

 

 

Reflection Question: 

Which content format do you use most often, and why? (Write 2–3 sentences and discuss with 

your group) 

1.2 Creating Digital Content 

Creating digital content involves producing information or media in a digital format that 

communicates a message, educates, entertains, or engages an audience. Effective creation 

balance’s purpose, audience, format, and creativity. 

Key Steps in Creating Digital Content 

1. Planning: 

o Define the purpose and target audience. 

o Determine the format (text, image, video, audio, interactive). 

Figure 71 Types of Digital Contents 
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o Outline key messages and ideas. 

2. Researching and Gathering Resources: 

o Collect accurate information, media assets, and references. 

o Ensure sources are reliable and properly credited. 

3. Content Production: 

o Use appropriate digital tools for creation (word processors, graphic design software, 

video/audio editors). 

o Focus on clarity, readability, and visual appeal. 

4. Editing and Refining: 

o Review for errors, clarity, and coherence. 

o Improve visuals, audio quality, and overall engagement. 

o Ensure accessibility (alt text for images, captions for videos). 

5. Finalizing and Preparing for Distribution: 

o Format content for the intended platform or audience. 

o Ensure compliance with copyright, licensing, and ethical standards. 

 Accessibility: Ensure content is usable by people with different abilities. 

Principles of Effective Digital Content Creation  

 Clarity: Content should be easy to understand and concise. 

 Relevance: Align content with audience interests and purpose. 

 Consistency: Maintain style, tone, and format across platforms. 

 Engagement: Use visuals, storytelling, and interactivity to maintain attention. 

Digital Content Creation tools and Platforms 

Do you have prior experience using digital tools? If yes, which tools have you used? 

Digital content creation tools are software or platforms that allow users to design, edit, and publish 

content. 

Here are some popular and accessible tools to create and edit digital content efficiently. 
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1. Text Tools: Used for writing, formatting, and editing documents, articles, or social media 

posts. 

 Tools: Microsoft Word, Google Docs, LibreOffice Writer. 

 Basic Functions: 

o Typing and formatting text. 

o Adding images, tables, or hyperlinks. 

o Checking spelling and grammar. 

2.  Image Tools: Used to create, modify, and enhance images. 

 Tools: Canva (online), Adobe Photoshop, GIMP, Pixlr. 

 Basic Functions: 

o Cropping, resizing, and adjusting colors. 

o Adding text or shapes. 

o Applying filters and effects. 

3.  Audio Tools:  Used to record, edit, and mix audio files. 

 Tools: Audacity, Ocenaudio, and Online Voice Recorder. 

 Basic Functions: 

o Cutting or trimming audio clips. 

o Adjusting volume and adding effects. 

o Mixing multiple audio tracks. 

4. Video Content Tools: Used to produce and edit video materials for social media, 

presentations, or tutorials. 

 Tools: CapCut, Clipchamp, Canva Video Editor 

 Basic Functions: 

o Cutting and joining video clips. 

o Adding captions, background music, or voiceovers. 

o Inserting transitions and effects. 
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Selection Criteria  

When choosing a tool for creating and editing digital content, it is important to consider the 

following factors: 

 Ease of Use – Beginner-Friendly Interface 

 Features – Templates, Editing Tools, Export Formats 

 Compatibility – Works on Your Device and Operating System 

 Cost – Free or Affordable Plans 

Now, let’s start using this tool for creating digital content 

1.2.1 Document Creation Using Google Docs 

In this activity, you will learn how to create, format, and edit text using Google Docs. Follow each 

step carefully and complete it before moving to the next. At the end of the activity, save and upload 

your document. 

Activity 1: Create a Document for a School Assignment 

Step 1: Access Google Docs 

 Go to https://docs.google.com. 

 Sign in with your Google account. If you 

don’t have one, create a free account. 

Step 2: Start a New Document 

 Click the Blank document option. 

 A new untitled document will open.  

Step 3: Add Your Text 

 Click anywhere in the document to start 

typing. 

 Type the content for your assignment, 

poster, or report. 

Step 4: Format Your Text 

 Change Font: Highlight text → Click the font dropdown → Choose a font. 

 Change Size: Highlight text → Select font size from the toolbar. 

 Bold, Italic, Underline: Highlight text → Click B, I, or U. 

Figure 72 New Google Docs 

https://docs.google.com./
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 Text Color: Highlight text 

→ Click the text color icon 

→ Choose a color. 

 Highlight: Highlight text → 

Click the highlight icon → 

Choose a color. 

 

Step 5: Organize Your Content 

 Headings: Select text → 

Click Styles → Choose 

Heading 1, 2, or 3. 

 Bullet Points/Numbering: Highlight text → Click Bulleted list or Numbered list. 

 Alignment: Click Left, Center, Right, or Justify in the toolbar. 

Step 6: Insert Images, Links, or Tables (Optional) 

 Image: Click Insert → Image → Upload from computer or Search the web. 

 Link: Highlight text → Click Insert → Link → Add URL. 

 Table: Click Insert → Table → Choose number of rows and columns. 

Step 7: Review and Edit 

 Proofread your text for spelling, 

grammar, and clarity. 

 Make sure formatting is 

consistent and content is easy to 

read. 

Step 8: Save and Share 

 Google Docs saves 

automatically. 

 To export, click File → 

Download → PDF or Word. 

Discuss with your group  

Which formatting option (font, size, bold, color) improved your text the most? 

Figure 74 Steps on Google Docs 

Figure 73 Formatting Text 
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Did inserting images or links make your document more engaging? Explain. 

How did you ensure your text is clear and easy to read? 

Practical Exercise  

create a simple document with: 

A title (use a large font and bold). 

3–4 lines of text about a topic of their choice. 

Apply at least two formatting options (color, highlight, bold, italic, etc.). 

 

1.2.2 Image Creation  

In this activity, you will learn how to create an image using Canva by following step-by-step 

instructions, so follow each step carefully and complete it before moving to the next. At the end 

of the activity, save and upload your poster. 

Activity 1: Imagine your school is hosting a digital poster competition on a topic you care about, 

such as health, the environment, or online safety. Your task is to create a poster that effectively 

conveys your message. Canva is one of the tools for supporting such activities. 

Step 1: Access Canva 

 Click here to open Canva → Canva.com 

 If you don’t have an account, create a free account or log in using Google/Facebook. 

Step 2: Choose a Template 

 Click “Create a design” → Select “Poster” 

 Browse available templates that match your school event theme. Click “Use this 

template” to start. 

https://www.canva.com/


Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [135]                                 October, 2025 

Step 3: Customize Text 

 Click on existing text boxes to 

edit text. 

 Replace with your event 

details: title, date, location, 

and call-to-action. 

Step 4: Add or Replace Images 

 Go to the “Photos” tab or 

click Upload to use your 

own images. 

 Drag and drop images into your poster; resize or reposition as needed. 

Step 5: Adjust Colors and Fonts 

 Change colors by clicking on elements and selecting new colors from the toolbar. 

 Choose fonts from the dropdown menu, keeping styles consistent. 

Step 6: Apply Basic Effects (Optional) 

 Add filters, adjust brightness/contrast, or apply transparency. 

Step 7: Save and Download 

 Click “Share” → “Download”, select PNG or PDF, then click Download. 

 Sharing and a Reflective question  

1. Share your poster with a partner or group 

2. suggests one improvement for your partner’s poster. 

3. Write down your feedback and reflect on what you learned  

practical exercise  

Figure 75 Canva at https://www.canva.com/ 
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using the following requirements create a poster for an upcoming sports Day school event  

 Include a title, date, location, and call-to-action. 

 Use at least two different fonts and two colors for text. 

 Add one or more images (from Canva library or uploaded). 

 Apply one effect (filter, brightness/contrast, or transparency). 

         

1.2.3 Video Creation and Editing 

In this activity, you will learn how to create a video using Clipchamp and CapCut by following 

step-by-step instructions so follow each step carefully and complete it before moving to the next. 

At the end of the activity, save and share with your friends. 

What is Clipchamp and CapCut? 

Clipchamp: A web-based video editor (with desktop app options) focused on ease-of-use, 

templates, and online editing.  

CapCut: A cross-platform video & graphics editor (mobile, web, desktop) with both simple and 

advanced features.  

Key Similarities 

Feature Clipchamp CapCut 

Trim / Cut / Split 

clips 

basic video trimming & splitting)  basic trimming, splitting   

Text overlays / Titles Can add text, overlays  text, animated text, auto captions etc 

Audio / Music / 

Volume control 

stock music + ability to adjust 

audio levels  

library of music, voiceover support, 

volume control 

Effects, filters, 

transitions 

filters, transitions, color correction filters, transitions, effects, keyframe 

animations, etc 

Templates & Stock 

Media 

Have templates and royalty-free 

content 

Have templates, built-in effects, 

asset library 
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Main Differences & Strengths 

Aspect Clipchamp CapCut 

Platform / 

Access 

Primarily web-based (works in 

browser) with desktop app  

Multi-platform: mobile (iOS/Android), 

desktop, web. 

Ease for 

Beginners 

Very user-friendly; drag-and-

drop, template-based for quick 

edits.  

Also beginner-friendly, but with more 

advanced options available. 

Advanced 

Features 

Some advanced effects, color 

correction, transitions, AI tools.  

More advanced tools: keyframe 

animation, auto captions, chroma key, 

motion tracking, etc.  

Export / Output 

Quality 

Free version may have 

limitations (watermarks, 

resolution caps) depending on 

plan.  

Free version is robust; Pro version offers 

higher export quality, premium assets, 

remove watermark, etc.  

AI Tools / 

Automation 

Offers AI tools, e.g. “remove 

silence,” auto-transcription, etc.  

Strong AI support: auto captions, vocal 

isolation, text-to-speech, etc.  

Integration & 

Ecosystem 

Integration with Microsoft, 

OneDrive, Windows 

environment.  

Better integration with mobile 

workflows and social media (TikTok, 

etc.) area of strength.  

Which One to Use When? 

 Use Clipchamp if: 

1. You want to edit from a browser (no installation) 

2. You prefer working on a desktop environment 

3. You value easy template-based workflows and Microsoft integration 

 Use CapCut if: 

1. You want more advanced editing options (keyframes, motion, chroma key) 

2. You work across mobile and desktop 

3. You want richer creative tools and AI-powered features 
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Let’s using both Clipchamp and CapCut to understand video editing practically. 

Activity 1 – Imagine your school is creating a short video campaign on a topic you care about. 

Your task is to create and edit a video that communicates your message clearly. Using Clipchamp 

helps you to develop short videos  

Step 1: Access Clipchamp 

 Go to 

https://clipchamp.com and 

sign up or log in. 

 Then, select a task on the 

dashboard. You can 

choose between Create a 

new video or Record 

something, then click it. 

 

 Step 2: Start a New Project 

 Click “Create a video”, 

set the aspect ratio (e.g., 

16:9 for YouTube or 1:1 

for Instagram). 

Step 3: Record Video or Audio  

 Use the Record & 

Create button to capture 

a short video or voice 

clip (30-60 seconds). 

 Alternatively, upload a 

pre-recorded clip. 

Figure 76 Access Clipchamp 

Figure 77 Start a New Project 
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Step 4: Load a video on timeline  

To load a video to timeline, drag 

the edges of the clip on the 

timeline to trim unwanted parts. 

 

 

Depending on your editing needs, 

choose among editing tools on the 

left and right-side panels and at the 

bottom of the timeline. 

Step5: Trim and edit the video  

 To trim a video, click on it in the 

timeline and click and drag the 

bars backward and forwards. 

 

 

 to add text, click the Text tab on 

the timeline's left side panel to add text to your video. 

  Scroll over the provided texts to find your preferred style for your video. Click the + symbol 

to add it to your timeline. 

 

 

Figure 78 Load a video on timeline 

Figure 79 Trim and edit the video 
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 Add a filter, fade, adjust colors, edit speed, or change volume, use the tabs on the right-

side panel of the timeline. 

Step 5: Preview and Export 

 Click the Play button to 

preview. 

 When satisfied, click 

Export, choose video 

quality, and download. 

 

 

Reflective question: 

1. Which steps did you find easiest while creating your video? Explain why. 

2. Which step was most challenging, and how did you overcome it? 

3. What feature did you use (text overlay, background music, trim) and why? 

Activity 2- Imagine your school is launching a video awareness campaign. You are part of the 

creative team responsible for producing a 30–

60 second short video on digital safety topic. 

Use CapCut to edit your video and make it 

engaging for your audience. 

Steps to create your video using CapCut 

Step 1. Install CapCut app and open it. 

Step 2. Tap the "New Project" icon to create a 

project.  

 Click add to import videos, images, or audio from your device. 

Figure 80 Preview and Export 

Figure 81 start the Cupcut project 
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Step 3. Start editing on the timeline. 

 Drag and drop clips into the Timeline (bottom area). 

 Rearrange by dragging clips left or right. 

You can stack clips (video, audio, text, overlays) on different tracks. 

To trim video  

After adding videos to the timeline, 

follow these steps to trim videos in 

CapCut: 

1. click the video clip, you shall see 

white frames around it. 

Figure 82 start the Cupcut project 

Figure 83 Load Video 
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2. click and hold on the white 

edge, and drag it to trim the 

video. 

3. You can also drag the opposite 

position to retrieve trimmed 

parts. 

When you are trimming videos by 

dragging the edges, the adjacent clips 

will move along. In this way, there won't 

be gaps (and hence black screens) in 

your project. 

If you want to trim out a section in 

the middle, you need to split the 

footage, and delete the clip in the 

middle. 

 

 

 

To split a video clip, follow these steps: 

1. Tap the video clip to make sure it is selected.  

Figure 84 Trim and edit the video1 

Figure 85 Trimming videos 
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2. Hit the Split icon at the bottom of 

CapCut. 

By splitting the video, you can perform the 

following edits: 

 Add transitions in between after 

creating the split; 

 Remove unwanted parts by tapping 

the split clip, and click the Delete icon 

at the bottom of the screen; 

 Insert new clips in between two video 

clips. 

To resize videos, follow these steps: 

1. click the video clip that you want to change size.  

2. click the Format icon at the bottom of the editor. 

3. Choose a different as aspect ratio. 

To Add Text & Titles Click Text in the bottom panel. 

 Choose a style (title, subtitle, handwriting, etc.). 

 Edit text in the Preview Window and adjust font, size, and animation from the toolbar on the 

right. 

Figure 86 Split Video 
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To Add Effects & Filters 

 Go to Effects (left 

panel). 

 Drag an effect (e.g., 

Glitch, Blur, 

Cinematic) onto the 

timeline track above 

your clip. 

 Adjust effect duration 

by resizing its bar on 

the timeline. 

To Ad Music & Sounds 

 Click Audio → choose from stock library or import your own. 

 Drag audio to the audio track in the timeline. 

 Adjust volume and fade-in/out in the right 

toolbar. 

Step 4 Export Your Video 

 Once editing is done, click Export (top right).  

 Choose resolution (up to 4K), FPS (frames per 

second), and quality. 

 Save to device or upload directly to 

TikTok/YouTube 

Reflection and Sharing  

1. Share your video with classmates  

2. Discuss what message does your video deliver? 

3. Discuss what editing tools helped you make it clear and engaging? 

Figure 87 Add Effects & Filters 

Figure 88 Export  Video 
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1.3 Editing and Refining Content 

How to improve the quality, clarity, and usability of digital content? 

Techniques for Improving Accuracy and Quality 

 Proofreading: Check for spelling, grammar, punctuation, and formatting errors. 

 Fact-checking: Verify all information, data, and references for accuracy. 

 Clarity and Concise: Remove unnecessary words, simplify complex sentences, and ensure 

the message is easy to understand. 

 Consistency: Maintain uniform style, tone, fonts, colors, and formatting across the 

content. 

 Peer Review: Have others review the content for feedback and improvements. 

Exercise 

Open one of your previous posters and: 

Check for any spelling or grammar mistakes. 

Suggest one improvement for clarity or accuracy. 

Enhancing Visual and Audio Elements 

 Visuals: 

o Adjust brightness, contrast, and saturation of images. 

o Crop or resize images to focus on key elements. 

o Use graphics, charts, or icons to make information easier to understand. 

 Audio: 

o Remove background noise and enhance clarity. 

o Adjust volume levels for consistency. 

o Use sound effects or music carefully to support, not distract from, the message. 

 Multimedia Integration: Combine text, images, video, and audio smoothly for cohesive 

content. 
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Exercise 

 Edit your Clipchamp video by applying at least one visual or audio enhancement.  

Ensuring Content is Accessible and User-Friendly 

 Accessibility Guidelines: 

o Use descriptive alt text for images. 

o Include captions or transcripts for videos and audio content. 

o Ensure adequate color contrast for readability. 

o Choose legible fonts and proper font sizes. 

 User Experience (UX): 

o Organize content logically with headings, bullet points, and sections. 

o Ensure navigation is simple for interactive content. 

o Check content responsiveness for different devices (desktop, tablet, mobile). 

Exercise  

 Review your content and check if it meets accessibility and UX guidelines. Write a short note on 

one improvement you can make. 

Summary  

In this session, you learned about digital content, its formats, purposes, and the principles of clear 

communication. You explored how to plan, create, edit, and finalize text, image, audio, and video 

content using digital tools. Activities in Google Docs, Canva, Cupcut and Clipchamp provided 

hands-on experience to produce engaging, clear, and accessible digital content for your audience. 

Emphasis was placed on editing for accuracy, enhancing visual/audio quality, and ensuring 

usability across devices. By following these steps, learners can create professional and effective 

digital content. 

Review Questions: 

Part 1: Multiple Choice  
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1. Which step comes first in creating digital content? 

A. Editing and refining 

B. Researching and gathering resources 

C. Planning 

D. Publishing 

2. Which tool would you use to create a visual poster? 

A. Google Docs 

B. Canva 

C. Audacity 

D. Clipchamp 

3. Which principle ensures that text, images, and audio are organized for easy understanding and 

readability? 

A. Accessibility 

B. Engagement 

C. Relevance 

D. Clarity 

Part II: Short Answer  

1. Which content format do you prefer using (text, image, audio, video, interactive), and why? 

2. Describe one editing or refinement step you applied to improve a text, image, or video 

3. How did you ensure your content is accessible to all users? 

4. What challenges did you face while creating digital content, and how did you overcome them? 
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Session 2: Integrating and Re-elaborating Digital Content 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Integrating and Re-

elaborating Digital Content 

Integrating and re-elaborating digital content involves taking existing information, improving it, 

and combining it with other resources to create something new and relevant. This process includes 

evaluating sources, rewriting or restructuring content, and merging different media types to suit a 

specific audience or purpose. In this session, you will learn how to refine, combine, and publish 

content in ways that add value while respecting copyright rules. 

Learning Objectives 

By the end of this session, learners will be able to: 

 Re-elaborate content by rewriting or restructuring it for clarity 

 Integrate multiple media types (text, images, audio, video) into a cohesive digital product. 

 Publish content responsibly, respecting copyright and attribution rules. 

 Promote digital content  

 Content outline  

2.2 Integrating Multiple Digital Products 

2.3 Publishing Digital Content 

2.4 Distributing & Promoting Digital Content 

2.1 Integrating Multiple Digital Products 

Up until now, you have created your text, images, audio, and video separately. In this lesson, we 

will learn how to bring all these elements together into a single, cohesive digital project. 
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Integration is the ability to take existing digital content (text, images, audio, and video ) into a 

single cohesive product and combine it with other materials, and producing something 

meaningful, new, and useful. 

Why Integration is Important: 

 Enhances engagement by appealing to multiple senses. 

 Improves understanding and retention of information. 

 Makes content more professional, creative, and visually appealing. 

 Encourages originality through modification and re-elaboration of existing content. 

Step-by-Step Process for Content Integration 

1. Select and Gather Sources 

o Collect relevant text, images, audio, and video from reliable sources. 

2. Evaluate Content for Relevance and Accuracy 

o Check each item for correctness and relevance to your topic. 

3. Plan Integration Strategy 

o Decide how text, images, audio, and video will complement each other. 

4. Re-elaborate and Modify Content 

o Rewrite text to be clear and original. 

o Edit images or videos to better fit your message. 

5. Merge Media and Design Final Product 

o Combine all media using tools like Canva, PowerPoint, or Google Slides. 

6. Add Attribution and Citations 

o Properly credit all external sources to respect copyright. 

7. Export and Publish 

o Save your project in a suitable format (MP4, PDF, PPTX). 

Example: 

 You can create a multimedia presentation about “My Hobby” using Canva, PowerPoint, or 

Google Slides. 
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 Your presentation could include: 

o A written paragraph describing the hobby 

o Images showing the hobby in action 

o A short video demonstrating the hobby 

o Background music or narration to enhance the experience 

Practical Activity – Integrate a Multimedia Project 

Instructions: 

Step 1 – Choose a Topic 

 Pick a topic you enjoy or know well (e.g., My Hobby). 

Step 2 – Gather Your Materials 

 Text: Write a short paragraph (3–5 sentences) explaining your topic. 

 Images: Select 2–3 images (photos you take or copyright-free sources). 

 Video/Audio: Add a short clip or voice recording (10–30 seconds) explaining your topic. 

Step 3 – Open a Digital Tool 

 Use Canva, PowerPoint, or Google Slides. 

Step 4 – Combine Your Media 

 Insert your text in clear, readable slides or sections. 

 Place images to support your text. 

 Add video or audio clips. 

 Adjust layout, fonts, and colors for clarity, aesthetics, and originality. 

Step 5 – Modify and Re-elaborate 

 Revise your text for clarity, originality, and coherence. 

 Edit images or video to improve quality and relevance. 
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Step 6 – Save, Preview, and Cite 

 Export your project in MP4, PDF, or PPTX format. 

 Ensure all media works seamlessly. 

 Include citations for any external media used. 

Step 7 – Submit 

 Upload your final multimedia project to the assignment submission box, including a short 

paragraph reflecting on your media choices and text improvements. 

Reflective question: 

1. What did you learned about integrating multiple digital products? 

2.2 Publishing Digital Content 

Publishing digital content means making your text, images, videos, or other materials available for 

others to view online or share electronically. This can be through websites, blogs, social media 

platforms, or learning management systems (LMS) like Moodle. 

Why Publishing Matters 

 Reach a wider audience: anyone with internet access can see your work. 

 Share information quickly: no printing or shipping delays. 

 Enable interaction: people can comment, like, or share your content. 

 Build your portfolio: showcase your skills to employers or clients. 

Common Publishing Platforms  

 Social Media – Facebook, Instagram, TikTok, YouTube. 

 Blogs & Websites – WordPress, Wix, Blogger. 

 Video Platforms – YouTube. 

 Learning Platforms – Moodle, Google Classroom. 

 Cloud Storage & Sharing – Google Drive, Dropbox, OneDrive. 
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Key Considerations Before Publishing 

1. Audience – Who will see the content? Adjust tone and style accordingly. 

2. Purpose – Is it for education, marketing, entertainment, or personal use? 

3. Format & Quality – Ensure the content is clear, well-formatted, and error-free. 

4. Copyright & Permissions – Only use media you have the right to share. 

5. Privacy & Security – Avoid sharing sensitive personal information. 

Basic Steps to Publish Content 

1. Prepare Your Final Version: Proofread text, check visuals, and confirm file formats. 

2. Choose the Platform: Select where your audience is most active. 

3. Upload or Post: Follow the platform’s upload process. 

4. Add a Title and Description: Make it clear, engaging, and searchable. 

5. Promote & Share: Use links, tags, and social sharing tools. 

6. Monitor Engagement: Track views, likes, comments, or shares.  

Steps to Publish Your Project 

Step 1 – Prepare Your File for Publishing  

 Export your integrated multimedia project (from Lesson 2.1) into a shareable format 

(PDF, MP4, PPTX). 

 Double-check spelling, layout, and media quality. 

Step 2 – Choose a Publishing Platform 

 For Classroom Sharing: Moodle Assignment, Google Drive, USB. 

 For Public Sharing: YouTube, Blogger, Instagram, Facebook. 

Step 3 – Upload Your Project 

 Follow the platform’s upload process. 

 Add a short title and description to help your audience understand your project. 
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Class activity  

Publish your video on YouTube 

Steps to Publish Your Project on YouTube 

Step 1: Sign in to YouTube 

 Go to www.youtube.com. 

 Click Sign In (top right corner) and 

enter your Google account email 

and password.  

Step 2: Go to the Upload Page  

 Click the Create (+) icon at the top 

right. 

 Select Upload video from the 

menu. 

 The YouTube Studio upload 

window will open. 

Step 3: Select Your Video File    

 Click Select files or drag and drop 

your project video into the window. 

Figure 89 Sign in  and upload Video 

https://www.youtube.com/
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 Wait for the video to upload. 

Step 4: Add Video Details 

Fill in the required information:  

 Title: Write a clear and 

descriptive title. 

 Description: Add details about 

your project (topic, purpose, 

etc.). 

 Thumbnail: Choose or upload an image that represents your video. 

 Playlist: (Optional) Add your video to a playlist if you have one. 

Step 5: Set Audience 

 Choose “Yes, it’s made for kids” if 

your video is for children, or 

 “No, it’s not made for kids” if it’s for 

general audiences.  

Step 6: Add Tags and Category (Optional) 

 Add keywords or tags related to your topic (e.g., “school project,” “digital content,” etc.). 

 Choose a category (e.g., Education). 

Figure 90 Add Meta Data 

Figure 91 Set Audience 
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Step 7: Choose Visibility Settings 

         Select who can see your video:  

 Public: Everyone can see it. 

 Unlisted: Only people with the link 

can watch it. 

 Private: Only you (and specific 

users you invite) can see it. 

Step 8: Publish or Schedule 

 Click Publish to make it live 

immediately, or 

 Choose Schedule to post it later at a 

specific date and time.  

Step 9: Share Your Video 

 After uploading, copy the video link and share it with classmates, teachers, or on social 

media. 

Review and Respond 

 Watch your video once it’s live. 

 Check comments (if enabled) and reply politely. 

 Track views and feedback to improve future projects. 

2.3 Distributing & Promoting Digital Content 

Distributing and promoting digital content means sharing your published materials with your 

intended audience and encouraging them to engage with it. This can involve sending direct links, 

posting on social media, embedding in websites, or using other communication channels. 

Promotion focuses on increasing visibility, reach, and interaction so your work gets noticed and 

achieves its purpose. 

Figure 92 Choose Visibility and Publish 
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Why Distribution & Promotion Matter 

 Increase Reachability – More people see and interact with your content. 

 Boost Engagement – Encourages likes, comments, shares, and discussions. 

 Achieve Purpose – Whether educational, marketing, or entertainment, your content reaches 

its intended audience. 

 Build Credibility – Regularly sharing valuable content strengthens your reputation. 

Common Distribution & Promotion Channels 

 Social Media: Facebook, Instagram, TikTok, X (Twitter), LinkedIn. 

 Messaging Apps: WhatsApp, Telegram, Messenger. 

 Email:  Newsletters or targeted email campaigns. 

 Websites & Blogs: Embedding or linking content on your site. 

 LMS Announcements: Sharing within Moodle or Google Classroom. 

Key Considerations Before Distribution 

1. Audience Location: Where are they most active (social media, email, forums)? 

2. Timing:  Post at times when your audience is most likely to see it. 

3. Content Format: Adjust size, style, and length for each platform. 

4. Message & Call-to-Action: Tell your audience exactly what to do next (e.g., “Watch Now,” 

“Download,” “Share”). 

5. Tracking & Feedback: Use analytics to measure how your content performs. 

Basic Steps to Distribute & Promote Content 

1. Identify Target Audience: Who needs to see your content? 

2. Choose Distribution Channels: Pick platforms where your audience is active. 

3. Prepare Content for Each Platform: Resize images, shorten text, create platform-specific 

captions. 

4. Share & Promote: Post, send, or publish content with engaging titles and tags. 

5. Encourage Interaction: Ask for feedback, comments, and shares. 
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6. Monitor & Adjust: Use analytics to improve future distribution. 

Practical Exercise:  Distribute & Promote Your Project 

Step 1 – Prepare Your Published Content 

 Use the final published version from Lesson 1.2 (PDF, MP4, PPTX, or link). 

Step 2 – Choose Two Distribution Channels 

 Example: Facebook & WhatsApp, YouTube & Moodle Announcement, Email & 

Instagram. 

Step 3 – Adapt Content for Each Channel 

 Create a short caption or description for social media. 

 For email, write a 2–3 sentence introduction with a clickable link. 

Step 4 – Share Your Content 

 Post or send your content on your chosen platforms. 

 Use relevant hashtags, tags, or groups to boost reach. 

Reflection: Write a short paragraph (3–5 sentences) on: 

o Which platforms worked best for reaching your audience. 

o Any feedback or engagement you received. 

o How you might improve future promotions. 

Summary  

In this session, you learned the complete workflow of creating a professional digital product from 

creating your text, images, audio, and video into a single, cohesive project, to publishing it in a 

format suitable for your audience, and finally distributing and promoting it through the right 

channels. By mastering integration, you ensured your content was clear, engaging, and original. 
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Through publishing, you prepared your work for sharing while maintaining quality and copyright 

compliance. By understanding distribution and promotion, you gained the skills to reach the right 

audience at the right time, increasing the visibility and impact of your work. These combined skills 

enable you to transform an idea into a finished product that is not only well-crafted but also widely 

seen and appreciated. 

Review Questions  

Multiple choses  

1. Which of the following is NOT a common publishing platform? 

A. YouTube 

B. Moodle 

C. Instagram 

D. Microsoft Word 

2. What is the main purpose of integrating multiple digital products before publishing? 

A. To make the file size smaller 

B. To combine elements into a cohesive, professional project 

C. To ensure it can be printed 

D. To increase download speed 

3. Which factor is MOST important when choosing a distribution channel? 

A. The color of the platform’s interface 

B. The size of your audience on that platform 

C. The amount of free storage it offers 

D. The number of fonts available 

4. Which of the following best describes “promotion” in digital content? 

A. Editing your video before publishing 

B. Actively increasing awareness and engagement for your content 

C. Backing up files to a secure location 

D. Compressing images for faster loading 

5. Which statement is TRUE about publishing digital content? 
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A. Once published, you can never edit it again 

B.  It’s only necessary if you’re selling your work 

C. It prepares your work for sharing in a usable format 

D. It’s the same as integrating content 

Practical Exercise   

 Create integrated multimedia projects, then  

 Publish your integrated multimedia project to a platform of your choice. 

 Submit /share the link or file to your group  

 Add a short reflection (3–4 sentences) describing your publishing choice, target audience, 

and promotion strategy. 
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Session 3: Copyright and Licenses 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Copyright and License  

Not everything you find online is protected by copyright in the same way. Understanding how 

copyright and licenses work will help you use and share digital content legally and ethically. It 

also helps you protect your own work and respect the rights of others.  

When you create a digital product/content such as text, images, audio, or video, you automatically 

have certain legal rights over it. These rights are called copyright. It also guides you in using and 

sharing content legally, which is essential for ethical digital content creation. 

Learning objectives 

By the end of this session, learners will be able to: 

 Explain what copyright is and how it applies to digital content. 

 Identify different types of licenses and their conditions. 

 Apply best practices for using and sharing digital content legally and ethically. 

 Recognize the importance of respecting copyright to protect both their own and others’ 

work. 

Content outline  

3.1 Facts and Row Data in Digital Content  

3.2 Copyright in Digital Content 

3.3 Licenses in digital content 

3.1 Facts and Raw Data in Digital Content 

Not all information you find online is protected by copyright. In digital content, it’s important to 

distinguish between facts/raw data and creative expression. 
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What is row data? 

Raw data refers to the original, unprocessed information collected from different sources. 

Example of Raw Data: 

Name Age City Score 

Hana 15 Addis Ababa 85 

Miki 16 Adama 78 

Saba 14 Bahir Dar 90 

Right now, it’s just numbers and names. It doesn’t tell a story yet. 

What are Facts? 

Facts come from processing the raw data. They are true and verified pieces of information. 

Example: From the table above, we can say: 

 “Saba scored the highest with 90 points.” 

 “The average score of students is 84.3.” 

Facts help us understand the data. They turn numbers into meaningful insights. 

Key Points to Remember: 

1. Facts and raw data are free for anyone to use. 

2. The creative arrangement or unique presentation of those facts may be protected by 

copyright. 

3. Always check if the way the data is presented is original before reusing it. 

Importance in Digital Content 

 Digital content (like blogs, videos, reports, infographics, or social media posts) should be 

based on accurate facts derived from reliable data. 

 Misusing or misrepresenting data can lead to misinformation or loss of credibility. 

 Content creators must: 

o Check the source of data. 
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o Verify facts before publishing. 

o Present data visually (charts, graphs, tables) to make it clear and engaging. 

3.2 Copyright in Digital Content 

Copyright is a legal protection given to the creators of original works, including digital content 

such as articles, photos, music, videos, and software. 

Digital content that contains creative expression, such as infographics, research reports, e-learning 

videos, blogs, or unique images, is protected by copyright. Using someone else’s protected work 

without permission may be an infringement unless covered by an exception or a license. 

Purpose: 

1. To give the creator control over how their work is used. 

2. To prevent unauthorized copying, distribution, or modification. 

Automatic Protection: In most countries, you do not need to register your work for it to be 

copyrighted it happens automatically when you create it. 

Example: 

If you write an original blog post or design a unique poster, no one else can legally copy, sell, or 

modify it without your permission. 

3.3 Licenses in Digital Content 

A license is permission given by the copyright owner for others to use their work in certain ways. 

Licenses clearly outline what is allowed and what is restricted when using digital content. 

Types of Licenses: 

1. All Rights Reserved – No one can use your work without explicit permission. 

2. Creative Commons (CC) Licenses – Allow sharing and use under specific conditions. 

Common types: 

 CC BY: Use allowed with credit to the creator. 
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 CC BY-SA: Use allowed with credit, and new work must have the same license. 

 CC BY-ND: Use allowed with credit, but no changes to the work. 

 CC BY-NC: Use allowed with credit, but not for commercial purposes. 

3. Public Domain – No copyright; work can be used freely by anyone. 

Example: 

A photo with a CC BY license can be used in your presentation as long as you give credit to the 

photographer. 

Why licenses matter: 

 They tell you what you can and cannot do with content. 

 They help protect creators while allowing fair and legal use. 

Best Practices for Using Digital Content Legally 

1. Always check the license before using someone’s work. 

2. Give proper credit (name of creator, source, and license type). 

3. When in doubt, create your own original content. 

4. Use copyright-free or Creative Commons-licensed resources. 

Summary 

Understanding copyright and licenses is essential for anyone creating or sharing digital content. 

Copyright laws give creators legal protection over their original works, ensuring that their ideas, 

designs, writing, or media are not used without permission. By learning about different types of 

licenses such as Creative Commons, open-source, or proprietary licenses you can clearly know 

what others allow and what requires explicit permission. 

Moreover, understanding and applying copyright and licenses fosters a culture of creativity and 

innovation. When creators know their work is protected, they are more likely to share, collaborate, 

and contribute new ideas confidently. Likewise, by respecting others’ work, you contribute to a 

community where creativity is valued, recognized, and ethically shared. In essence, mastering 
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copyright and licensing is not just about avoiding problems it’s about promoting integrity, respect, 

and sustainability in the digital world. 

Review Questions  

1. What does copyright protect? 

A. Ideas 

B. Original works of expression 

C. Names and slogans only 

D.  Facts and numbers. 

2. Which Creative Commons license allows use only for non-commercial purposes? 

A. CC BY 

B. CC BY-NC 

C.  CC BY-SA 

D. CC BY-ND 

3. What is the main purpose of a license? 

A. To increase file size 

B. To allow others to use a work under certain conditions 

C. To delete old content 

D. To hide ownership of a work 

Short Answer 

Give one example of how you can legally use an image from the internet. 

Capstone Project: Creating and Publishing Digital Content 

Assignment Tasks / Steps 

Step 1: Project Planning 

 Select a topic: school event, community awareness, environmental campaign, or cultural 

heritage. 

 Define your target audience and purpose. 
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 Create a project plan including: 

o Type of content (poster, video, presentation, blog, etc.) 

o Required resources (software, images, audio, etc.) 

o Timeline for completing each step 

 Example: “A short video promoting school cleanliness for students aged 12–18.” 

Deliverable: Written project plan 

Step 2: File Management 

 Create a main project folder with subfolders: Text, Images, Audio, Video, Drafts. 

 Name your files clearly (e.g., poster_final.png, script_draft.docx). 

 Use search and sort tools to organize and quickly find your files. 

Deliverable: Properly organized project folder with all files 

Step 3: Content Creation 

 Text: Write clear and engaging copy relevant to your topic. 

 Images/Graphics: Create or source images and graphics, ensuring proper licenses. 

 Video/Audio (Optional): Record or source media responsibly; edit using tools like 

CapCut or Clipchamp. 

 AI Tools (Optional): Use AI tools to improve text, generate images, or enhance your 

content. 

Deliverable: Draft content including text, images, and optional audio/video 

Step 4: Copyright and Licensing 

 Verify all media for usage permissions. 

 Give proper credit to original creators. 

 Follow licensing rules such as Creative Commons or other usage licenses. 

Deliverable: Documentation of sources and licenses used 
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Step 5: Editing and Refining 

 Edit videos, images, and text to make content polished and professional. 

 Ensure logical flow and visual appeal. 

 Check grammar, spelling, and readability. 

Deliverable: Finalized digital content ready for publishing 

Step 6: Publishing 

 Choose a platform (school website, YouTube, digital gallery). 

 Add title, description, tags, and thumbnail. 

 Set audience (Made for kids or not) and visibility (Public, Unlisted, Private). 

 Publish and copy the link for submission. 

Deliverable: Published digital content link 

Step 7: Reflection 

 Write a short reflection (5–10 sentences) addressing: 

o Challenges you faced 

o How you followed copyright and licensing rules 

o Lessons learned about digital content creation 

Deliverable: Reflection report 

. 
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Module 5: Safety 

Introduction 

In today’s digital world, protecting your personal data and managing your online identity is more 

important than ever. Safety in this context refers to the ability to understand and recognize threats 

that exist on the internet, as well as having the skills and knowledge to avoid these threats. This 

includes knowing how to keep personal information private and secure online, protecting devices 

from malware, avoiding harmful or illegal content, and managing online relationships safely. The 

module is organized into four sessions where: Session 1 focuses on your account management, 

Session 2 discusses the basic privacy settings, Session 3 identity and common threats, and Session 

4 deals with secure practice of online environment. in these sessions, Learners will also explore 

secure practices such as strong password creation, two-factor authentication, and safe browsing 

habits to protect themselves and others in digital environments. 

Session 1: Account Management 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Account Management  

Digital security skills are the abilities and practices used to safeguard devices, data, accounts, and 

online activities from unauthorized access, cyberattacks, and data loss. They include using strong 

passwords, enabling multi-factor authentication, securing files, managing account permissions, 

avoiding phishing threats, and maintaining regular backups. These skills are essential for 

safeguarding personal and organizational information in today’s connected world. 

Learning Objectives 

At the end of the session, learners will be able to:  

 Manage user account. 

 Assign appropriate roles, permissions, and enable MFA for security. 

 Monitor activity and maintain updated recovery options. 
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Content Outline 

1.1 Introduction to Account Management 

1.2 Security Practices 

1.3 Account Maintenance, Recovery, and Closure 

1.1 Introduction to Account Management  

Account Management refers to the processes and skills required to create, secure, maintain, and 

optimize user accounts in digital systems (e.g., email, cloud services, operating systems, and 

applications). It ensures users have the correct access to resources, data is protected, and accounts 

remain organized and functional 

Purpose of Account Management 

Why accounts are needed in digital systems: Accounts provide a unique identity for each user, 

allowing the system to store personalized settings, track activities, manage access rights, and 

ensure secure interaction with data and services. 

Role in identifying and authenticating users: Accounts help the system recognize who is trying to 

access it (identification) and verify that they are indeed the rightful user (authentication), often 

through passwords, PINs, biometrics, or security tokens 

Types of Account Management: Here is the summary of personal, organizational, shared account, 

and administrative account management, and their purpose with examples.  

Type Purpose Examples Best Practices 

Personal Account 

Management 

For individual services 

and personal use 

Gmail, Facebook, 

LinkedIn 

Use strong & unique 

passwords, enable 

MFA, avoid for work 

tasks 
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1.2 Security Practices  

 Creating strong passwords: Use long, complex, and unpredictable passwords combining 

letters (upper & lower case), numbers, and symbols to make guessing or brute-force attacks 

difficult. 

 Using password managers: Tools that securely store and organize passwords, allowing 

users to create unique, 

complex passwords without 

needing to remember them all. 

Google Password Manager 

manages your saved 

passwords in Android or 

Chrome. whereas there are 

other tools, such as NordPass, 

1Password, and RoboForm are exceptional password managers that offer great value, 

robust security, and user-friendly interfaces. 

Workplace/Enterprise 

Account Management 

Managed by the 

organization’s IT for 

business operations 

Microsoft 365, 

ERP systems, 

corporate email 

Follow company 

policies, keep 

credentials private, 

report suspicious 

activity 

Shared Account 

Management 

Accessed by multiple 

authorized users for 

collaboration 

Shared Dropbox 

folders, team 

social media 

accounts 

Limit access, use a 

password manager, 

track activity logs 

Administrative Account 

Management 

Full control over systems, 

settings, and user 

permissions 

Windows 

Administrator, 

domain admin 

accounts 

Use only when needed, 

secure with MFA, 

maintain usage logs 

Table 5 Account type, example, and best practice 

Figure 93: Multi-factor authentication 
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 Multi-Factor Authentication (MFA): Adds extra verification layers beyond a password 

(e.g., SMS codes, authentication apps, biometrics) to ensure that only the legitimate user 

can access the account. These factors typically fall into three categories:  

o Something you know (like a password or PIN),  

o Something you have (such as a phone or hardware token), and  

o Something you are (like a fingerprint or other biometric data).  

MFA supports protecting your password even if it is stolen. 

 Keeping recovery options updated: Regularly check and update email addresses, phone 

numbers, and security questions linked to accounts to ensure account recovery is possible 

if access is lost. 

Profile Customization  

 Adding a profile picture, contact information, and preferences: Personalizes the account, 

makes it easier for others to recognize and contact the user, and tailors the system 

experience according to user preferences. 

 Importance of keeping profiles professional in workplace accounts: Maintains a positive 

and credible image, supports professional communication, and ensures appropriate 

representation within the organization or with clients. 

1.3 Account Maintenance, recovery, and closure   

A. Account Maintenance  

1 Updating passwords regularly: Helps protect accounts from unauthorized access, 

especially if old passwords have been exposed or compromised. 

2 Reviewing account permissions and connected devices: Ensures only necessary apps, 

services, and devices have access, reducing security risks. 

3 Monitoring account activity for suspicious logins: Detects unauthorized attempts early, 

allowing timely action to secure the account and prevent potential breaches. 
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B. Account Recovery  

 Resetting passwords: Allows users to regain access when a password is forgotten or 

compromised. 

 Using recovery email/phone: Sends verification codes or links to a trusted contact method 

to securely recover the account. 

 Security questions and backup codes: Provide additional ways to verify identity and 

restore access if standard recovery methods are unavailable. 

C. Account Closure & Archiving  

 When to close an account: Close accounts that are no longer needed, unused, or pose a 

security risk. 

 Backing up important data before closure: Ensures valuable files, contacts, and settings 

are saved before losing access permanently. 

 Understanding permanent deletion vs. temporary deactivation: Permanent deletion 

removes all data and access permanently, while temporary deactivation disables the 

account temporarily, allowing future reactivation without data loss. 

Link: activity Click the Link  

 Demonstrating the process of setting up security alerts in Gmail or Outlook. 

 https://www.youtube.com/watch?v=RgFJbJFyvw0 

Exercise  

1. Create a new email account (can be demo-based). 

2. Set a secure password and enable two-factor authentication. 

3. Add an alternate recovery email and phone number. 

4. Share screenshots of each step in a training portfolio. 

Summary 
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Staying safe at this digital age is essential. Digital device users should know how to manage their 

existence and participation online. Account Management is a fundamental digital skill that 

safeguards user access, protects sensitive data, and enhances productivity. Whether for personal 

or organizational use, proper account management involves creating accounts correctly, securing 

them with strong authentication, keeping credentials up-to-date, and responsibly closing or 

archiving accounts when no longer in use. Mastering these practices ensures a safer and more 

efficient digital work environment. Besides knowing the safest online practices and maintaining 

their accounts is one skill on digital safety.  

Review Question  

Multiple choices  

1. Which of the following is an example of a cloud account? 

A. Local Windows login without internet 

B. Microsoft 365 account 

C. Calculator app settings 

D. Offline document editor 

2. The best password example is: 

A. 123456 

B. mihretu1990 

C. Sun!River#93 

D. password123 

3. Multi-factor authentication (MFA) improves account security by: 

A. Using the same password for all accounts 

B. Adding an extra verification step beyond the password 

C. Disabling password requirements 

D. Sharing credentials with team members 
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Session 2: Privacy Settings 

Introduction  

Dear learners, welcome to this session. In this session, you will explore privacy settings  

Privacy settings allow users to control who can see their information, activity, and shared content. 

Adjusting these settings helps protect personal data, manage visibility, and maintain security while 

using digital accounts. 

They are controlled within software, apps, or devices that allow you to manage who can see your 

information, how it is used, and what is shared. In productivity tools (such as Word, Excel, and 

PowerPoint) and related online services (like OneDrive, SharePoint, or email), privacy settings 

protect personal data, control access to files, and ensure compliance with workplace or legal 

standards. 

Learning Objective 

By the end of this lesson, learners will be able to: 

 Configure privacy settings in digital platforms.  

 Protect personal and work-related data.  

 Explain and demonstrate the concepts of sharing, editing permissions, and data visibility. 

Content Outline 

2.1 Privacy in Digital Tools 

2.2 privacy setting features and settings 

2.1 Privacy in Digital Tools  

Why privacy matters in productivity software: Protects sensitive data, personal information, and 

work-related documents from unauthorized access, ensuring confidentiality and compliance with 

organizational policies. 
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Risks of ignoring privacy settings: Can lead to data breaches, accidental sharing of confidential 

information, identity theft, or misuse of personal and professional data. 

Privacy Settings in Microsoft Word, Excel, and PowerPoint  

 Account and sign-in privacy options: Control how your account information is used, who 

can see your activity, and manage connected apps or services. 

 Document properties and personal information removal: Remove metadata like author 

name, comments, or editing history to protect identity and confidential information. 

 Managing sharing permissions in OneDrive/SharePoint: Set who can view, edit, or share 

files to ensure that sensitive documents are only accessible to intended collaborators. 

2.2 privacy setting features and settings  

A. General Privacy Features  

 Password-protecting files: Adds a layer of security so that only users with the password 

can open or modify documents. 

 Disabling macros from untrusted sources: Prevents potentially harmful automated scripts 

from running, reducing the risk of malware or data breaches. 

 Controlling collaborative editing and version history: Manages who can edit documents 

and tracks changes, ensuring accountability and protecting sensitive information from 

unauthorized modifications. 

B. Types of Privacy Settings 

 File-Level Privacy: Who can open, edit, or copy a document. 

 Account-Level Privacy: Control over your Microsoft/Google account data. 

 Collaboration Privacy: Permissions for shared workspaces and team editing. 

 Device Privacy: Settings that control app access to the microphone, camera, and location 

when using productivity tools online. 

C. Best Practices for Privacy  
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 Regularly reviewing privacy preferences: Ensures settings stay up-to-date with changing 

needs and helps protect personal and organizational data. 

 Using “View only” or “Restricted Access” modes: Limits what collaborators can do, 

preventing unauthorized editing or sharing of sensitive files. 

 Enabling multi-factor authentication (MFA) for account protection: Add an extra security 

layer, making it harder for unauthorized users to access accounts even if passwords are 

compromised. 

Exercise 1: 

You are preparing a confidential financial report in Excel for your company’s internal use. Before 

sending it to the manager, you: 

1. Remove hidden personal author information. 

2. Save the file with a password. 

3. Share it via OneDrive with “View only” permission so no one can edit it without approval. 

Exercise 2: 

Open an existing document in Word. 

 Access File → Info → Inspect Document to remove personal information. 

 Save the file with a password. 

 Share it with a colleague using “Can View” rights only. 

Exercise 3: 

Practice: Go to Facebook privacy settings and limit profile visibility 

Summary 

In this session, you learned that privacy settings help protect your personal and work-related 

information by controlling who can see, edit, or share your files. Adjusting privacy settings in tools 

like Microsoft Word, Excel, PowerPoint, and OneDrive helps prevent unauthorized access and 
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data misuse. You also explored how to remove personal details from documents, use passwords 

for protection, and manage sharing permissions to keep files secure. Understanding file-level, 

account-level, and collaboration privacy ensures you can safely work and share in digital 

environments. Regularly reviewing privacy settings, using “View only” options, and enabling 

multi-factor authentication are essential habits for maintaining security and confidentiality online. 

Review Questions 

Multiple Choices  

1. Which privacy feature prevents unauthorized users from editing your document? 

A. Track Changes 

B. Password Protection  

C. Spell Check 

2. What does “Inspect Document” do in Microsoft Word? 

A. Checks for spelling errors 

B. Removes personal metadata  

C. Translates the document 

3. True or False: Once you share a document with “Can Edit” permission, you can change it to 

“View only” later. 
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Session 3: Identify Common Threats 

Introduction 

Dear learners, welcome to this session. In this session, you will explore identifying common 

Threats  

Recognizing phishing, malware, social engineering, and other cyber threats. In the digital world, 

threats are risks or dangers that can harm devices, data, or users. These threats may be intentional, 

such as hacking, or unintentional, like accidental data loss. Understanding common threats is 

essential for protecting personal information, maintaining system integrity, and ensuring safe 

online activities. 

Learning Objective 

By the end of this lesson, learners will be able to: 

 Define and recognize different types of digital threats and their sign. 

 Apply preventive measures to reduce the risk of threats. 

Content Outline 

3.1 Digital Threats and Their Types  

3.2 How to Prevent Threats  

3.1 Digital Threats and their signs  

Digital threats refer to any dangers or malicious activities that target digital systems, devices, 

networks, or data. These threats can disrupt operations, steal sensitive information, or damage 

systems.  

 Common Signs of a Threat 

Common signs of a digital threat include signs related to your computer system, signs related to 

accounts and access, and signs related to network and internet connectivity  
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Signs on Your Computer/System  

 Slow performance: Your computer or network may run significantly slower than usual. 

 System crashes: Frequent, unexplained shutdowns or crashes. 

 Unexplained changes: Unauthorized changes to your system & security settings, or 

installed programs. 

 Unknown programs or files: The appearance of unfamiliar applications or files on your 

device. 

 Strange pop-ups: Unexpected pop-up messages, security alerts, or warnings. 

 Encrypted files: Files that are inaccessible and may have an unusual file extension, 

indicating a potential ransomware attack. 

Signs Related to Accounts & Access 

 Locked accounts: Being locked out of your accounts without reason.  

 Password changes: Your password is being changed without your knowledge.  

 Inaccessible files: You may find you can no longer access certain documents or files.  

 Unauthorized access alerts: Notifications of unauthorized attempts to log in or access your 

accounts.  

Signs in Network & Internet Activity 

 Unusual network activity: High data usage or unusually slow network performance.  

 Redirected internet searches: Being redirected to unexpected websites when you try to 

search the internet.  

 Strange emails: Emails coming from your domain that you didn't send, or emails asking 

for sensitive information.  

 Automatic email sending: Emails are being sent automatically from your account without 

your knowledge.   

 They come in many forms, and understanding them is essential for cybersecurity. 
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 Man-in-the-Middle (MitM) Attack: An attacker secretly intercepts and relays 

communication between two parties who believe they are directly communicating with 

each other. Such as: Using an unsecured public Wi-Fi network, where an attacker can see 

the data you send and receive. 

 Denial-of-Service (DoS) / Distributed Denial-of-Service (DDoS) Attack: 

o DoS: Flooding a target server with so much traffic that it cannot function & goes 

offline. 

o DDoS: A larger attack where the flood of traffic comes from many compromised 

computers (a "botnet") simultaneously. This is extremely difficult to stop. 

 SQL Injection (SQLi): An attack on a web application. Attackers insert malicious code into 

a website's search box or login form. If the website is poorly designed, this code can trick 

the database into revealing sensitive data (like user passwords). 

 Zero-Day Exploit: An attack that targets a software vulnerability that is unknown to the 

software vendor. This means there is no patch available, making the attack highly 

dangerous until the vendor can create and release a fix. 

 Advanced Persistent Threat (APT): A prolonged, targeted attack where an intruder gains 

access to a network and remains undetected for a long period. The goal is usually to steal 

data over time, not cause immediate damage. Often conducted by nation-states or highly 

organized criminal groups. 

Concept Name Simple Explanation Real-World Analogy 

DDoS Attack 

Overwhelming a website 

with fake traffic to knock 

it offline. 

A mob is blocking the entrance to 

a store so legitimate customers 

can't get in. 

Zero-Day 
Attacking a secret flaw 

before a fix exists. 

A thief discovers a unique, 

unknown flaw in a bank's alarm 

system. 

MFA/2FA 
You need two proofs of 

identity to log in. 

You need both a key (something 

you have) and a code (something 

you know) to enter a building. 

Table 6: Real-world Examples of Attacks 
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3.2 How to Prevent Threat  

Preventing a breach of your network and its systems requires protection against a variety of cyber-

attacks. For each attack, the appropriate countermeasure must be deployed/used to deter it from 

exploiting a vulnerability or weakness. 

 Disconnect: Immediately disconnect the device from the internet (Wi-Fi and Ethernet) to stop 

data theft or the spread of malware. 

 Scan for Malware: Use a reputable antivirus/antimalware program to run a full system scan. 

 Change Passwords: On a clean device, change the passwords for any compromised accounts 

(and any accounts that used the same password). Enable Multi-Factor Authentication 

(MFA/2FA) everywhere possible. 

 Check Accounts: Review your bank and credit card statements for fraudulent charges. 

Consider placing a fraud alert on your credit. 

 Update and Restore: Update your operating system and all software. If the infection is severe, 

you may need to restore your system from a clean backup or completely wipe and reinstall 

the OS. 

 Report: Report phishing attempts to your IT department and the legitimate company being 

impersonated. Report fraud to your bank and the relevant authorities. 

 Staying vigilant and recognizing these signs early can significantly reduce the damage from a 

digital threat. 

Threat Type Example Techniques Primary Mitigations 

Malware Ransomware, spyware Antivirus, restricted admin rights 

Social Engineering Phishing, whaling Employee training, MFA 

DDoS Attacks 
HTTP floods, SYN floods 

(Synchronous flood) 
Firewalls, traffic filtering 

Insider Threats Data theft, sabotage Activity monitoring, access controls 
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Threat Type Example Techniques Primary Mitigations 

Password Attacks Brute-force, dictionary Strong passwords, account lockouts 

Supply Chain 

Attacks 
Compromised updates Vendor vetting, code signing checks 

Data Breaches 
Unauthorized 

access/sharing 

Encryption, Data Loss Prevention 

(DLP) tools 

Table 7: Summary on Cyber Threats and Primary Mitigations 

Practice: Review sample phishing emails and mark suspicious indicators. 

Summary 

Digital threats are dangers that can harm your devices, steal your information, or disrupt your 

online activities. Common threats include malware, phishing, unsecured networks, and insider 

attacks. Recognizing the signs of a threat and applying prevention strategies such as using security 

tools, maintaining strong passwords, and staying vigilant online can greatly reduce risks. 

Awareness and proactive habits are the strongest defense. 

Review Questions 

Multiple choices   

1.  Ideally, when should passwords be changed? 

A. Only when an account is compromised 

B. Every day 

C. Every 30-90 days 

D. Never 

2. What is implemented to carry out distributed DDoS attacks, steal data, and send spam 

messages, and permits the hacker to access various devices and their connection? 

A. Trojan 

B. Virus 

C. Botnet 

D. Worm 
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3. What does two-factor authentication (2FA) provide when logging into an application or 

service? 

A. A Single Password Verification 

B. An additional verification through a separate channel 

C. No additional security measures 

D. Automatic password changes 

4.  Which statement best describes the relationship between 2FA and overall security strategy? 

A. 2FA should be the only security measure used. 

B. 2FA is more effective when combined with other security tools and policies. 

C. 2FA is outdated and not necessary anymore 

D. 2FA is only useful for social media accounts. 

5. Which of the following is a technique in which malicious code is inserted into strings that are 

passed to an SQL query? 

A. SQL Malware 

B. SQL Injection 

C. SQL Hijack 

D. SQL Trojan 
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Session 4:  Secure Practices 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Secure practice  

Secure practices refer to the safe and responsible use of productivity software and digital tools to 

protect data, devices, and user privacy. This includes safeguarding documents, applying access 

controls, managing sensitive information, and preventing unauthorized use or data loss. In 

advanced productivity software usage, secure practices ensure that work is not only high quality 

but also protected from cyber risks, accidental leaks, and unauthorized edits. 

Learning Objective 

By the end of this lesson, learners will be able to: 

 Apply software-specific security features to protect files and data. 

 Practice safe sharing, backup, and version control habits. 

 Use password protection, encryption, and restricted editing effectively. 

Content Outline 

4.1 Security Practice in Productivity Tools 

4.2 Advanced Security Tools 

4.1 Security Practice in the Information Age 

In today’s digital world, information has become one of the most valuable assets. However, with 

increased connectivity and data sharing come greater risks. Before exploring security practices, it 

is important to understand key security concepts such as data threats, the value of information, 

personal security, and file security. Data threats refer to the risks and attacks that can compromise 

or damage information. Recognizing the value of information helps users understand why 

protecting it is essential. Personal security focuses on safeguarding individual identities and digital 

activities, while file security ensures that stored or shared files remain safe from unauthorized 
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access or loss. Understanding these concepts lays the foundation for adopting effective security 

practices in the information age. 

File Protection Features 

 Password-protecting documents: Restricts access to authorize users only. 

 Setting file permissions: Controls who can view, edit, or share files. 

 Restricting editing in Word: Limits modifications to specific sections or users, preserving 

document integrity. 

Data Privacy Measures 

 Removing personal metadata: Deletes author info, comments, and document history to 

protect identity. 

 Protecting sensitive data in Excel: Use masking, hiding cells, or locking sheets to prevent 

accidental or unauthorized access. 

Safe Sharing Practices 

 Secure cloud sharing vs. email attachments: Cloud sharing allows controlled access and 

tracking, reducing the risk of leaks compared to email attachments. 

 Version control and change tracking: Keeps a record of edits, enabling rollback if 

mistakes or unauthorized changes occur. 

Backup and Recovery 

 AutoSave and version history – Automatically saves changes and keeps previous 

versions to recover from errors. 

 Local and cloud backups – Provides redundancy to protect against hardware failure or 

data loss. 

4.2 Advanced Security Tools 

 Configuring Firewall: Allow or deny incoming and outgoing data based on configured 

rules 
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 File encryption options: Converts files into unreadable formats for unauthorized users. 

 Digital signatures in documents: Verifies document authenticity and confirms that 

content has not been altered. 

Firewall  

 A firewall is a network security system that acts as a barrier between a trusted network, 

such as a private internal network, and an untrusted network, like the internet. 

  It monitors and controls incoming and outgoing network traffic based on predefined 

security rules, selectively allowing or blocking data packets to prevent unauthorized 

access and malicious activity. 

  Firewalls can be either software programs or dedicated hardware. 

 

Basic features of a firewall: 

1. Packet Filtering – Inspects incoming and outgoing packets, allowing or blocking them 

based on rules (e.g., source/destination IP, port, protocol). 

2. Stateful Inspection – Tracks the state of active connections and decides whether packets 

are part of a valid session. 

3. Proxy Service – Acts as an intermediary between users and the internet, masking internal 

addresses and providing content filtering. 

4. Network Address Translation (NAT) – Hides internal IP addresses by translating them 

into a public IP, adding a layer of security. 

5. Access Control – Defines which users, devices, or applications are allowed or denied 

access to certain network resources. 

6. Logging and Monitoring – Keeps detailed records of traffic, including attempts to 

breach the network, which helps in auditing and threat detection. 

7. Intrusion Detection/Prevention (IDS/IPS) Integration – Identifies suspicious activities 

and may block malicious traffic in real time. 

8. VPN Support – Enables secure remote connections through encrypted tunnels. 

9. Application Layer Filtering – Inspects traffic at the application level (e.g., HTTP, FTP) 

to block malicious content or unauthorized usage. 
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10. Alerts and Notifications – Notifies administrators when potential threats or unusual 

traffic patterns are detected. 

Accessing firewall  

 To access the Windows Firewall basic settings 

1.  Type Windows Firewall in the search box and  click  on the Windows Firewall app 

2. Click on Windows Firewall on or off   

3. Click on Turn on or Turn off to change settings (Private, or Public) and click ok button 

 Use the Advanced settings to create custom inbound and outbound rules for specific 

applications or ports 

 

 

 

 

 

 

 

 

 

 

 

 

 

Firewall Rules  

Inbound Rules (Traffic Coming In) 

• Purpose: To prevent unauthorized access to your device from the internet or other 

networks.  

• Default Behavior: Blocks any inbound traffic that doesn't match an existing "Allow" 

rule.  

2 
3 

1 

Table 8 Firewall settings 

https://www.google.com/search?sca_esv=c4a0913eaf92f181&cs=0&sxsrf=AE3TifNtehf5xGQmfwn0PCAds9SBKlVoBQ%3A1757051546334&q=inbound+and+outbound+rules&sa=X&ved=2ahUKEwj4lpSK98CPAxXYQ6QEHRf1HtAQxccNegQIAxAB&mstk=AUtExfB0rmP_rETKpmFt5udjfdE8mqdO9_yY80dW958Ehybd9E5Ehp1DZ-29BUU-dG4cFDKHp1tRMbyl868_AQ-ZZS-ogK40NNX7l685utlY7INURMVUPpvnZoiSiio6O0KsiC256H8D1jjDAlwjTg8XkNP3TMSPA3kUCrTJLDxH5DgEP2Q&csui=3
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• Example Use: You might create an inbound rule to allow specific remote desktop 

connections or incoming data for a particular application.  

• Outbound Rules (Traffic Going Out) 

• Purpose: To control which applications or services can send data from your device to 

external networks.  

• Default Behavior: Allows all outbound traffic by default.  

• Example Use: In a highly secure environment, you could block all outbound traffic 

and then create specific "Allow" rules for particular applications or URLs to control 

which services can connect to the internet.  

Steps to Manage Rules (using wf.msc) 

1. Press the Windows key + R to open 

the Run dialog box.  

2. Type wf.msc and press Enter to 

open Windows Firewall with 

Advanced Security.  

3. In the left pane, click on either 

Inbound Rules or Outbound Rules.  

4. To create a new rule, click New 

Rule... in the Actions pane on the 

right.  

5. Follow the wizard to select the rule 

type (e.g., Program, Port), specify 

the protocol (TCP/UDP), the local 

and remote ports/addresses, the 

action (Allow or Block), and the 

profiles the rule applies to (Domain, 

Private, Public networks).  
 

Practical Scenarios 

 Protecting financial reports: Apply strong passwords, restrict editing, and control 

sharing to safeguard sensitive numbers. 

Figure 94 Windows Firewall advanced Security 
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 Securing confidential presentations: Use encryption, manage access permissions, and 

track versions to maintain confidentiality during collaboration. 

Types of Secure Practices 

 Password Protection (Word, Excel, PowerPoint file-level security) 

 Restricted Editing (Track Changes, lock sheets, limit slides edits) 

 Data Encryption (Secure sensitive business data) 

 Safe Sharing & Permissions (OneDrive, SharePoint, Teams access controls) 

 Backup & Recovery (Offline and online backup systems) 

Exercise:  Protecting a Confidential Excel Report 

Step-by-step Example: 

1. Open the Excel file. 

2. Go to File → Info → Protect Workbook. 

3. Choose Encrypt with Password and set a strong password. 

4. Hide sensitive sheets (Right-click → Hide). 

5. Lock important cells (Format → Lock Cell + Protect Sheet). 

6. Save the file and share via a secure cloud link with “View Only” permission. 

Exercise 

Scenario: You are preparing a company salary report in Excel. 

o Secure by adding a password. 

o Hide columns containing personal information. 

o Share only with HR staff via a secure link. 

Exercise 

1. In Word: Create a short confidential agreement and restrict editing so only comments can 

be added. 
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2. In Excel: Prepare a budget spreadsheet and lock all formula cells. 

3. In PowerPoint: Create a presentation and set a password for opening. 

Summary 

Secure practices in productivity software involve protecting files, controlling access, securing 

sensitive data, and ensuring safe sharing. By using built-in security tools such as passwords, 

encryption, restricted editing, and version control, professionals can safeguard work from 

unauthorized access and accidental loss. These skills are essential for maintaining data 

confidentiality, integrity, and availability in modern digital work environments. 

Careful practice Practice: Enable browser HTTPS-only mode, create a backup on external drive. 

Review questions  

Multiple Choices  

1. Which of the following is NOT a secure practice? 

A. Password protecting files 

B. Sharing unprotected files over public Wi-Fi 

C. Restricting editing in Word 

D. Encrypting sensitive Excel sheets 

2. Hiding a sheet in Excel without protecting it is a secure way to keep data safe. (True/False) 

3. Name two advantages of using digital signatures in Word or Excel. 
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Module 6: Problem-Solving 

Introduction  

In our digital world, problems with software, networks, and applications are common and can 

disrupt everyday activities. Users should know these problems and solve them accordingly.   

Problem-solving in digital literacy refers to the ability to identify, analyze, and resolve issues that 

arise when using digital technologies, devices, applications, or online resources. It’s not just about 

fixing technical errors—it also includes making decisions, finding reliable information, adapting 

to new tools, and applying critical thinking in digital environments. This module focuses on 

helping you understand and fix these issues so that your devices and applications run smoothly. 

First, we will explore common software problems, their symptoms, and practical troubleshooting 

methods to resolve them. Then, we will move on to network and application issues, learning how 

to identify causes of connectivity failures or app malfunctions and apply the right solutions. 

By the end of this module, you will have the skills to recognize, diagnose, and fix frequent digital 

problems, making you more confident and independent in managing your devices. 

Session 1:  Resolving software issues 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Resolving software issues 

Software is the most susceptible part of the computer system to corruption or damage due to many 

reasons (power failure, improper shutdown). So resolving software issues is critical. This session 

introduces you to common software issues of digital devices, their symptoms, and resolving 

mechanisms. Let’s start our journey. 

Software issues are the most frequent problems of digital devices that affect our digital lives. So 

let’ start with a few questions to explore your experience. 

 What do you think about your device being slow after a few days of normal use? 

 Do you have experience with the problems of not responding in your device's app and 

how you fix it?  
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 Do you have any experience with mobile apps that are not installed on your device? 

This session provides you with the basic skills of identifying symptoms of common software 

problems and the mechanisms of how to solve these problems. Let’s start our journey.    

Learning Objectives 

At the end of this session, learners/trainees will be able to: 

 Explain the common software problems of digital devices 

 Identify common symptoms of software problems and fix software problems  

Contents outline  

1.1 Common Software-Related Problems  

1.2  Troubleshooting techniques/ common symptoms of software problems and their solutions 

1.1 Common Software-Related Problems  

Software-related problems are issues that occur in a computer or digital device due to 

malfunctions, bugs, misconfigurations, or incompatibilities within the software (the programs and 

operating systems) rather than the hardware. The most common software-related problems of 

digital devices are listed below: 

1. Operating system errors  

 Blue Screen of Death (Windows) 

 System freezing or random restarts 

 Boot loops or device stuck on startup 

2. Application crashes or freezes 

 Apps not opening at all 

 Apps closing unexpectedly during use 
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3. Performance problems 

 Slow startup or sluggish operation and lag in games or video playback 

4. Compatibility issues  

 Software not working after OS update 

 Older apps incompatible with new hardware or OS versions 

5. Network & connectivity problems 

 Wi-Fi not connecting or frequently disconnecting and Bluetooth pairing failures 

 Slow internet caused by misconfigured settings 

6. Update failures  

 OS updates not installing correctly and app updates stuck or failing in app stores 

7. Security & malware infections 

 Pop-ups, unwanted ads, or strange programs appearing 

 Ransomware or viruses causing file loss or lockouts 

8. Corrupted files or settings 

 Files failing to open due to corruption 

 System settings or registry errors causing malfunction 

9. Storage & file system errors 

 Insufficient storage preventing installations 

 Disk read/write errors or bad sectors 

10. Driver/software conflicts 

 Hardware not functioning because of outdated or incompatible drivers 
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 Printer, webcam, or audio devices not detected 

 

Scenario:  

Sara opens Microsoft Word to finish her report, but the program keeps freezing and won’t 

respond. How does she solve the problem? 

Software Problem Possible Cause Possible Solution 

Slow performance Too many background apps, 

low storage, malware 

Close unused apps, free up storage, run 

an antivirus scan 

App not 

responding/freezing 

Software bug, low RAM, 

corrupted files 

Force close and restart the app, update 

or reinstall it 

The operating system is 

not booting 

Corrupted system files, 

failed update 

Use system repair tools (Windows 

Recovery / macOS Recovery), restore 

from backup 

Frequent crashes / Blue 

Screen 

Driver issues, incompatible 

software 

Update drivers, uninstall conflicting 

apps, run diagnostics 

Unable to install 

software 

Insufficient permissions, 

low storage, compatibility 

issues 

Free storage, run as administrator, 

check system requirements 

Internet not connecting Network misconfiguration, 

driver issues 

Restart router, reset network settings, 

update network drivers 

Printer not working Missing/corrupt driver, 

wrong settings 

Reinstall printer driver, check 

connections, and set as default printer 

File won’t open File corruption, 

unsupported format 

Use file repair tools, try compatible 

software 

Pop-ups or strange apps 

appearing 

Malware infection Run an antivirus/antimalware scan, 

uninstall unknown apps 

Update fails repeatedly Network issues, insufficient 

space, corrupted update 

files 

Ensure stable internet, free up space, 

and clear update cache 

Table 9 Common software problems on digital devices and their solutions 
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Steps Taken: 

1. She presses Ctrl + Alt + Delete and opens Task Manager. 

2. She selects Microsoft Word → End Task to close the frozen app. 

3. She restarts Word — the same problem happens again. 

4. She checks for updates in Office settings or CD/USB drive and installs the latest version. 

5. After restarting her computer, Word runs smoothly without freezing. 

Learning Points:  

 Use Task Manager to close unresponsive programs. 

 Software updates often fix bugs and improve performance. 

 Restarting helps apply fixes and clear temporary issues. 

1.2 Troubleshooting/Resolving Techniques method  

Device troubleshooting is not a random task; rather, it is a systematic process that starts from 

external to internal and from simple to complex problems. 

1. Identify and define the problem 

 Note exactly what’s wrong (error messages, crashes, slow performance, missing features). 

 Determine when the issue started and anything changed (new software, updates, or change 

settings). 

II. Check for simple causes first 

 Restart the device — many temporary issues clear after a reboot. 

 Close unnecessary apps or processes that might be using too many resources. 

 Ensure cables, accessories, or network connections are working. 

III. Verify software is up to date 

 Check for OS updates (Windows Update, mac OS Software Update, Android/iOS updates) 

and Update the specific app or program from its official source. 
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IV. Scan for malware or unwanted software 

 Run antivirus/antimalware scans (Windows Defender, Malware bytes, etc.). 

 Remove or quarantine threats found. 

V. Check compatibility 

 Make sure the software is compatible with your OS version and hardware. 

 Look up system requirements from the developer’s site. 

VI. Adjust settings or preferences 

 Reset app preferences or settings to default. 

 Check for misconfigured network, display, or security settings. 

 Change only one device or setting at time   

VII. Reinstall or repair the software 

 Uninstall the problematic app completely, and then reinstall it from the official site/store. 

 For Windows, you can also use “Repair” if available in Apps & Features. 

VIII. Use built-in troubleshooting tools 

 Windows: Settings → Update & Security → Troubleshoot. 

 macOS: Disk Utility → First Aid or Safe Mode. 

 Mobile: Safe Mode or reset network/app settings. 

IX. Restore to a previous state (if recent changes caused the issue)  

 Windows: Use System Restore / Windows Recovery. 

 macOS: Restore from Time Machine backup. 

 Mobile: Roll back to a stable OS version if supported. 

X. Seek expert or official support 
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 Check the developer’s support page or user forums. 

 Contact technical support if the issue persists. 

Best Practices 

 Keep software updated. 

 Avoid installing apps from untrusted sources. 

 Back up important data before major changes. 

 Document solutions for future reference. 

Scenario: Wi-Fi Connection Problem 

Abel tries to connect his laptop to the school’s Wi-Fi, but it says “No Internet Connection.” 

Steps Taken: 

1. He checks if Wi-Fi is turned on 

2. He notices other students are connected, so the network is fine. 

3. He runs the Windows Network Troubleshooter, which reports “Incorrect IP 

configuration.” 

4. Abel selects Forget Network, then reconnects and enters the correct password. 

5. The laptop connects successfully and the internet works again. 

Learning Points: 

 Check if the problem is with the device or the network. 

 The Network Troubleshooter can automatically fix common issues. 

 Reconnecting can refresh network settings and solve IP conflicts. 

Summary  

Most commonly, software problems stem from low resources, corrupted files, software 

incompatibility (software/drivers), misconfigurations of settings, storage or file system errors, and 

malware infections. To solve these problems, different troubleshooting techniques are applied such 

as closing unused apps, freeing storage, updating/reinstalling software or drivers, repairing system 

files, resetting settings, and running antivirus scans 
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Review questions 

1. What are common causes of frequent crashes or Blue Screen errors? 

2. What are possible reasons why a printer is not working? 

3. How can you open a file that is corrupted or in an unsupported format? 

4. What should you do if pop-ups or strange apps appear unexpectedly? 

5. What are the possible causes of slow performance in digital devices 
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Session 2: Troubleshoot network and application problems 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Troubleshooting network 

application problems  

Troubleshooting network and application problems involves identifying, diagnosing, and resolving 

issues affecting connectivity or software performance. Network and application problems should 

be able to identify the causes, apply appropriate solutions, and verify that systems are functioning 

important. This includes using diagnostic tools, updating software, and managing settings to maintain 

reliable network and application operations. 

Learning Objectives 

 Identify common causes of network issues on digital devices and troubleshoot. 

 Identify common causes of application problems on the network and troubleshoot. 

Content Outline: 

      2.1 Common causes of network problems and their solutions 

      2.2 Troubleshooting Application issues on networking 

2.1 Common causes of network problems and their solutions: 

Have you ever had your internet fail right before a deadline or online class? What did you do first? 

If your device can’t connect to the internet or has slow speeds, don’t panic the solution might be 

simpler than you think. 

Troubleshooting the network on digital devices involves identifying and fixing connectivity 

problems affecting computers, smartphones, smart TVs, and other gadgets. 

It includes checking hardware, network settings, and software to restore stable internet access. 

The process ensures smooth communication, data transfer, and online activities. 
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I. Computer Network Configuration Issues & Solutions   

Network configuration issues occur when devices fail to connect or communicate properly within 

a network due to incorrect settings, faulty hardware, or software conflicts. 

Understanding common problems and solutions helps maintain seamless internet and intranet 

connectivity. 

Table 10: Common Network Configuration issues 

No Issue Description Possible Causes 

1 Incorrect IP 

Configuration 

The device has the wrong IP 

settings. 

DHCP server error, manual 

misconfiguration, static IP conflicts. 

2 DNS Configuration 

Errors 

Unable to translate domain 

names to IP addresses. 

Wrong DNS server address, DNS 

server down. 

3 Gateway 

Misconfiguration 

The device can’t connect 

outside the local network. 

Wrong default gateway address. 

4 Network Adapter Issues Hardware or driver problems. Outdated/missing drivers, disabled 

adapter. 

5 Firewall or Security 

Settings 

Network access blocked. Overly restrictive firewall rules. 

6 Duplicate IP Addresses Two devices share the same IP. Static IP conflicts, DHCP 

mismanagement. 

7 Wireless SSID & 

Password Issues 

Unable to connect to Wi-Fi. Incorrect credentials, hidden SSID. 

II. Router Problems and Solutions 

A router is a key device that connects digital devices to the internet and local networks. 

Common router problems include no internet connection, slow speed, or frequent disconnections. 

These issues can often be solved by restarting the router, checking cables, updating firmware, or 

adjusting network settings. 

 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [202]                                 October, 2025 

Table 11: common Router problems and solutions 

No Problem Possible Cause Solution 

1. No Internet 

Connection 

ISP outage, router 

malfunction, or loose cables. 

- Check if other devices have internet. 

- Restart router and modem. 

- Contact ISP if the outage persists. 

2.  

 

Slow Internet 

Speed 

Too many connected 

devices, an outdated router, 

and interference from walls 

or other electronics. 

- Limit active devices. 

- Move the router to a central location. 

- Use a wired Ethernet connection for critical 

devices. 

- Upgrade router or plan if needed. 

3. Frequent 

Disconnections 

Overheating router, 

firmware bugs, and network 

congestion. 

- Keep the router in a cool, ventilated place. 

- Update router firmware. 

- Change Wi-Fi channel to avoid interference. 

4. Weak Wi-Fi 

Signal 

The router is too far from the 

device, with thick walls 

blocking the signal. 

- Relocate the router or device closer. 

- Use Wi-Fi range extenders or a mesh network. 

5. Can’t Connect to 

 Wi-Fi 

Wrong password,  MAC 

address filtering, or device 

blocked by the router. 

- Re-enter the correct password. 

- Disable MAC filtering or add the device to the 

allowed list. 

- Restart both the device and router. 

6. Router Keeps 

Restarting 

Power supply issues, 

overheating, and faulty 

hardware. 

- Check the power adapter. 

- Place the router in an open, ventilated space. 

- Replace the router if the hardware is faulty. 

9. Unable to 

Access Router 

Settings 

Wrong IP address or 

forgotten admin credentials. 

- Check default gateway IP (e.g., 192.168.1.1). 

- Reset the router to factory settings if the 

password is lost. 

III. Wi-Fi Connectivity Problems & Solutions 

Wi-Fi connectivity problems occur when a device cannot connect to a wireless network or 

experiences unstable internet performance. These issues may be caused by incorrect settings, weak 
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signals, interference, or hardware/software malfunctions. Troubleshooting these problems is a key 

digital literacy skill for ensuring smooth communication and access to online resources. 

No Problem Description Possible Causes 

1 No Wi-Fi Network 

Detected 

The device can’t find the 

network 

Router turned off, SSID hidden, out 

of range 

2 Cannot connect to 

Wi-Fi 

Connection attempt fails Wrong password, network overload, 

MAC filtering 

3 Intermittent 

Connection Drops 

Wi-Fi disconnects 

randomly 

Weak signal, interference, faulty 

drivers 

4 Slow Wi-Fi Speed Pages load slowly, 

buffering 

Network congestion, outdated router, 

ISP issues 

5 Limited or No 

Internet Access 

Connected but no 

internet 

ISP outage, router config error, DNS 

issue 

6 Authentication Errors Incorrect credentials Typo in password, saved wrong key 

7 IP Address Conflicts Two devices share same 

IP 

Static IP duplication, DHCP error 

Table 12 : Common Wi-Fi Connectivity Problems and Possible Causes 

Review Questions  

1. What steps do you usually take first when your Wi-Fi connection becomes weak or 

unstable, and why? 

2. How can updating router firmware or adjusting router placement improve Wi-Fi 

connectivity at home or school? 

3. In what ways does securing your Wi-Fi network (e.g., using strong passwords) help prevent 

connectivity problems? 

2.2 Troubleshooting Application issues on networking 

Troubleshooting application software in digital devices is essential to ensure smooth and efficient 

usage. Common problems include crashes or freezing caused by bugs, outdated versions, or limited 

system resources. 

Users may also face installation/update errors, login/authentication issues, and performance 
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slowdowns. 

Additionally, compatibility issues arise when applications are not supported by the device or 

operating system. Application problems are just as frustrating. An app that freezes during an 

important task can be a major setback. 

Common Application Issues: 

 Freezing or crashing 

 Running too slowly 

 Display glitches 

Causes: 

 Outdared application 

 Insufficient storage or RAM 

 Corrupted files or settings 

 Conflicts with other apps 

Solutions: 

1. Close and reopen the application. 

2. Check for updates (Microsoft Store, App Store, and Google Play). 

3. Restart the device. 

4. Clear cache or temporary files. 

5. Uninstall and reinstall the application. 

Summary 

Troubleshooting network and application problems ensures reliable connectivity and smooth 

software use. Network issues may include no internet, slow speeds, weak Wi-Fi, or IP conflicts. 

Application problems often involve crashes, slow performance, or failure to launch. 

Solutions include checking connections, restarting devices, updating software, and using 

diagnostic tools. Regular updates, maintenance, and proper network management help prevent 

future issues. 
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Review Questions: 

1. What is the first step when a device cannot connect to a network? 

A. Update the operating system 

B. Check physical connections and cables 

C. Reinstall all applications 

D. Contact the ISP immediately 

2. If a Wi-Fi connection keeps dropping, what is a common solution? 

A. Clear browser history 

B. Restart the router and device 

C. Delete all apps 

D. Turn off device completely 

3. An application keeps crashing on a smartphone. What should you try first? 

A. Reinstall the operating system 

B. Change the Wi-Fi password 

C. Disable all network connections 

D. Update or restart the application 

4. Which action helps resolve IP address conflicts on a computer? 

A. Restart the router 

B. Block the device from Wi-Fi 

C. Clear the application cache 

D. Uninstall the operating system 

5. Why is it important to update device firmware and applications regularly? 

A. To make the device look new 

B. To improve compatibility and fix bugs 

C. To slow down performance 

D. To delete old files automatically 
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6. What is a preventive practice to avoid network and application problems? 

A. Avoid using Wi-Fi entirely 

B. Turn off the device for one week 

C. Regularly update software, clear cache, and maintain storage 

D. Only use one device for everything 
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Module 7: Career-Related Competences 

Introduction 

This module provides learners with essential knowledge in software development that is relevant 

to their careers. It places strong emphasis on understanding software development, development 

environments, programming, and programming tools. In addition to developing programming 

skills and concepts, learners will acquire the ability to work as software developers or 

programmers. 

Session 1: Software development basics 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Software Development 

Basics  

Welcome to Software Development Basics! In this session, you will explore how software is 

developed, the stages of the software development lifecycle, the different types of developers and 

the key soft skills they need, and the tools that help teams collaborate effectively, including version 

control. By the end, you’ll understand the fundamentals of software development, recognize 

developer roles, and appreciate how modern tools support efficient teamwork. 

Learning Objectives 

At the end of the session, learners will be able to: 

 Explain the concept of software development.  

 Describe the phases of the software development life cycle (SDLC).  

 Differentiate among types of software developers and identify essential soft skills.  

 Demonstrate the use of version control and collaborative tools 

Content outline 

1.1 What is software development? 
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1.2 Lifecycle of software development 

1.3 Software developers’ types  

1.4 Version control and collaboration tools 

1.1 What is software development? 

Every app, game, or website you use starts as an idea, but how does it become a reality? That’s 

where software development comes in. In this lesson, you’ll discover what software development 

is. 

The process of designing, developing, testing, and maintaining computer programs and 

applications is known as software development.  The goal of software development is to create a 

product that meets user needs and business objectives in an efficient, repeatable, and secure way. 

Software developers develop the software, which itself is a set of instructions, in order to perform 

a specific task. 

Software developers, programmers and software engineers develop software through a series of 

steps called the software development lifecycle (SDLC). Artificial intelligence-powered tools 

and generative AI are increasingly used to assist software development teams in producing and 

testing code. 

Types of software 

System software: runs the core functions of a computer, including operating systems, disk and 

hardware management, and essential utilities.. 

Programming software:  Provides tools like text editors, compilers, debuggers, and linkers for 

writing and building software programs. 

Application software (applications or apps): Helps users perform specific tasks, such as document 

editing, media playback, data management, or using web/mobile apps. 

https://www.ibm.com/think/topics/artificial-intelligence
https://www.ibm.com/think/topics/generative-ai
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Embedded software: Controls the operation of devices that aren’t traditional computers, such as 

appliances, vehicles, or industrial machines. 

Nice work! Before moving on to the next subtopic, let’s take a moment to see your progress in this 

section. 

Reflective Question: 

1. Who develops software through the software development lifecycle? 

2. What is the main goal of software development? 

1.2 life cycle of software development 

Software development life cycle (SDLC) is a structured process that is used to design, develop, 

and test good-quality software. The SDLC stages are shown below.  

 

Figure 95: Software development lifecycle 

 Planning: Define the project scope, goals, resources, and timeline. 

 Analysis:  Gather and document detailed requirements from stakeholders. 

 Design:  Create system architecture, database design, and user interface layouts. 

 Implementation: Write and integrate the actual code according to the design. 

 Testing: Verify the system for bugs, performance issues, and requirement compliance. 

 Deployment:  Release the completed software to the intended users. 

 Maintenance:  Fix issues, update features, and ensure long-term system performance. 
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Software development method  

A software development method is a structured approach to creating software, guiding how the 

SDLC is carried out. 

Common methods include: 

 Waterfall: Step-by-step, sequential process. 

 Agile: Flexible, iterative development with user feedback. 

 Scrum:  Agile framework with short work cycles (sprints). 

 Lean:  Focus on efficiency and reducing waste. 

 DevOps: Combines development and operations for continuous delivery. 

So, Modern enterprises use DevOps; practices and tools that speed up delivery of high-quality 

applications and services. 

Nice work! Before moving on to the next subtopic, let’s pause and review your progress in this 

section. 

Reflective Questions 

1. How might choosing different SDLC methods (e.g., Waterfall vs. Agile) affect the speed and 

flexibility of software development? 

2. Why is it important for software developers to follow a structured life cycle like SDLC? 

3. In what ways does DevOps improve collaboration between development and operations teams? 

1.3 Software developer types  

Have you ever wondered what different types of software developers do? Can you guess the roles 

behind the apps and websites you use every day? 

Here are the main types of software developers and they are summarized into three broad 

categories: 

1. Front-End Developer: Builds the user interface and ensures good user experience. 
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Example: Designs the Telebirr app interface that you interact with like the buttons to send 

money, check balance, or pay bills. 

2. Back-End Developer:  Handles the server, databases, and application logic behind the scenes.   

Example: Manages transactions, account balances, and security on the server. When you send 

money, the back-end ensures the correct amount is deducted and added to the recipient’s 

account. 

3. Full-Stack Developer: Works on both front-end and back-end, able to build a complete 

application. 

Example: Works on both the app interface and server logic, ensuring that what you see in the 

Telebirr app matches the real-time transaction processing happening behind the scenes. 

You can develop skills to become any of the above types of developers. Besides hard skills, 

software developers need soft skills to work well with others, solve problems, and adapt in a fast-

changing tech environment. Here are key soft skills: 

 Communication: Explaining ideas clearly to teammates, managers, and clients. 

 Teamwork & collaboration:  Working well with others, especially in cross-functional teams. 

 Problem-solving:  Thinking critically to find solutions when challenges arise. 

 Time management:  Meeting deadlines and balancing multiple tasks. 

 Adaptability & flexibility: Learning new tools, languages, or methods quickly. 

 Creativity:  Finding innovative approaches to solve problems. 

 Attention to detail:  Spotting mistakes before they cause bigger issues. 

 Patience, stay focused and motivated during challenges. 

Excellent! Before diving into the next subtopic, let’s check how well you’ve grasped this section. 

Reflective questions: 

It is obvious that you have understood the above lesson. So before move to another topic try to 

answer the below questions. 
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1. Which soft skill areas do you feel you need to improve to become an effective software 

developer? 

2. Telebirr is launching a new feature that allows users to pay utility bills directly from the app. 

The interface needs to be intuitive, while the server must handle payments accurately and 

securely. 

Who is mainly responsible for designing the app interface? 

A) Back-End Developer 

B) Front-End Developer  

C) Full-Stack Developer 

D) All  

1.4 Version control and collaboration  

Have you heard about or experienced a version control system? Take 3 minutes to think about 

those version control systems? 

If you experience it, that is great. So, Version control, also known as source control, is the practice 

of tracking and managing changes to software code. Version control systems are software tools 

that help software teams manage changes to source code over time. 

What does it? 

A. Version Control  

A Version Control System (VCS) tracks changes by recording every edit, addition, or deletion in 

files, ensuring that all modifications are documented. It stores history by keeping snapshots of the 

project at different points in time, allowing developers to see the evolution of the work. It also 

enables collaboration, allowing multiple people to work on the same project simultaneously 

without overwriting each other’s changes. Additionally, it supports rollback, making it possible to 

revert to a previous version if something goes wrong. 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [213]                                 October, 2025 

i. Types of VCS 

 Local VCS: Stores version history only on the local computer. 

Example: RCS (Revision Control System). 

 Centralized VCS: Stores versions on a central server.  Users check out files and check 

them back in. 

Example: Subversion (SVN). 

 Distributed VCS: Each user has a full copy of the repository, including history. Enables 

offline work and easy branching/merging. 

Example: Git, Mercurial.  

ii. Popular VCS Tools 

 Git (most widely used today, supports branching, merging, distributed workflows) 

 SVN (centralized) 

 Mercurial (distributed, Git alternative)  

B. Collaborative software development 

Have you thought of how exactly collaboration affects software development?  

Let’s take a look at what makes collaboration work in software development. 

Collaboration is a key pillar of success in software development; sharing knowledge while 

distributing responsibilities has become essential within the team.  

So to make it clear, Collaborative software development is the process where multiple developers 

(often across different locations) work together to design, build, test, and maintain software. Here 

are the most popular tools for development: 
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Figure 96: Github icon 

GitHub:  A cloud platform that hosts Git repositories online. It Let’s you store your Git projects 

on the internet, share them, and collaborate with others. For access, use: https://github.com/ 

 

Figure 97: GitLab icon 

GitLab: Another Git-based platform for hosting repositories, similar to GitHub.  Also stores Git 

projects online, but is especially known for its built-in DevOps tools. To access the gitlab, use:  

https://about.gitlab.com/ 

Key Steps in Collaboration with GitHub 

1. Create or Fork a Repository 

o The main project owner creates a repository or team members fork it to make their own 

copy. 

2. Clone the Repository 

o Download the repository to your local computer using 

o git clone <repo-url> 

3. Work in Branches 

o Create a separate branch for new features or fixes: 

o git checkout -b feature-name 

4. Commit Changes 

o Save changes locally: 

o git add. 

o git commit -m "Description of change" 
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5. Push to GitHub 

o Upload branch to the shared repository: 

o git push origin feature-name 

6. Pull Requests (PRs) 

o Request to merge your branch into the main branch, allowing for code review. 

7. Code Review & Merge 

o Team members review code, discuss improvements, and approve merges. 

8. Sync Regularly 

o Keep your local project up-to-date: 

o git pull origin main 

Great job! Let’s briefly evaluate your learning progress before moving forward. 

Reflective questions: 

1. State one main advantage of collaborative software development. 

2. Match each type of VCS with its description: 

1. Local VCS 

2. Centralized VCS 

3. Distributed VCS 

a. Stores the full repository, including history, on every user’s machine 

b. Stores versions only on a local computer 

c. Stores versions on a central server and requires check-in/check-out 

Choices: 

A. 1–a, 2–b, 3–c 

B. 1–b, 2–c, 3–a 

C. 1–c, 2–a, 3–b 

D. 1–a, 2–b, 3–c 

Group Exercise (4–6 students per group): 

Title: Design a Student Attendance System 

Scenario: 

Your team has been hired to develop a simple Student Attendance Management System for a 
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local school. The system should allow teachers to mark attendance, generate reports, and students 

should be able to view their attendance history. 

Task:- prepare a report document that has the following parts:  

Part 1: Define the Project  

 Project Name: Give your app a creative name. 

 Purpose: What problem does the app solve? 

 Target Users: Who will use it? 

Part 2: Assign Developer Roles 

 Decide who will take on which developer roles: 

o Front-End Developer(s) 

o Back-End Developer(s) 

o Full-Stack Developer (if needed) 

 Also assign a Project Coordinator to guide discussion and organize tasks. 

 Use your understanding of each developer role to decide who fits best where. 

Part 3: Plan the SDLC Phases  

 Briefly describe what your team will do at each stage: 

o Planning 

o Analysis 

o Design 

o Implementation 

o Testing 

o Deployment 

o Maintenance 

Part 4: Collaboration Tools  

 Choose one version control tool and one collaboration platform your team would use. 

 Explain why these tools are useful for teamwork. 

Summary  

This session introduced the fundamentals of software development, covering its definition, the 

Software Development Life Cycle (SDLC) stages, along with common methods like Waterfall, 

Agile, Scrum, Lean, and DevOps. The session also explored the main types of software developers: 

front-end, back-end, and full-stack, highlighting the importance of both technical and soft skills. 
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Finally, it discussed Version Control Systems (VCS), their types, and popular tools like Git, as 

well as collaborative software development practices using platforms such as GitHub and GitLab. 

Review questions 

1. Which of the following is the correct order of SDLC stages? 

A. PlanningDesignAnalysisImplementationTestingDeploymentMaintenance 

B. PlanningAnalysisDesignImplementationTestingDeploymentMaintenance 

C. AnalysisPlanningDesignDeploymentImplementationTestingMaintenance 

D. PlanningImplementationDesignAnalysisTestingDeploymentMaintenance 

2. A developer who works on both the front-end and back-end of an application is called: 

A. Front-End Developer 

B. Back-End Developer 

C. Full-Stack Developer 

D. System Analyst 

3. What is the main purpose of a Version Control System (VCS)? 

A. To make software slower 

B. To track and manage changes to code 

C. To design the user interface 

D. To test network connections 

4. Collaborative software development ensures that: 

A. Only one developer writes all code 

B. Developers can work together without overwriting each other’s work 

C. Testing is optional 

D. Soft skills are unnecessary 
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Session 2: Open-source vs Proprietary software 

Introduction 

Dear learners, welcome to this session. In this session, you will explore Open-source Vs 

Proprietary Software  

Welcome! Have you thought about the software you use every day? Some programs are open 

source, meaning anyone can use, modify, and share them, while others are proprietary, owned by 

a company with restrictions. 

In this session, you’ll explore the differences among Linux, Windows, LibreOffice, and Microsoft 

Office, and by the end, you’ll be able to identify open source and proprietary software. 

Learning Objective: 

By the end of the session, learners will be able to: 

 Identify open source and proprietary software  

Content outline 

2.1 Open source and proprietary software  

2.1 Open source and proprietary software 

Can you think of a software you use daily? Is it open-source or proprietary? 

Open-source software makes its source code freely available for anyone to use, modify, and 

distribute, often under specific licenses that encourage collaboration and modification. Proprietary 

software, on the other hand, is owned by an individual or company, with its source code kept 

private, and users typically need a license to use it. 

Open source vs proprietary software 

 Cost: Open source is usually free; proprietary software requires purchase or subscription. 
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 Updates: Open source gets community or publisher updates; proprietary has regular company-

managed updates. 

 Flexibility: Open source can be modified; proprietary software has usage and modification 

restrictions. 

 Support: Open source relies on forums or hired help; proprietary offers official support teams. 

Examples 

Open Source Software Examples: 

 Operating Systems: Linux, Android. 

 Web Browsers: Firefox. 

 Office Suites: LibreOffice. 

 Media Players: VLC Media Player. 

 Programming Languages: PHP. 

 Cloud Platforms: OpenStack.  

Proprietary Software Examples: 

 Operating Systems: Windows, macOS. 

 Office Suites: Microsoft Office. 

 Web Browsers: Microsoft Edge, Google Chrome. 

 Cloud Computing: Google Apps. 

Exercise (Group Work 4–6 members) 

1. Each group will list at least five software applications. 

2. For each software listed, research or discuss whether it is open-source or proprietary. 

3. Compare them based on: 

o Interface and usability 

o Features and customization 

o Cost and licensing 

o Update/support options 

4. Which type do you prefer? 
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5. In what situations might open-source software be better? 

6. When would proprietary software be the better choice? 

Summary 

This session covered open-source and proprietary software. Open-source software is freely 

available, modifiable, and encourages community collaboration, while proprietary software is 

privately owned, with restricted access and usually requires a license. 

Well done! Let’s take a quick moment to check what you’ve learned so far before we continue to 

next session. 

Review Questions  

1. Can you name one open-source and one proprietary software you use? 

2. Which of the following is an open-source software? 

a. Windows 

b. Linux 

c. Microsoft Office 

d. Google Apps 

3. How do users usually get help with open-source software? 

a. Official customer support teams 

b. Community forums and online guides 

c. Calling the government 

d. No support is available 
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Session 3: Basics of programming 

Introduction  

Dear learners, welcome to this session. In this session, you will explore Computer Programming 

Basics 

Have you ever been curious about how your favorite app or game is made? It all happens through 

computer programming, or coding, which is the process of writing instructions that tell a computer 

what to do. In this session, we will explore who a computer programmer is, the essential skills 

needed, how to design algorithms, and the different programming environments where software is 

created. By the end, you’ll understand how programmers turn ideas into working software. 

Learning objectives 

By the end of the session, learners will be able to: 

 Explain the fundamental concepts of computer programming. 

 Identify and describe different programming environments. 

Content outline 

3.1 Computer programming  

3.2 Computer programming environment 

3.1 Computer programming  

Think of your favorite app or game. How do you think it was created?  

Your favorite app or game works because someone wrote instructions for the computer. That’s 

what we call computer programming, and in this lesson, you’ll learn how it’s done. 



Digital Amhara Initiative  

Intermediate Digital Literacy (Version 1.0)                      Page [222]                                 October, 2025 

Computer programming, also known as coding, is the process of creating instructions for 

computers to follow. These instructions, called programs, enable computers to perform specific 

tasks or achieve desired computing results. 

So, who do you think is in charge of writing the instructions or codes for a computer? It is called 

the programmer.   

Essential Skills for Computer Programmers 

Computer programmers need both technical and soft skills to succeed, including understanding 

programming languages and soft skills, such as problem-solving. Here are essential skills for 

programmers.  

Programming Skill: Skilled in one or more programming languages such as Python, Java, or C++. 

Algorithm Design: Understanding and implementing algorithms effectively. It helps optimize 

solutions and ensures software performs tasks efficiently. 

Debugging: Identifying and fixing errors or bugs in software. 

Version Control: Familiarity with systems like Git for managing code changes. 

Problem-Solving: Ability to break down complex problems and find logical solutions. 

Designing the Algorithm  

The algorithms can be represented using tools like: 

Pseudocode: A high-level, language-independent description of the steps. 

Flowcharts: Visual diagrams illustrating the flow of control and operations. 

Pseudocode example  
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Flowchart symbols   

Symbol Symbol Name Function 

 Oval Used to represent start and End of flowchart 

 Parallelogram Used for input and output operation 

 Rectangle Processing: used for arithmetic operation and 

data manipulation. A single step or operation 

within the process. 

 Diamond Decision making: used to represent the 

operations in which there are two/three 

alternatives, true and false, etc 

 Arrows Flow line used to indicate the flow of logic by 

connecting symbols 

 

Circle A circle with a letter inside, used to link different 

parts of the flowchart on the same page.  

 

 A similar circle with a letter, but used to link 

parts of the flowchart on different pages.  

Table 13 Flowchart Symbols 

 Oval (Terminator): Marks the beginning and end of the flowchart. 

 Rectangle (Process): Represents a single step or operation within the process. 

Pseudo code to find the sum of two numbers: 

1. Start 

2. Input num1 

3. Input num2 

4. Set sum = num1 + num2 

5. Display sum 

6. End 

Pseudo code to print numbers from 1 to 5 

SET count ← 1 

WHILE count ≤ 5 DO 

    PRINT count 

    count ← count + 1 

END WHILE 
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 Diamond (Decision): Indicates a decision point, typically with "yes" or "no" (or true/false) 

outcomes. 

 Parallelogram (Input/Output): Represents data input or output. 

 Arrow (Flowline): Shows the direction of the process flow from one symbol to the next. 

 On-page connector: A circle with a letter inside, used to link different parts of the flowchart 

on the same page.  

 Off-page connector: A similar circle with a letter, but used to link parts of the flowchart on 

different pages. Example 

 

 

 

 

 

 

 

 

Well done! Let’s take a quick moment to check what you’ve learned so far before we continue to 

the next topic. 

Reflective questions 

1. Who do you think writes the instructions (code) for a computer? 

2. Which skill do you think is important for a programmer? 

3.  Can you name the two common tools used to represent algorithms? 

 

Flowchart to read the two sides of a rectangle 

and calculate its area 
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Exercise: 

1. Write pseudo code or draw a flowchart to calculate the average of three numbers. 

2. Write pseudo code or draw a flowchart to find the Area and Perimeter of a Square. 

3. Write pseudo code or draw a flowchart to find the smaller of two numbers. 

3.2 Programming environment 

If you wanted to build a mobile app or a game, what kind of tools or software would you need on 

your computer?  

Just like a chef needs a kitchen to cook, programmers need the right tools to create programs. Let’s 

explore what makes up a programming environment and how it helps us code. 

A programming environment is the set of tools and resources that programmers use to write, test, 

and run their programs. It provides everything needed to create software efficiently. 

Types of Programming Environments 

Text-based Environment: You write code in a text editor and run it from a terminal. (e.g. 

Notepad++, Sublime Text). 

 

 

 

Integrated Development Environment (IDE):  Combines editor, 

compiler, debugger, and tools in one application (e.g., Visual Studio and 

PyCharm). 

Online/Cloud-based Environment: Code in your browser without 

installing software. Provide development tools and resources over the internet, accessible from 

anywhere. (e.g., Replit, GitHub Codespaces). 

Figure 98: Text based environment 

Table 14 IDE software 
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Reflective questions 

1. Mention the programming environment that combines editor, compiler, and debugger in one 

application?  

2. Which environment can be accessed from anywhere using the internet? 

Group Exercise (4–6 students per group): 

1) Develop an algorithm that takes a number as input and prints its multiplication table up to 10. 

2) Develop an algorithm that accepts three numbers and displays the largest. 

3) Develop an algorithm for the following  

A banking application receives a transaction amount from a user. The application needs to 

determine if the transaction is a deposit (positive), a withdrawal (negative), or if the transaction 

did not occur (zero). 

Summary 

This session introduced computer programming as the process of creating instructions (code) for 

computers to follow, enabling them to perform specific tasks. The person responsible for writing 

these instructions is called a programmer. We explored essential skills for programmers. 

Finally, we covered programming environments: the set of tools and resources used to write, test, 

and run programs. 

Review questions 

1. Which of the following is NOT a common programming skill? 

a) Algorithm design 

b) Debugging 

c) Cooking 

d) Version control 

2. What is the main purpose of computer programming? 

a) To design websites only 

b) To give instructions for computers to perform tasks 

c) To play games on a computer 

d) To write essays 
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3. Which flowchart symbol shows the start or end of a process? 

a) Rectangle 

b) Diamond 

c) Oval 

d) Parallelogram 
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